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Preface

1. About Mandriva Linux

Mandriva Linux is a GNU/Linux distribution supported by Mandriva S.A. which was born on the Internet in 1998.
Its main goal was and still is to provide an easy-to-use and friendly GNU/Linux system. Mandriva’s two pillars
are open source and collaborative work.

On April 7th 2005 the Mandrakesoft company changed its name to
Mandriva to reflect its merger with Brazil-based Conectiva. Its core
product, Mandrakelinux, became Mandriva Linux.

1.1. Contacting the Mandriva Linux Community

The following are various Internet links pointing you to the most important Mandriva Linux-related sources. If
you wish to know more about the Mandriva company, connect to our web site (http://www.mandriva.com/).
You can also check out the Mandriva Linux distribution web site (http://www.mandrivalinux.com/) and all its
derivatives.

Mandriva Expert (http://www.mandrivaexpert.com/) is Mandriva’s support platform. It offers a new expe-
rience based on trust and the pleasure of rewarding others for their contributions.

We also invite you to subscribe to the various mailing lists (http://www.mandriva.com/community/
resources/newsgroups) where the Mandriva Linux community demonstrates its vivacity and keenness.

Please also remember to connect to our security page (http://www.mandriva.com/security). It gathers all
security-related material about Mandriva Linux distributions. You will find security and bug advisories, as well
as kernel update procedures, the different security-oriented mailing lists which you can join, and Mandriva
Online (https://online.mandriva.com/) (see “Mandriva Online Services”, page 175). This page is a must for
any server administrator or user concerned about security.

1.2. Join the Club!

Mandriva offers a wide range of advantages through its Mandriva Club (http://club.mandriva.com):

• download commercial software normally only available in retail packs, such as special hardware drivers,
commercial applications, freeware, and demo versions;

• vote for and propose new software through a volunteer-run RPM voting system;

• access more than 50,000 RPM packages for all Mandriva Linux distributions;

• obtain discounts for products and services on Mandriva Store (http://store.mandriva.com);

• access a better mirror list, exclusive to Club members;

• read multilingual forums and articles.

• access Mandriva’s Knowledge Base (http://club.mandriva.com/xwiki/bin/view/KB/), a wiki-based site
which holds documentation on many subjects such as administration, connectivity, troubleshooting, and
more;

• chat with the Mandriva Linux developers on the Club Chat (https://www.mandrivaclub.com/user.php?op=
clubchat);

• enhance your GNU/Linux knowledge through Mandriva’s e-training lessons (http://etraining.mandriva.
com/).

By financing Mandriva through the Mandriva Club you will directly enhance the Mandriva Linux distribution
and help us provide the best possible GNU/Linux desktop to our users.
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1.3. Subscribing to Mandriva Online

Mandriva offers a very convenient way to keep your system automatically up-to-date, keeping away bugs and
fixing security holes. Consult “Mandriva Online Services”, page 175.

1.4. Purchasing Mandriva Products

Mandriva Linux users may purchase products on-line through the Mandriva Store (http://store.mandriva.
com/). You will not only find Mandriva Linux software, operating systems and “live” boot CDs (such as Move),
but also special subscription offers, support, third-party software and licenses, documentation, GNU/Linux-
related books, as well as other Mandriva goodies.

1.5. Contributing to Mandriva Linux

The skills of the many talented folks who use Mandriva Linux can be very useful in the making of the Mandriva
Linux system:

• Packaging. A GNU/Linux system is mainly made of programs picked up on the Internet. They have to be
packaged in order to work together.

• Programming. There are many, many projects directly supported by Mandriva: find the one which most
appeals to you and offer your help to the main developer(s).

• Internationalization. You can help us translate web pages, programs and their respective documentation.

Consult the development projects (http://qa.mandriva.com/) page to learn more about how you can contri-
bute to the evolution of Mandriva Linux.

2. About this User Guide

We wrote this to give you a better understanding of the Mandriva Linux system. In it we focus on graphical
applications which allow you to perform your daily tasks, such as writing documents and e-mails, surfing the
web and listening to music. We also show you how to configure your desktop to your liking, install software,
and finally, we give you some tips and tricks to help you fix common — and not so common — problems.

We start off with Installing Mandriva Linux, where we discuss what you need to know before you actually
install Mandriva Linux onto your system (see “Installation Warning”, page 7, and “Before Installation”, page 9).
Then we show you how to correctly install and configure your Mandriva Linux distribution (“Installation with
DrakX”, page 11) by describing the preparation, installation and post-installation procedures.

The next part (Discovering Mandriva Linux) is an introduction to Linux basics. We discuss the Linux paradigm
by comparing it to other OSes in “Migrating to Linux from Windows® and Mac OS® X”, page 31. In order to
help new users, we wrote “Linux for Beginners”, page 35. In it we describe the first steps a new user must
master and we explain concepts such as “logging in and out”, security tips, and more. The following chapter
(“Accessing Documentation”, page 41) guides you through a fairly exhaustive list of documentation sources
which you can consult to attain a better understanding of Linux. A Mandriva Linux-specific section points to
numerous in-house resources which you can find on the Net. We close this part by speaking about the popular
KDE graphical environment (see “Using KDE”, page 45).

We then tackle Internet applications (Communicating with the Wired World). We explain how to send e-mails
using the KMail component of the Kontact suite (Writing E-mails and Reading News, page 53), how to read news
and RSS feeds with Akregator (Akregator, page 57) and how to browse the web using Firefox (“Surfing The Web
With Firefox”, page 59).

The next part (Free Software Daily) discusses the OpenOffice.org suite (see Word Processor, page 65, and
Spreadsheet, page 67), file managers (see Managing Your Files, page 71) and printers (see Printing and Faxing
from Applications, page 73). We then explore the world of multimedia by reviewing audio and movie applica-
tions (see Audio Applications, page 79, and Movie Applications, page 81), as well as CD burning (see CD Burning,
page 82).

Finally we go through more technical aspects of the Mandriva Linux system (Configuring and Tweaking Your Box):
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• Mandriva Linux Control Center. This is your main graphical configuration tool (see MCC’s Components,
page 91). With it you can configure your software sources (“Package Management through Rpmdrake”, page
95), your hardware (“Hardware Setup”, page 103), and your network (“Setting up your Network and Accessing
the Web”, page 129). You can also set up your general system settings (“Personalizing your System”, page
137) such as your menus (see Customizing your Menus with MenuDrake, page 137) and your start-up services
(see Configuring Start-Up Services, page 140). We also address more complex issues such as configuring your
mount points (“Mount Points and Remote Directories”, page 155) and general system security (“Securing your
Linux Box”, page 165). Finally, you can tune-up your boot options (“Boot Device Configuration”, page 171).

• Software Installation. Mandriva Linux offers different ways to update your system with normal software
updates and security fixes. This can be done through the Rpmdrake Software Manager (“Package Management
through Rpmdrake”, page 95) which allows you to install and remove software packages, set up Mandriva
Update sources as well as other media such as Cooker.

• Troubleshooting. For most users, switching to GNU/Linux is a challenging experience. And this manual
wouldn’t be complete without a chapter dedicated to helping you solve what might go wrong during your
GNU/Linux experience (“Troubleshooting”, page 181). It gives you tips and tricks if “all hell breaks loose”:
needless to say, this chapter cannot be exhaustive.

3. Note from the Editor

In the open-source philosophy, contributors are always welcomed! Updating the Mandriva Linux documenta-
tion pool is quite a task. You could provide help in many different ways. In fact, the documentation team is
constantly looking for talented volunteers to help us out accomplish the following tasks:

• writing or updating;

• translating;

• copy editing;

• XML/XSLT programming.

If you have a lot of time, you can write or update a whole chapter; if you speak a foreign language, you can
help us translate our manuals; if you have ideas on how to improve the content, let us know; if you have
programming skills and would like to help us enhance the Borges Collaborative Content Creation System
(C3S) (http://sourceforge.net/projects/borges-dms), join in. And don’t hesitate to contact us if you find
any mistakes in the documentation so we can correct them!

For any information about the Mandriva Linux documentation project, please contact the documentation admi-
nistrator (mailto:documentation@mandriva.com) or visit the Mandriva Linux Documentation Project Pages
(http://qa.mandriva.com/twiki/bin/view/Main/DocumentationTask/).

Please note that since June 2004 the Mandriva Linux documen-
tation and the development of Borges is handled by NeoDoc
(http://www.neodoc.biz).

4. Conventions Used in this Book

4.1. Typing Conventions

In order to clearly differentiate special words from the text flow, we use different renderings. The following
table shows examples of each special word or group of words with its actual rendering, as well as its signifi-
cance.

Formatted Example Meaning

inode Used to emphasize a technical term.

ls -lta Used for commands and their arguments. (see Commands Synopsis, page 4).

a_file Used for file names. It might also be used for RPM package names.
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Formatted Example Meaning

ls(1) Reference to a man page. To read the page, simply type man 1 ls, in a
command line.

$ ls *.pid Formatting used for text snapshots of what you may see on your screen
including computer interactions, program listings, etc.

localhost Literal data which does not generally fit in any of the previously defined
categories. For example, a key word taken from a configuration file.

OpenOffice.org Defines application names. Depending on context, the application and
command name may be the same but formatted differently. For example, most
commands are written in lowercase, while applications names usually begin
with an uppercase character.

Files Indicates menu entries or graphical interface labels. The underlined letter, if
present, informs you of a keyboard shortcut, accessible by pressing the Alt key
plus the letter in question.

Le petit chaperon rouge Identifies foreign language words.

Warning! Reserved for special warnings in order to emphasize the importance of words.
Read out loud.

Highlights a note. Generally, it gives additional information about
a specific area.

Represents a tip. It can be general advice on how to perform a
particular action, or hints at nice features, such as shortcuts, which
could make your life easier.

Be very careful when you see this icon. It always means that very
important information about a specific subject will be dealt with.

4.2. General Conventions

4.2.1. Commands Synopsis

The example below shows the symbols you will see when the writer describes the arguments of a command:

command <non literal argument> [--option={arg1,arg2,arg3}] [optional arg ...]

These conventions are standard and you will find them elsewhere such as in the man pages.

The “<” (lesser than) and “>” (greater than) symbols denote a mandatory argument not to be copied as is,
which should be replaced according to your needs. For example, <filename> refers to the actual name of a
file. If this name is foo.txt you should type foo.txt, not <foo.txt> or <filename>.

The square brackets (“[ ]”) denote optional arguments, which you may or may not include in the command.

The ellipsis (“...”) means an arbitrary number of arguments may be included.

The curly brackets (“{ }”) contain the arguments authorized at this specific place. One of them is to be placed
here.

4
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4.2.2. Special Notations

From time to time, you will be asked to press, for example, the keys Ctrl-R, which means you need to press
and hold the Ctrl key and tap the R character right after as well. The same applies for the Alt and Shift keys.

We use capital letters to represent the letter keys; this doesn’t mean
that you have to type them capitalized. However, there might be
programs where typing R is not the same than typing r. You will
be informed when dealing with such programs.

Regarding menus, going to menu item File→Reload user config (Ctrl-R) means: click on the File text displayed
on the menu (generally located in the upper-left of the window). Then in the pull-down menu, click on the Re-
load user config item. Furthermore you are informed that you can use the Ctrl-R key combination (as described
above) to get the same result.

4.2.3. System-Generic Users

Whenever possible, we use two generic users in our examples:

Queen Pingusa queen This is our default user, used through most examples
in this book.

Peter Pingus peter This user can be created afterward by the system
administrator and is sometimes used to vary the text.

5
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Chapter 1. Installation Warning

This guide only covers the most common steps of the installation process. If you plan on using Windows® as
well as GNU/Linux by dual-booting (meaning being able to access either system on the same computer), please
note that it is easier to install Windows® before GNU/Linux. If Windows® is already set up on your system, and
you have never installed GNU/Linux before, DrakX — Mandriva Linux’s installation program — will have to
resize your Windows® partition. This operation can be harmful to your data. Therefore, you must perform the
following steps before proceeding:

• Run chkdsk on your Windows® computer (called scandisk on non-NT systems, such as Windows® 9x).
The resizing program can detect some obvious errors, but chkdsk is better suited for this task. Refer to the
chkdsk documentation for more information on the different options it has.

Before using chkdsk make sure your screen saver and any other
program that might write to the hard disk is turned off. To obtain
even better results, you should run chkdsk from Windows®’s“Safe
Mode”.

• For maximum data security, also run defrag on your partition if you use Windows® 9x1. This further reduces
the risk of data loss. This isn’t mandatory, but it’s highly recommended. Doing so will make the resizing
process much faster and easier.

• The ultimate insurance against problems is to always back up your data! Of course, you should back up
your data on another computer, upload your back-ups on the web, on a friend’s computer, etc. Do not back
it up onto the computer on which you want to install GNU/Linux.

NTFS Partitions. Windows® 2000, NT and XP users should
remain careful: even though DiskDrake (through the ntfsresi-
ze application) is able to resize NTFS partitions, it’s highly
recommended that you back up your data before starting
the installation. Please see the Linux-NTFS site (http://
linux-ntfs.sourceforge.net/info/ntfs.html#2.6) as well as
these NTFS Resize FAQ (http://linux-ntfs.sourceforge.
net/info/ntfsresize.html) for more information on the subject.

Windows® users could be tempted to use Norton PartitionMagicTM

to resize a NTFS partition. However many reports indicate that it
fails and the end result could be a broken partition! Therefore we
recommend you use Mandriva Linux’s DiskDrake program. In doubt
refer to the FAQ mentioned above.

1. On NT-based operating systems, defragmentation has little to no effect.
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Chapter 2. Before Installation

This chapter covers issues which should be addressed before you start your new Mandriva Linux installation.
Make sure you read it completely since it will save you a lot of time. Also back up your data (on a different
disk to the one you will install the system into) and plug in and turn on all your external devices (keyboard,
mouse, printer, scanner, etc.).

2.1. Configuring your BIOS

The BIOS (Basic Input/Output System) is used to find the device on which the operating system is located and
starts it up. It’s also used for the initial hardware configuration and low-level hardware access.

The appearance of plug’n’play devices and their widespread use means that all modern BIOSes can initialize
these devices. In order for Linux to recognize plug’n’play devices, your BIOS must be configured to initialize
them.

Changing your BIOS’ settings is usually performed by holding down the Del key (some BIOSes use the F1,
F2, F10 or Esc keys instead) right after the computer is switched on. Unfortunately, there are many types of
BIOSes. Therefore you will need to look for the appropriate option yourself. It’s often called PNP OS installed
(or Plug’n’Play OS installed). Set this option to No and the BIOS will then initialize any plug’n’play devices,
which helps Linux to recognize them.

All recent systems can boot from a CD-ROM. Look for Boot sequence or First boot device in the BIOS’ features
setup, and set the CD-ROM as the first boot device. If your system can’t boot from a CD-ROM you will need
to use a floppy boot disk.

If you want to use a parallel printer connected locally to your machi-
ne, make sure the parallel port mode is set to ECP+EPP (or at least
to one of ECP or EPP) and not to SPP, unless you have a really
old printer. If the parallel port is not set this way you might still
be able to print, but your printer will not be detected automati-
cally and you will have to configure it manually. Also make sure
the printer is properly connected to your machine and powered on
beforehand.

2.2. Supported Hardware

Mandriva Linux can handle a large number of hardware devices, and the list is far too long to be quoted exhaus-
tively. Nevertheless some of the steps we describe will help you to find out if your hardware is compatible. It
will also guide you in configuring some problematic devices.

You may also consult an up-to-date list of supported hardware on the Mandriva Linux Hardware Database
(http://www.mandriva.com/hardware) web site.

Legal Disclaimer: The Mandriva Linux Hardware Database con-
tains information about hardware devices which have been tested
and/or have been reported to function properly with Mandriva Li-
nux. Due to the wide variety of system configurations, Mandriva
cannot guarantee that a specific device will work properly on your
system.

USB devices: support for USB 1.x and USB 2.0 is now extensive. Most peripherals are fully supported. You
can obtain the list of supported hardware on the Linux-USB device overview (http://www.qbik.ch/usb/
devices/) site. Relevant information can also be found on the Linux USB (http://www.linux-usb.org) web
site.
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Chapter 3. Installation with DrakX

3.1. The Mandriva Linux Installer

With the DrakX installation program, it doesn’t matter whether you’re a newbie or a GNU/Linux guru. The job
of DrakX is to provide you with a smooth installation and an easy transition to Mandriva Linux’s latest version.

DrakX works best of all if your hardware is connected to your com-
puter and powered on during the installation. Printers, modems,
scanners and joysticks are just a few examples of peripherals which
DrakX can automatically detect and configure as Mandriva Linux
is being installed.

Figure 3-1. Very First Installation Welcome Screen

The first screen offers to run the installation with special options if the standard mode wasn’t suited for your
hardware. Let the installation start automatically with no options. If something goes wrong, see Installation
Options, page 11.

3.1.1. The Installation Process

When the installer starts, you see a nice graphical interface (see figure 3-3). On the left are the various installa-
tion steps, the current one marked by a highlighted bullet. The installation occurs in two phases: installation,
then configuration.

Each step may present various screens. You can surf between those screens through the Next and Previous
buttons. Additionally an Advanced button may be available to show more advanced configuration options.
Note that most of the latter should only be used by expert users. But there’s no harm in looking at them!

The Help button displays explanations concerning the current ins-
tallation step.
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3.1.2. Installation Options

If something goes wrong during the first installation attempt, pressing F1 at the welcome screen (see figure
3-1) opens a help window (see figure 3-2). Here are some useful options to choose from:

Figure 3-2. Available Installation Options

• vgalo: If you tried a default installation and didn’t see the graphical interface (see figure 3-3), you can try to
run the installation in low resolution mode. This happens with certain types of video cards. With Mandriva
Linux you are given a number of options to work around problems related to older hardware. To try the
installation in low resolution mode, enter vgalo at the prompt.

• text: If your video card is very old and the graphical installation doesn’t work at all, you can always choose
to install in text mode. Since all video cards can display text, this is the “last resort” kind of installation.
However don’t worry: it’s unlikely that you will need this option.

• noauto: In some rare cases, your PC may appear to freeze or lock up during the hardware detection phase.
If that happens, adding the word noauto as a parameter tells the installation program to bypass hardware
detection. Therefore you will need to manually specify hardware parameters later in the installation process.
You can add the noauto parameter to the previous modes, so depending on your hardware you may have
to specify vgalo noauto to perform a low-resolution graphical installation without DrakX performing a
hardware scan.

• kernel options: Most machines don’t require specific kernel options. Due to bugs in the design or in the
BIOS, there have been a few cases of motherboards incorrectly reporting the amount of memory installed.
If you need to manually specify the amount of RAM installed in your PC, use the mem=xxxM parameter.
For example, to start the installation in normal mode with a computer containing 256 MB of memory, your
command line would look like linux mem=256M

3.2. Choosing your Language

The first step is to choose your preferred language.
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Figure 3-3. Choosing the Default Language

Open the tree relative to the continent you’re located in, then choose your language. Your language choice will
affect the installer, the documentation, and the system in general.

Use the list accessible through the Multi languages button to select other languages to be installed on your
workstation, thereby installing the language-specific files for system documentation and applications. For
example, if Spanish friends are to use your machine, select English as the default language in the tree view
and Español in the list view.

About UTF-8 (unicode) support: Unicode is a character encoding
intended to cover all existing languages. However full support for it
in GNU/Linux is still under development. For that reason, Mandriva
Linux’s use of UTF-8 depends on your choice:

1. If you choose a language with a strong legacy encoding
(latin1 languages, Russian, Japanese, Chinese, Korean,
Thäı, Greek, Turkish, and most iso-8859-2 languages),
the legacy encoding will be used by default.

2. Other languages use Unicode by default.

3. If two or more languages are to be installed, and those
languages don’t use the same encoding, then Unicode is
used for the whole system.

4. Finally, Unicode can also be forced for use throughout the
system at a user’s request by selecting the Use Unicode
by default option independently of which languages have
been chosen.

Note that you’re not limited to choosing a single additional language. You may choose several, or even install
them all by selecting the All languages option. Selecting support for a language means translations, fonts, spell
checkers, etc. are also installed for that language. Make sure you select all languages which are likely to be
useful on the machine now, it may be difficult to configure support for languages not chosen at install time at
a later time.
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To switch between the various languages installed on your system,
you can launch the localedrake command as root to change
the language used by the entire system. Running the command as
a regular user only changes the language settings for that particular
user.

3.3. License Terms of the Distribution

Before continuing, you should carefully read the terms of the license. It covers the entire Mandriva Linux dis-
tribution. If you agree with all the terms it contains, select Accept and click on Next. If not, clicking on Quit
reboots your computer.

If you are curious about any technical changes which have occurred
in the distribution since the last release, you can click on the Release
Notes.

3.4. Installation Class

This step is shown only if an existing GNU/Linux partition is found on your machine.
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DrakX now needs to know if you want to install from scratch or to upgrade your existing Mandriva Linux
system:

Upgrade

This installation type simply updates the packages currently installed on your Mandriva Linux system.
Your current partitioning scheme and user data won’t be altered. Most of the other configuration steps
remain available and are similar to a standard installation.

Install

For the most part, this completely wipes out the old system. However, depending on your partitioning
scheme, you can prevent some of your existing data (particularly /home directories) from being overw-
ritten.

Using the “Upgrade” option should work fine on Mandriva Linux
systems running version 10.1 or later. Performing an upgrade on
prior versions is not recommended.

3.5. Configuring your Keyboard

This step only shows if your language settings don’t match one
single keyboard. Otherwise, your keyboard layout is automatically
selected.
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Depending on the language you choose (see Choosing your Language, page 12), DrakX automatically selects
a particular type of keyboard configuration. Verify that the selection suits you or choose another keyboard
layout.

Also, you may not have a keyboard which corresponds exactly to your language: for example, if you are an
English-speaking Swiss native, you may have a Swiss keyboard. Or if you speak English and are located in
Québec, you may find yourself in the same situation where your native language and country-set keyboard
don’t match. In either case, this installation step will allow you to select an appropriate keyboard.

Click on the More button and a list list of supported keyboards appears.

If you choose a keyboard layout based on a non-Latin alphabet, the next dialog allows you to choose the key
binding which can switch the keyboard between the Latin and non-Latin layouts.

3.6. Security Level
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At this point, DrakX allows you to choose your machine’s security level. As a rule of thumb, the security level
should be set higher if the machine is to contain crucial data, or if it’s to be directly exposed to the Internet.
The trade-off is that a higher security level is generally obtained at the expense of ease of use.

If you don’t know what to choose, keep the default option. You’ll be able to change it later with the draksec
tool in the Mandriva Linux Control Center.

Fill the Security Administrator field with the e-mail address of the person responsible for security. Security-
related messages will be sent to that address.

3.7. Partitioning your Disk

You now have to decide where you want to install Mandriva Linux on your hard drive. Your hard drive needs
to be partitioned which means it must be logically divided in order to create the required space for your new
Mandriva Linux system.

Because the process of partitioning a hard drive is usually irreversible and can lead to data loss, it can be
intimidating and stressful for the inexperienced user. Fortunately, DrakX includes a wizard which simplifies
this process. Before continuing with this step, read through the rest of this section and above all, take your
time.

Depending on the configuration of your hard drive, several options are available:

Use free space

This option performs an automatic partitioning of your blank drive(s). If you use this option there will be
no further prompts.

Use existing partitions

The wizard detected one or more existing Linux partitions on your hard drive. If you want to use them,
choose this option. Then choose the mount points associated with each of the partitions. The legacy mount
points are selected by default, and for the most part it’s a good idea to keep them. Then choose the
partitions to be formatted or preserved.

Use the free space on the Windows partition

If Windows® is installed on your hard drive, you might have to create free space for GNU/Linux. To do so,
you can delete your Windows® partition and data (see the “Erase entire disk” solution below) or resize
your FAT or NTFS partition. Resizing can be performed without the loss of any data, provided you pre-
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viously defragmented the Windows® partition. Backing up your data is strongly recommended. Using
this option is recommended if you want to use both Mandriva Linux and Windows® on the same computer.

Before choosing this option, please understand that after this procedure, the size of your Windows® parti-
tion will be smaller than when you started, which means you will have less free space to store your data
or to install new software.

Erase entire disk

Choose this option to delete all data and partitions present on your hard drive. You won’t be able to undo
this operation after you confirm.

If you choose this option, all data on your disk will be deleted.

Remove Windows(TM)

This option appears when the hard drive is entirely taken by Windows®. Choosing this option simply
erases the entire drive, partitioning everything from scratch.

If you choose this option, all data on your disk will be lost.

Custom disk partitioning

Choose this option to manually partition your hard drive. Be careful: it’s a powerful but dangerous choice
and you can very easily lose all your data. This option is only recommended if you performed custom
disk partitioning before, and have enough GNU/Linux experience. For more instructions on how to use
the DiskDrake utility, refer to Managing your Hard Drive Partitions with DiskDrake, page 155.

3.8. Package Selection

We now enter the software package installation itself. It first consists of selecting the installation media and
then the packages to be installed.

3.8.1. Media Handling

If you are doing an installation from a CD, you are first asked to select the CDs you actually have available.

You are also given the option to copy all packages on your hard drive. This will probably speed up installation
and will ease later package installation as all packages will already be available on the hard disk.
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3.8.2. Supplementary Installation Media

It is now possible to add new installation media, such as a CD or remote network repositories from Mandriva
Club for example. If you choose a network repository, you will go through the following steps:

1. Network Configuration

Simply choose the connection type needed to access the remote repository. Your settings will be preserved
for the actual system network configuration.

2. Media Selection

Provide the information (URL or NFS server and path) to access the new media.

3.8.3. Choose Package Groups to Install
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It’s now time to specify which programs you wish to install on your system. There are thousands of packages
available for Mandriva Linux, and to make it simpler to manage, they have been placed into groups of similar
applications.

Mandriva Linux sorts package groups into categories. You can mix and match applications from the various
categories, so a Workstation installation can still have applications from the Server category installed.

1. Workstation: if you plan to use your machine as a workstation, select one or more of the groups in this
category. The special LSB group will configure your system so that it complies as much as possible with
the Linux Standard Base Project (http://www.linuxbase.org/) specifications.

2. Server: if your machine is intended to be a server, select which of the more common services you wish to
install on your machine.

3. Graphical Environment: this is where you will choose your preferred graphical environment. At least one
must be selected if you want to have a graphical interface available.

Moving the mouse cursor over a group name will display a short
explanatory text about that group.

You can check the Individual package selection box, which is useful if you’re familiar with the packages being
offered or if you want to have total control over what will be installed.

If you start the installation in Upgrade mode, you can deselect all groups and prevent the installation of any
new packages. This is useful for repairing or updating an existing system.

Minimal Installation

If you deselect all groups when performing a regular installation (as opposed to an upgrade), a new dialog
shows after pressing the Next button, suggesting different options for a minimal installation:

• With X: install the minimum number of packages possible to have a working graphical desktop.

• With basic documentation: installs the base system plus basic utilities and their documentation. This installa-
tion is suitable for setting up a server.

• Truly minimal install: installs the absolute minimum number of packages necessary to get a working Linux
system. With this installation you will only have a command-line interface.
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3.8.4. Choosing Individual Packages to Install

If you choose to install packages individually, the installer will present a tree structure containing all packages
classified by groups and subgroups. While browsing the tree, you can select entire groups, subgroups, or
individual packages.

Whenever you select a package on the tree, a description will appear on the right to let you know the purpose
of that package.

If a server package has been selected, either because you specifically
chose the individual package or because it was part of a group of
packages, you will be asked to confirm that you really want those
server packages to be installed. By default Mandriva Linux will
automatically start any installed services (servers) at boot time.
Even if they are safe and have no known issues at the time the
distribution was shipped, it is entirely possible that security holes
were discovered after this version of Mandriva Linux was finalized.
If you don’t know what a particular service is supposed to do or
why it’s being installed, then click No.

The Show automatically selected packages option is used to disable the warning dialog. Those appear whenever
the installer automatically selects a package to resolve a dependency issue. Some packages depend on others
and the installation of one particular package may require the installation of others. The installer can determine
which packages are required to satisfy a dependency and to successfully complete the installation.

The little floppy disk icon at the bottom of the list allows you to load or save the packages list. This is useful if
you have a number of machines that you wish to configure identically. Click on this icon and select whether
you wish to Load or Save the packages list, then select the medium in the following screen and click on the Ok
button.
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3.9. Root Password

This is the most crucial decision point for the security of your GNU/Linux system: you must enter the root
password. Root is the system administrator and is the only user authorized to make updates, add users,
change the overall system configuration, and so on. In short, root can do everything! That’s why you must
choose a password which is difficult to guess: DrakX tells you if the password you choose is too simple.
Depending on the security level you chose, you’re not forced to enter a password, but we strongly encourage
you to do so. GNU/Linux is just as prone to operator error as any other operating system. Since root can
overcome all limitations and unintentionally erase all data on partitions by carelessly accessing the partitions
themselves, becoming root must be difficult.

The password should be a mixture of alphanumeric characters and at least 8 characters long. Never write
down root’s password — it makes it far too easy to compromise your system.

One caveat: don’t make the password too long or too complicated because you must be able to remember it
too!

The password won’t be displayed on screen as you type it. To reduce the chance of a blind typing error you
have to enter the password twice.

You can change the way users are authenticated on your computer by clicking on the Authentication method
button. The following authentication methods are available:

• Local file. Use a local file for all authentication and user information. This is the default method.

• LDAP. Use an LDAP server for some or all authentication needs. An LDAP directory consolidates certain
types of information within your organization.

• NIS. Authenticates users against a NIS domain. This allows you to run a group of computers in the same
NIS domain using a common password and group file.

• Windows Domain. Uses a Windows® domain controller to provide authentication services through Active
Directory, Microsoft’s implementation of LDAP.

If you select a method other than Local file, you are asked to provide some parameters which vary from one
method to the other. If you don’t know those parameters, you should ask your network administrator.
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3.10. Adding a User

GNU/Linux is a multi-user system which means each user can have his own preferences, files and so on. But
unlike the system administrator called root, the users you add at this point are not authorized to change
anything except their own files and their own configurations, protecting the system from unintentional or
malicious changes which could have a serious impact on it.

You must create at least one regular user for yourself — this is the account which you should use for routine,
day-to-day usage. Although it’s very easy to log in as root to do anything and everything, it may also be
very dangerous! A very simple mistake could render your system unusable. If you make a serious mistake as
a regular user, the worst that can happen is that you’ll lose some information, but you won’t affect the entire
system.

You are first asked for a real name. DrakX uses the first word you type in this field and copies it, all in lowercase,
to the Login name field, which is the name this user must enter to log on to the system. Then enter a password,
twice (for confirmation). From a security point of view, a non-privileged (regular) user’s password isn’t as
crucial as the root password, but that’s no reason to neglect it by making it blank or too simple: after all, your
files could be the ones at risk.

Once you click on Accept user you can add other users. Add a user for each one of your friends, your father,
your sister, etc. Click Next when you’re finished adding users.

Clicking the Advanced button allows you to change the default
shell for that user (bash by default), and to manually choose the
user and group IDs for that user.
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3.11. Installing a Bootloader

A bootloader is a small program which is started by the computer at boot time. It’s responsible for starting
up the whole system. Normally, the bootloader installation is totally automated. DrakX analyzes the disk boot
sector and acts according to what it finds:

• If a Windows® boot sector is found, it is replaced by a GRUB/LILO boot sector. This way you are able to load
either GNU/Linux or any other OS installed on your machine.

• In any other case it asks you where it should place the boot loader. Generally, the First sector of drive (MBR)
is the safest place.

Choosing Skip won’t install a bootloader. Use this option only if you know what you’re doing.
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3.12. Checking Miscellaneous Parameters

3.12.1. Summary

As a review, DrakX presents a summary of information it gathered about your system. Depending on the
hardware installed on your machine, you may have some or all of the following entries. Each entry is made
up of the hardware item to be configured, followed by a quick summary of the current configuration. Click on
the corresponding Configure button to make any changes.

• Keyboard: check the current keyboard map configuration and change it if necessary.

• Country / Region: check the current country selection. If you’re not in the country selected by DrakX, click on
the Configure button and choose another. If your country isn’t in the list shown, click on the Other Countries
button to get a complete country list.

• Timezone: by default, DrakX deduces your time zone based on the country you have chosen. You can click
on the Configure button here if this is not correct.

• Mouse: verify the current mouse configuration and change it if necessary.

• Printer: clicking on the Configure button will open the printer configuration wizard. Consult Configuring
Printers with PrinterDrake, page 109 for more information on how to set up a new printer. The interface
presented in our manual is similar to the one used during installation.

• Sound card: if a sound card is detected on your system, it will be displayed here. If you notice the sound card
isn’t the one actually present on your system, you can click on the button and choose a different driver.

• TV card: if you have a TV card, this is where information about its configuration will be displayed. If you
want to try a different driver for your TV card, or its detection wasn’t accurate you can click on Configure to
try to configure it manually.

• Graphical Interface: by default, DrakX configures your graphical interface with a resolution that best matches
your video card and monitor combination. If that doesn’t suit you, or DrakX could not automatically confi-
gure it (not configured is displayed), click on Configure to reconfigure your graphical interface. You can click
on Help from within the configuration wizard to benefit from full in-line help.

• Network: if you wish to configure your Internet or local network access, you can do so from here. Refer
to the printed documentation or use the Mandriva Linux Control Center after the installation has finished to
benefit from full in-line help.

• Proxies: allows you to configure HTTP and FTP proxy addresses if the machine you’re installing on is to be
located behind a proxy server.
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• Security Level: this entry allows you to redefine the security level as set in a previous step (see Security Level,
page 16).

• Firewall: if you plan to connect your machine to the Internet, it’s a good idea to protect yourself from in-
trusions by setting up a firewall. Consult Securing your Internet Access via DrakFirewall, page 168 for details
about firewall settings.

• Bootloader: to change your bootloader configuration. This should be reserved to advanced users. Refer to
the printed documentation or the in-line help about bootloader configuration in the Mandriva Linux Control
Center.

• Services: with this entry you can fine tune which services will be run on your machine. If you plan to use
this machine as a server it’s a good idea to review this setup.

3.12.2. Time Zone Options

This setup allows to refine the time zone you are currently located in. After you’ve chosen the location nearest
to your time zone, two more options for time management are shown.

Hardware clock set to GMT. GNU/Linux manages time in GMT (Greenwich Mean Time) and translates it
to local time according to the time zone you selected. If the clock on your computer is set to local time, you
may deactivate this by deselecting Hardware clock set to GMT, which will let GNU/Linux know that the system
clock and the hardware clock are in the same time zone. This is useful when the machine also hosts another
operating system.

Automatic time synchronization. This option will automatically regulate the system clock by connecting to a
remote time server on the Internet. For this feature to work, you must have a working Internet connection. We
recommend that you choose a time server located near you or the generic World Wide entry which will select
the best server for you. This option actually installs a time server which can be used by other machines on
your local network as well.

3.12.3. Configuring X, the Graphical Server

X (for X Window System) is the heart of the GNU/Linux graphical interface on which all the graphical environ-
ments (KDE, GNOME, AfterStep, WindowMaker, etc.) bundled with Mandriva Linux rely on.

You will see a list of different parameters which you can change in order to optimize your graphical display.
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Graphic Card

If everything works fine, the installer should detect and configure the video card installed on your machi-
ne. If the detection or configuration is incorrect, you can choose the card installed on your system from a
list.

Monitor

If the installer fails to detect or configure your monitor properly, you can choose from this list the monitor
which is connected to your computer.

Resolution

Here you can choose the resolution and color depth from the available ones for your graphics hardware.
Choose the one which best suits your needs (you will be able to make changes after the installation). A
sample of the chosen configuration will be shown in the monitor picture.

Test

Depending on your hardware, this entry might not appear.

The system will try to open a graphical screen at the desired resolution. If you see the test message during
the test and answer Yes, then DrakX will proceed to the next step. If you don’t see it, it means that some part
of the auto-detected configuration was incorrect and the test will automatically end after a few seconds
and return you to the menu. Change settings until you get a correct graphical display.

Options

This step allows you to choose whether you want your machine to automatically switch to a graphical
interface at boot. Obviously, you may want to select the No option if your machine is to act as a server, or
if you were not successful in getting the display configured.

3.12.4. Selecting Available Services at Boot Time

This dialog is used to select which services you wish to start at boot time.
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DrakX will list all services available on the current installation. Review each of them carefully and uncheck
those which aren’t needed at boot time.

A short explanatory text will be displayed about a service when it
is selected. However, if you’re not sure whether a service is useful
or not, it is safer to leave the default setting.

At this stage, be very careful if you intend to use your machine as
a server: you probably don’t want to start any services which you
don’t need. Please remember that some services can be dangerous
if they’re enabled on a server. In general, select only those services
you really need.

3.13. Installing Updates from the Internet

By the time you install Mandriva Linux, it’s likely that some packages have been updated since the initial
release. Bugs may have been fixed, security issues resolved, etc. To benefit from these updates select Yes if you
have a working Internet connection, or No if you prefer to install updated packages later.

Choosing Yes displays a list of web locations from which you can retrieve updates. You should choose one
near to you. Review the packages from the tree selection, and press Install to retrieve and install the selected
packages.
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3.14. It’s Done!

There you are. The installation is now complete and your GNU/Linux system is ready to be used. Just click
on Reboot to restart the system. Remember to remove the installation media (CD-ROM or floppy). The first
thing you should see after your computer has finished doing its hardware tests is the bootloader menu, which
allows you to choose between the OSes your system can boot.

3.14.1. Advanced Options

The Advanced button shows more buttons to:

1. Generate auto-install floppy: enables you to create an installation floppy disk which automatically performs
a whole installation, similar to the one just finished, without the help of an operator.

Note that different options are available after clicking on that button:

• Replay. This is a partially automated installation. The partitioning step is the only interactive procedure.

• Automated. Fully automated installation: the hard disk is completely rewritten, all data is lost.

This feature is very handy when installing on a number of similar machines. See the Auto install (http:
//qa.mandriva.com/twiki/bin/view/Main/AutoInstall) section on our web site for more information.

2. Save package selection1: saves a list of the packages selected in this installation. The following screen shows
you the possible media to use to save the package list onto: you might need to fill some parameters when
you click on the Next button.

To use this selection of packages with another installation, perform the installation as usual up to the
point of the package selection, and choose to select individual packages, without worrying about the
current package selection. Use the floppy icon and select the Load option. Then choose the medium which
contains the package list. Finally click OK: the list of packages you loaded will be selected and installed.

1. You need a FAT-formatted floppy to save on a floppy disk. To create one under GNU/Linux, type mformat a: or, as
root, fdformat /dev/fd0 followed by mkfs.vfat /dev/fd0.
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3.15. How to Uninstall Linux

If for any reason you want to uninstall Mandriva Linux, you can do so. The process of uninstalling Mandriva
Linux is done in two steps:

Removing partitions on your hard drive will inevitably result in the
loss of all data stored on those partitions. Please make sure you’ve
backed up all of the data you want to keep before proceeding.

1. Remove the bootloader, LILO in this example, from the Master Boot Record (MBR). To do so, execute lilo
-U in a console, as root. Doing this will not only uninstall LILO but will also restore the previous master
boot record, if any.

If you have a different boot loader, please refer to its documentation to determine how to regenerate the
master boot record.

2. Delete all partitions related to Mandriva Linux on your hard drive (usually partitions hosting ext3 file
systems and the Swap partition) and — optionally — replace them with a single partition using fdisk.

a. Log out from your current session and log back in as root.

b. Open a terminal window and run fdisk /dev/hda (if the hard disk containing Mandriva Linux
is other than the 1st IDE disk, change /dev/hda accordingly).

c. Use the p command to display partition information, and then use the d command to delete all
unneeded partitions.

d. If you want to create a single partition, use the c command, specify 1 as the partition number,
make it use the whole space available, and when asked for the partition type use the L command
to list the supported partition types and choose the right one for the OS you plan to install later.
Some examples: c for a FAT32 (Windows® 9x) partition, 7 for a NTFS (Windows® NT/Windows®

2000/XP) partition, 83 for a GNU/Linux partition. Finally use the w command to write changes
back to disk.

Once this is done, just reset or shutdown the machine “the hard way”.
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This chapter is aimed at users migrating from Windows® or Mac OS® X. Instead of presenting the various
applications in depth, it tries to answer the most common questions and/or issues former Windows® or Mac
OS® X users might ask.

4.1. Where’s my...?

Experienced Windows® and Mac OS® X users are normally accustomed to certain functions and/or concepts
which are often treated differently in GNU/Linux.

4.1.1. Start Menu

In Windows®, most applications and system tools are accessed through the so-called Start Menu; this concept
remains more or less the same, except it’s now called the Main Menu: you open it by clicking on the yellow star
in the panel.

For users coming from Mac OS® X, Mandriva Linux’s Main Menu can be considered as a replacement for func-
tions from both the Apple Menu, located at the far left of the menu bar, and the Applications folder available in
the Finder.

4.1.2. Applications

The wide variety of applications is a large differentiator between GNU/Linux and Windows®. Mandriva Linux
installs many more applications onto your system, and clicking on the main menu gives you a wide range of
choices depending on what you would like to do. Most standard file formats can be handled: PNG pictures,
Rich Text Format texts, PostScript printouts, etc. These file formats should always be preferred as they facilitate
exchange of data between applications, while ensuring your freedom to change to another application and/or
operating system at any time.

You may also have many files in proprietary formats such as Microsoft® Excel or Microsoft® Word documents.
OpenOffice.org is just one application which can handle most popular formats for office applications (see Word
Processor, page 65 and Spreadsheet, page 67).

We specifically mention office documents because they are widely
used. Due to space constraints we cannot cover every single Win-
dows® application and its GNU/Linux equivalent. However, there
is a high probability that you will find GNU/Linux equivalents for
all the programs you used under Windows® or Mac OS® X. To
get an idea of GNU/Linux equivalents of Windows® applications,
you can consult this table of equivalents (http://linuxshop.ru/
linuxbegin/win-lin-soft-en/table.shtml).

Mac OS® X users may find similarities between Mac OS® X and GNU/Linux applications, because Mac OS®

X is based on BSD®, a UNIX®-like system on which GNU/Linux is also based. Moreover, other applications
designed for the desktop have been ported to, or are available under, the X11 implementation available for
Mac OS® X.

You may also install a large number of applications through the RpmDrake utility (please refer to “Package
Management through Rpmdrake”, page 95).

4.1.3. Control Panel/System Preferences

The Control Panel in Windows® and the System Preferences utility in Mac OS® X are replaced by the Mandriva
Linux Control Center under Mandriva Linux. It can be accessed by choosing System+Configuration→Configure
Your Computer in the main menu. With this interface, you have the ability to modify most of your system’s
settings with graphical tools.
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4.1.4. Command Shell

GNU/Linux is still very fond of shell environments. Unlike Windows® the popularity of the shell is not fading
away as is evident by the availability of the shell in Mac OS® X. By default, Mandriva Linux installs bash, a truly
powerful shell environment. You can access it by opening the main menu and choosing System+Terminals→
Konsole.

Few of your DOS commands or functions work in a Linux shell.
Take a look at the Introduction to the Command Line chapter in
the Reference Manual to discover their equivalents and much, much
more.

4.1.5. Network Neighborhood

GNU/Linux uses TCP/IP by default, not SMB (the Windows® network protocol), so there’s nothing like a net-
work neighborhood icon to give you a view of the network you’re in. However, you may use the LinNeigh-
borhood application to give you similar functionality.

Konqueror can also accomplish the same tasks. Just type smb:/ in the location bar, and all of the shared Win-
dows® resources on the network will appear.

See File Sharing, page 73 for more information.

4.1.6. C: Drive

The “lettered drive” is a concept exclusive to Windows®. On UNIX® systems, the drive notion (C:, D:, ..., Z:)
is replaced by “mount points”. From a user perspective, you’re always accessing directories. Your system is
configured to “load” all relevant disks, disk partitions and remote systems, and then assign them to a specified
directory, generally under the /mnt directory. While this concept is similar to that found in Mac OS® X, it is
slightly different. What is mounted under /mnt with GNU/Linux is mounted under /Volumes in Mac OS® X
but is made available as a “root file system” in the Finder.

4.1.7. CD/DVD Drives

The same concept as for C: applies here. CD-ROMs are mounted in /mnt/cdrom. To access the CD-ROM, just
click on the desktop icon and the CD-ROM’s contents appear in a new window.

Things are a bit different for audio and data CDs: upon inserting an
audio CD in the drive, the CD player is automatically loaded and
starts playing. Please see Audio Applications, page 79.

4.1.8. Other Removable Media (floppy, USB key, etc.)

Like CD-ROMs and disk partitions, floppy disks, USB keys, and other removable media are mounted and will
appear under the /mnt directory. Icons are displayed on your desktop to access some media directly; all media
is accessible through the media icon on the desktop.

4.1.9. My Documents

Under Mandriva Linux every user has a directory called the user’s home directory: that is the place to store
the user’s documents. For example, Peter should store documents in /home/peter. A MyDocuments directory
could be created inside the user’s home to “mimic” Windows® behaviour.

The home directory concept is analogous to the C:\Winnt\Profiles\user_name\ or C:\Documents and
Settings\user_name\ directories in Windows NT®, Windows® 2000 and Windows® XP and is explained in
“Using KDE”, page 45.
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Under Mac OS® X this is very similar. The home directory’s equivalent is /Users/user_name which contains
a directory called Documents.

4.2. A Brave New World!

Now that you have found your way around GNU/Linux, here is a brief presentation of the features which make
excellent reasons to migrate to GNU/Linux.

4.2.1. A Multiuser Environment

GNU/Linux, like Mac OS® X, is based on UNIX®. This basically implies a shift in the structure of your envi-
ronment, from a single workstation to a multiuser architecture and implies very thorough user management.
Each file, service and application is exclusively allocated to a user or a group of users, according to its na-
ture. For example, every user has his or her own personal directory, containing personal data and personal
configuration files, which can be made inaccessible (even invisible) to other users.

4.2.2. Multiple Tasks

GNU/Linux has always been a very strong operating system for multi-tasking (running many applications
concurrently) and still remains a leader in this domain.

4.2.3. Multiple Desktops

Modern desktop environments available for GNU/Linux give you many virtual desktops to work with, instead
of just a single desktop. Users who like to have numerous applications running at the same time will greatly
appreciate this feature since it makes for a much cleaner working environment.

4.2.4. Full Desktop Customization

Regarding aesthetics, GNU/Linux truly rocks! Not only can you choose between many different window ma-
nagers, but you can also highly customize their appearance with themes. Themes go beyond just the initial
look and feel: actually, everything you see can be modified, from the background image to the behavior of
applications when they are closed, which is truly unique.

See the themes page on Freshmeat (http://themes.freshmeat.net/) for available designs.

4.2.5. Thousands of Free Applications

The GNU/Linux community is by far the most generous one. Given a specific problem, you will most likely
find a script or an application to answer your needs, for free! Also, Mandriva Linux includes hundreds of
applications not documented in this book, so don’t be shy, try them out. You’ll most probably be surprised by
the extent of the possibilities GNU/Linux offers.

GNU/Linux also offers advanced server functionality, such as the ability to host mail or web page servers “out
of the box”.

4.2.6. No More Reboots!

Windows® and Mac OS® (although this has largely been addressed in Mac OS® X) users know the level
of frustration generated by crashing systems. Even though GNU/Linux is not perfect, its stability is one of
its strongest points. Sometimes, applications crash, but rarely do they take the operating system down with
them. Also, installing new applications or devices and modifying the system’s configuration doesn’t require a
reboot: they are immediately taken into account.

We hope this rapid tour will help you truly appreciate GNU/Linux’s strengths. Do not be afraid to explore
further!
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5.1. Introduction

This chapter is written for inexperienced GNU/Linux users. If you know how to log in and out, use KDE and
know where your applications reside on your Mandriva Linux system, skip ahead to the next chapter. If not,
read on! After reading this chapter, all subsequent chapters will make much more sense to you.

If you’re an experienced Windows® or Mac OS® user, refer to
“Migrating to Linux from Windows® and Mac OS® X”, page 31,
which will ease the transition between those operating systems and
GNU/Linux.

5.2. The Bootloader Menu

The first component you see when your Mandriva Linux boots is the bootloader menu. It allows you to boot
your GNU/Linux system, or any other operating system installed on your machine, as well as some special
options.

The number of items and their names vary depending on your particular configuration. The one labeled linux
starts your Mandriva Linux system and it’s the default item unless you manually configure it differently. Wait a
few seconds or press Enter, and Mandriva Linux starts to load. Use the arrow keys on your keyboard and press
Enter to select another item.

5.3. Getting Ready for your Session

GNU/Linux is a multiuser system which means more than one user can access your machine, each with the
ability to keep his own data and configuration files private and protected from other users. The different user
accounts must be created by the administrator who is called root. You must have set his password during
the installation, and he has no restrictions at all on the system.

It’s very important to understand the terms “to log in” and “to log out”. To log in means to identify yourself
to the computer. Think of it as a security officer verifying who you are before letting you in. After logging in,
the system takes a number of actions in order to give you access to the system’s resources. By logging in, you
start a so-called “session”.

When you log out you are telling the system you no longer need to use its resources. Your personal session is
closed, you exit the graphical interface and the login screen appears once more.

Although these definitions are valid within the scope of this chapter,
they are oversimplified. As you read the following chapters, you will
better understand these concepts, their advantages and options.

5.4. Beginning your Session

We assume that you are sitting in front of a running Mandriva Linux computer which, when turned on, automa-
tically displays the graphical login screen. If this isn’t the case and you’re facing a black screen with something
like:

Mandriva Linux release 2006.0 for i586
Kernel 2.6.12-8mdk on an i686 / tty1
machine_name login:

with a flashing cursor, type your user name then your password. You should now be logged in. Now type
startx to launch the graphical interface (KDE by default, see “Using KDE”, page 45). If this doesn’t work,
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please refer to X Doesn’t Start, page 186. In order to automatically start your system in graphical mode, refer
to Controlling the Graphical Configuration, page 104.

Identifying Yourself

To log into the system, you need to supply your user name and password (see figure 5-1).

Figure 5-1. The Login Window

If you’re the only user on your Mandriva Linux system, and typing your user name and password annoys
you, you can set your system to boot directly into your favorite desktop environment. This feature is called
auto-login (see Configuring the Login Mode, page 171).

Be careful with this option as no password is asked for, therefore
anybody sitting in front of your system can use it and have access
to your files.

5.5. Using your Graphical Environment

5.5.1. The Mandriva Linux Desktop

All modern graphical environments share a common set of features: a main menu, a desktop area with so-
me icons, a panel, etc. In the following paragraphs we describe the elements which comprise the desktop
environment.

36



Chapter 5. Linux for Beginners

Figure 5-2. The KDE Desktop

1. Icons are located on the left of the screen and in the panel at the bottom of the screen. Clicking on an icon
either launches a program or opens a folder. In both cases a window appears on your desktop.

2. The panel is located in the lower part of the screen. It provides quick access to useful tools such as a
Terminal, a web browser, a text editor, etc. Each icon represents a program.

3. The desktop, also called the background, is where everything you see or use lives, such as the icons and the
panel. Right-click on a free area on the desktop (i.e. where there is nothing) and a menu appears. It gives
you access to several more functions such as configuring your background or accessing your bookmarks.

5.5.2. Accessing Applications

Click on the main menu to access the software installed on your machine. The applications are organized
by task so finding the program you’re looking for is pretty easy.

5.5.3. Opening a Window on the Desktop

Click on this icon on your desktop to launch your file manager:
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Figure 5-3. KDE File Manager

The Konqueror file manager displays the content of your Home directory where all your personal documents
and files are stored. Only you and root can access them.

5.5.4. Managing Desktops

We introduced the desktop to point out the area of the screen where all objects are placed. On the
panel there’s a group of desktop buttons.

These buttons give you access to virtual desktops, which are identical copies of the desktop you see after you
log in. You will find more information about the handling and usage of virtual desktops in Virtual Desktops,
page 46.

Click on the button labeled 2 to simply switch desktops. Click on the button labeled 1 to go back to previous
desktop.

This feature called virtual desktops is very handy. It allows you to open several windows and to organize
them as you wish.

You can also change which virtual desktop a window is currently in. This may be handy to logically orga-
nize your work by desktop, for instance moving all Internet-related windows into desktop 2, all multimedia
applications into another desktop, and so on.

Right-click on the window’s title bar and access the To Desktop item. Simply choose the virtual desktop to
which you want to move your window.

5.6. Logging Out of Your Session

When you are finally done using your computer, don’t forget to log out in a proper manner.

Logging out can be done from the main menu or from the menu which appears when you right-click on the
desktop.

The screen shades and a little box with options appears. Click on End Current Session and you return to the
login screen.

Two other options are available: you can choose to shutdown the system (Turn Off Computer), as well as reboot
your system (Restart Computer).
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This is the correct and safe way to shut down or reboot your system. You should never do it by pushing your
computer’s power or reset buttons because this can lead to serious problems such as file-system corruption or
the loss of data.
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Apart from the manuals included with Mandriva Linux, documentation is available from many sources. The
next few pages contain suggestions which you might find useful.

6.1. Mandriva Linux-Specific Documentation

6.1.1. Mandriva’s Own Documentation

Some of these manuals may be available in your Mandriva Linux pack, in the mandriva-doc-en package. Once
this is installed, a new menu entry will be available: More Applications+Documentation→Mandriva Linux docu-
mentation in English.

This section lists all the documentation which Mandriva produced for the current release:

Starter Guide

This manual is intended to get you going with Mandriva Linux. It includes basic topics which should be of
interest to new GNU/Linux users, as well as configuration procedures for the most important elements of
Mandriva Linux.

Reference Manual

Available on-line and in the Mandriva Linux –– PowerPack Edition, this document covers advanced
GNU/Linux operations and system administration.

Server Administration Guide

This manual, only available in the Mandriva Linux –– Corporate Server pack, tackles the configuration of
your system as an intranet or Web server. It covers most common services such as web server, mail, file
sharing, etc.

6.1.2. Internet Resources

Internet information sources are widespread and many web sites are devoted to GNU/Linux and its use or
configuration. However, some sources of information are better than others.

Your preferred source of information should be the Mandriva Linux official web site (http://www.
mandrivalinux.com/). In particular, check out the support section (http://expert.mandriva.com).

On the other hand, many unofficial sources will also be of value. For one there is the Mandriva Community
Twiki (http://mandriva.vmlinuz.ca/bin/view/Main/WebHome). It offers a lot of resources and gives infor-
mation and documentation which can certainly interest Mandriva Linux users.

6.1.2.1. Mandriva Club

If you’re familiar with Mandriva Linux’s web sites, you probably know about Mandriva Club (http://club.
mandriva.com/). It’s the meeting point for all Mandriva Linux users. On it you will find questions along with
their answers, suggestions and news related to Mandriva Linux and GNU/Linux. You will be able to express
your opinions and influence future development of Mandriva Linux. If you’re not a member yet, we encourage
you to join.

One specific area of the Club is of particular interest: the Mandriva Club Knowledge Base (http://club.
mandriva.com/xwiki/bin/view/KB//) is the Mandriva Linux user’s database. It is probably the largest collec-
tion of Mandriva Linux-related documentation on the web.

It collects submissions by Mandriva Linux users. It also features a discussion forum and a community newslet-
ter. These articles are meant to be practical and target beginner and intermediate users.

Topics range from administrative issues, such as the handling of the shell, to the tweaking of X, GNU/Linux’s
graphical subsystem.
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6.1.2.2. Mandriva Security Advisories

The Mandriva Security Advisories web site (http://www.mandriva.com/security/) is Mandriva’s very own
security site which covers package vulnerabilities.

6.1.2.3. Mandriva E-training

The Mandriva E-Training web site allows you to buy quality GNU/Linux training in order to improve your Open
Source knowledge. You can access this web site (http://etraining.mandriva.com/) by using your Mandriva
Club account. A free demo on Samba is available.

6.2. GNU/Linux Useful Resources

In this section we present resources useful for any GNU/Linux distribution. Most are not written specifically
for Mandriva Linux, but may nevertheless prove useful.

6.2.1. The /usr/share/doc Directory

Most packages include their own documentation in one of /usr/share/doc’s sub-directories, which will be
named after the specific package. Mandriva Linux’s own documentation, when installed, is available in the
/usr/share/doc/mandriva/ directory.

6.2.2. The Man Pages

The Manual Pages (also known as “man pages”) are a set of exhaustive documents which help you acquire
better knowledge of GNU/Linux commands. The latter are usually issued through a “command line” and allow
great control over your system (see the Introduction to the Command Line chapter of the Reference Manual).
Although these man pages might seem discouraging at first, they offer great detail and we encourage you to
browse through them when a problem occurs.

This should be your primary source of information for shell commands. Almost all commands have a manual
page. Other items, such as certain configuration files, library functions for programmers and others system
aspects also have their own man pages.

Man page contents are arranged in different sections. References to these are made in the following manner:
for example, open(2), fstab(5) will respectively refer to the open page in section 2 and the fstab page in
section 5.

The easiest way to view a man page is through a browser. Using
Konqueror, type man:/man(1) in the Location bar and the man
page for the man command will be displayed. For example, to
display the man page for fstab(5), type in the Location field:
man:/fstab(5).

To display a man page in a terminal (or shell), type man. The syntax to obtain a man page is:

man [options] [section] <manual page>

man also has documentation, which can be obtained by typing man man. Manual pages are formatted and
then displayed using the less pager.

The names of the manual pages and their relevant sections appear at the top of each page. At the bottom of
the page you will find references to other pages with related subjects (usually in the SEE ALSO section).
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You can start by consulting the pages related to the different commands covered in the Reference Manual: ls(1),
chmod(1), etc.

If you cannot find the right manual page — for example, you want to use the mknod function in one of your
programs but you end up on the mknod command page — make sure you spell out the section explicitly. In
our example: man 2 mknod. If you forgot the exact section, man -a mknod will read through all the sections
looking for pages named mknod.
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7.1. Discovering the K Desktop Environment

This chapter will introduce the K Desktop Environment (KDE) and its panel. It will also talk about the concept
of virtual desktops, how to navigate through and manage them and session support. The range of features
KDE offers as well as its degree of personalization is huge and you are encouraged to refer to its integrated
help to learn more about this great desktop environment.

7.1.1. The Desktop

Figure 7-1. The KDE Desktop

KDE follows the modern desktop paradigm. In the above figure you see the desktop itself with some icons
on it, while the panel sits at the bottom. This figure also introduces something new if you come from the
Windows® world: virtual desktops (see Virtual Desktops, page 46).

Virtual desktops are not an exclusive KDE concept. Other
GNU/Linux desktop environments and window managers also make
use of them.

The icons on the desktop represent files, directories, applications, devices, web pages, etc. Almost “everything”
can be placed on it. Clicking on each icon opens its associated application.

Here are some of your desktop’s default icons, along with a brief explanation for each of them.

Home. Gives access to all your personal files. Under UNIX®-like operating systems (Mandriva Linux
is one of these), every user has a personal directory usually named /home/login_name.

Trash. Gives access to all deleted files (the equivalent of Windows®’ Recycle Bin). Files can also be
deleted without being thrown into the trash can (“direct” file deletion) so some deleted files might not be
accessible through the trash can.
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System and media Icons. Gives you access to your home folder, system’s settings, networked places,
storage media and the trash can. The media icon gives you access to all the storage media present in the system,
fixed and removable: hard disk partitions, CD/DVD drive, floppy disk drive, ZIP/JAZ drives, USB keys, and
others. Double clicking on a device icon opens the corresponding medium.

7.1.2. The Panel

Figure 7-2. The KDE Panel

The panel is the bar which sits at the bottom of your desktop1 and contains the following main components:

The Main Menu. Allows you to access the software installed on your system. It is the equivalent of
Windows®’ Start menu. Programs are arranged into convenient categories, so you can quickly and easily find
the application you want to run.

Show Desktop. Use this to minimize all currently opened windows. Pressing it again will restore the
windows to the state they were previously in. Handy when you your desktop is so full of opened windows
and you want to access, for example, a folder on your desktop.

Desktop Switching Applet. Makes switching between virtual desktops as easy as one, two, three.
See Virtual Desktops, page 46 for more information.

Kat Search Tool. Allows you to perform searches on files according to different criteria and metadata.
Please refer to Searching For Files, page 48 for more information.

7.1.3. Virtual Desktops

Think of virtual desktops as having several screens available but with only one monitor. By default, there
are two virtual desktops, right click on the desktop switching applet and select Configure Desktops to add or
remove virtual desktops and change desktop names for more meaningful such as Work, Play or Internet.

When you log in into KDE the last virtual desktop you were in when you closed your last session is opened.
To switch between virtual desktops just click on the desktop number in the desktop switching applet et voilà !

7.2. Personalizing your Desktop

7.2.1. Changing your Desktop’s Appearance

To change the desktop color scheme choose System+Configuration+KDE+ LookNFeel →Colors from the main
menu. In the Color Scheme list are predefined color schemes. Select the one you like and click on Apply.

1. By default the panel is at the bottom, but it may be placed on any border of the desktop.
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Figure 7-3. Changing KDE’s Color Scheme

You can also define custom color schemes: click on the element you want to change (for example, Active
Window to change the active window colors), then on the color bar, choose the color you like and click on OK
to apply it.

Figure 7-4. Changing KDE’s Background Wallpaper

To change the desktop background, choose System+Configuration+KDE+ LookNFeel →Background from the
main menu. Select the background picture option in the Background section and background scaling, colors
and blending in the Options section.

All desktop background settings can be applied on a per-desktop
basis using the Setting for desktop pull-down list. Please note that
doing so consumes more memory.
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7.3. Searching For Files

Kat is a search tool that is able to index your files based on the content of the file, thus allowing you to
look for files on your system. For example it can help you find all of your PDF documents containing
a given project. Kat is made of two parts: a daemon responsible for periodically indexing files, and an

interface to manage catalogs and perform searches.

Choose System+Archiving+Other→Kat from the main menu to open Kat.

Figure 7-5. Kat Catalogs View

1. Check configuration

Launch the setup wizard (Settings→Launch Wizard) to check everything works correctly. Pay particular
attention to the Helper Programs step. If some applications are missing, it is time to install them through
the Mandriva Linux Control Center (see “Package Management through Rpmdrake”, page 95).

2. Add Catalogs

This is done using the Catalog→New menu, or by right-clicking on the Kat applet, and choosing Configure
KAT, then clicking on the Add button in the Catalog section.

Add a catalog for your home folder, and another one for /usr/

share/doc so that you can perform searches both on your personal
files and on the documentation installed on your computer.

3. Check Indexation is Done

After adding new catalogs it can take some time before they get fully indexed. To check the indexation
status of each catalog, simply click on the Kat applet.

4. Perform Searches

Click on the search button in Kat’s main interface to toggle to the search utility.
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Figure 7-6. Sample Search Using Kat

7.4. KDE Sessions

KDE and its applications support sessions. This feature allows the system to save the state of all applications
that are in use when the user logs out of the desktop environment, and to restore them when the user logs
back in.

Please bear in mind that non-KDE applications, and even some
KDE ones, may have limited session support. The degree of session
recovery is up to the application, ranging from just opening the
application again, to opening it along with all the files that were
open inside that application.

By default, KDE automatically saves sessions whenever you log out of the desktop environment. To change
the default behavior, open the Session Manager (System+Configuration + KDE+Components→Session Manager
from the main menu.), make your choices and click on the OK button. The settings are effective the next time
you log into KDE.
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Browsing, Reading and Surfing

Using the Internet with Mandriva Linux is very easy. And since it includes many mail clients and web browsers,
you can choose the one you prefer.

The default e-mail client in Mandriva Linux is part of the Kontact suite of applications and is called KMail. With
it you can read and write e-mails, filter spam, sign and encrypt your messages, and more (see Writing E-mails
and Reading News, page 53). The growing popularity of RSS feeds convinced us to document Akregator an open-
source news reader (Akregator, page 57). To browse the web we provide you with documentation about the
very popular Mozilla-based Firefox (see “Surfing The Web With Firefox”, page 59. Since it’s also available on Win-
dows®, it’s seriously threatening Internet Explorer’s monopoly. With it you can enjoy tabbed browsing, watch
RSS feeds as well as the other standard web browser features such as managing (and importing) bookmarks.
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Chapter 8. Sending E-mails and Reading News

8.1. Writing E-mails and Reading News

The KMail mailer is integrated into a groupware client named Kontact which also contains the Akregator RSS
news reader. This chapter describes how to configure and use both of these applications to compose, read and
organize your e-mail messages, as well as your news feeds.

8.1.1. KMail

Launch KMail by choosing Internet+Mail→KMail from the main menu.

8.1.1.1. Configuring KMail

Figure 8-1. KMail’s Startup Interface

The first time you run KMail, Kontact’s main window appears and the Mail section is selected. Access the
configuration window through the Settings→Configure KMail menu. First of all, you must define an identity1

under the Identities category. Click on the Modify button and fill in Your name, Organization and E-mail address.

Use the Cryptography, Advanced and Signature tabs to set up other parameters such as different “Reply-To”
addresses, a GPG key to send messages securely, and so on. Click on OK and Apply to define your default
identity.

Now configure the mail servers in the Accounts section. Click on Add in the Receiving tab, select POP3 as the
account type2.

1. It is useful to create a different identity for each e-mail address you might have (work and private, for instance).
2. We use POP3 in our example since most ISPs provide POP3 accounts to retrieve mail. If you have another account
type, such as an IMAP (Internet Mail Access Protocol) one, the configuration differs slightly.
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Figure 8-2. Configuring a POP3 Mail Account

Complete the Name field with a meaningful one for this account and the Host field with your POP3 server’s
name or IP address. Type in the e-mail user name and password which your ISP provided you with in the
Login and Password fields. Check the Store POP Password option to avoid having to type your password each
time you want to retrieve messages (see figure 8-2)3. If you use many computers to access your e-mail with a
POP3 account, you should check the Leave fetched messages on the server option which allows you to access
the messages you already downloaded from another computer. Click on OK to add the account.

If you have a permanent network connection (such as DSL or cable-
modem) activate the Enable interval mail checking option which
tells KMail to fetch messages periodically.

3. However please understand that this means anyone can actually access your e-mails if they are using your user
account.
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Figure 8-3. Setting the Outgoing Mail Server

In the Sending tab click on Add, and select SMTP as the transport type. Fill the Name field with a meaningful
name for this server and the Host field with the SMTP server’s name or IP address (see figure 8-3).

For security reasons, the outgoing mail server you use may need
authentication. If this is the case, check the Server requires authen-
tication box and complete the login and password provided by your
ISP or network administrator.

8.1.1.2. KMail’s Interface

Figure 8-4. KMail Client Interface
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Toolbar. Where the main action buttons lie. See table 8-1.

Messages List. Where information (subject, date, sender, etc.) about messages stored in the currently selected
folder is displayed.

Message View Pane. Where the currently selected message’s contents are displayed.

Folders List. Where all folders are listed. The default folders are inbox (incoming messages), outbox (unsent
templates), sent-mail (already sent messages), trash (deleted messages) and drafts (draft messages).

Kontact Buttons. On the left of the interface are buttons to access Kontact’s components such as RSS Feeds (see
Akregator, page 57).

The following table shows the most important buttons available in KMail’s toolbar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-N Compose a New Message.

Ctrl-L
Get new messages for all defined e-mail accounts. Keep this button
pressed to display a list of all defined accounts; select the one you want
to get mail from in order to retrieve messages only for that account.

R Reply to the author of the selected message. A message-compose
window pops up with some fields already set.

F Forward (send to a third party) the selected message.

Del
Delete the selected messages. Deleted messages are moved to the
Trash folder. You can recover messages moved to the trash folder,
but deletion from the Trash folder cannot be undone: be careful!

Table 8-1. KMail’s Toolbar Buttons

Some of those buttons have a little black arrow at the bottom right
corner. An additional menu with related actions can be displayed
by pressing the mouse button a little longer.
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8.1.1.3. Composing a Message

Figure 8-5. The Message-Compose Window

Toolbar. This is where the main composition buttons reside. See table 8-2

Message Body. The area where you will type the content of your message.

Message Recipients. The list of all recipients of this message. By default, the following options are shown:

• To: the “principal” intended recipient of this message.

• CC (Carbon Copy): not-hidden “secondary” intended recipient(s) of this message. All recipients will have
access to the mail addresses to which this message is sent.

• BCC (Blind Carbon Copy): these recipients are also “secondary” but are hidden from the other recipients
of this message. No recipients of the message will have access to the other mail addresses to which this
message was sent.

The following table shows the buttons which are mostly used in the message-composition window, their
equivalent keyboard shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-Enter Sends the message immediately (your network connection must be
active). A copy of the message will be kept in the sent-mail folder.

Queue the message. The message will be saved in the outbox folder
and will be sent the next time you request mail to be sent (File→
Send Queued Messages).

Attach a file to the message. This function is also accessible through the
Attach→
Attach File menu. A standard file dialog will pop up. Select the file you
want to attach and click on Attach. Repeat for multiple files.

Table 8-2. Message-Composition Toolbar Buttons
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8.1.2. Akregator

Akregator is a feed reader or aggregator which can check on RSS-enabled web sites for the latest headlines or
articles. RSS is typically used on blogs, personal web sites but also on major media sites such as those from
the BBC and Reuters.

Figure 8-6. Akregator’s Interface

Find a syndicated site4 and save the feed’s URL by right-clicking on it. Then right-click on the All Feeds folder
at the top of Akregator’s tree structure. Paste the URL by clicking on your middle mouse button in the Feed
URL field and click OK.

Figure 8-7. Adding a Feed

Right-click on a feed and select Fetch Feed to retrieve all of its articles. The right side of Akregator’s window
allows you to see all of your feed’s article titles. Click on a title and then on the Complete Story link to read that
story in a new tab.

4. A site which offers RSS feeds.
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Chapter 9. Surfing The Web With Firefox

This chapter deals with the Firefox browser which is gaining more and more popularity each day, and is
also challenging other very widespread browsers on different operating systems due to its cross-platform
availability. One of Firefox’s fortes is that you can personalize it endlessly through extensions (Extensions, page
61) and themes (Themes, page 62).

9.1. A First Glance at Firefox

Figure 9-1. Firefox Interface

To launch Firefox click on this icon on your panel. You can also access it through the Internet+Web
Browsers→Mozilla Firefox submenu.

If Firefox’s interface isn’t displayed in the language you expected,
access the Edit→Preferences menu entry, and select the General
Language option. Add your preferred language on top of the list.
Refresh your browser for the changes to apply.

Firefox’s interface (figure 9-1) is composed of the following:

• Page Display Area. Where the contents of the sites you browse are displayed.

• Bookmarks Bar. Contains buttons which give you quick access to your favorite sites (see Managing Book-
marks, page 60), as well as Live Bookmarks.

• Navigation Buttons & Location Bar. Enter the URLs you wish to visit in the location bar. Local files can be
accessed through the file:// protocol.

• Search Engine Field. Type in a keyword and choose your preferred search engine (such as Googletm or
Yahoo!). The results are available in the Page Display Area.
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9.2. Using the Sidebar

The sidebar gives you quick access to the history of the sites you visited recently, as well as to your bookmarks.
To enable it, choose View+Sidebar from the menu and then choose between Bookmarks (Ctrl-B) or History (Ctrl-
H).

Figure 9-2. Bookmarks and History in the Sidebar

Search. Enter the keyword you wish to find results for (i.e. Mandriva Linux) in the Search field and press Enter.
This applies for both the Bookmarks and History sidebars.

Bookmarks. Clicking on one of your bookmarks from the sidebar automatically launches a request for that
page. It’s then shown in the display area. To search for specific bookmarks based on keywords, type one in the
Search field.

History. If you want to return to a site you visited three days ago, access the 3 days ago folder in the History
sidebar and click on the plus sign (+). The same behavior as for the bookmarks sidebar applies.

To change the number of history days to keep, choose
Edit+Preferences→Privacy from the menu and open the History
sub-section.
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9.3. Managing Bookmarks

Figure 9-3. Bookmarks Manager Dialog

Select Bookmarks→Manage Bookmarks from the browser’s menu to open the bookmarks manager (figure 9-3).
They are classified in a tree structure, all operations taking place on the currently selected tree node. Click on
the different available buttons to create folders, add separators, etc. Click on the Properties button to change
the current bookmark’s name or URL.

To export bookmarks to an HTML file choose File→Export, type a file name (bookmarks.html by default) and
click on Save.

To import bookmarks from an HTML file access File→Import, enter the name of the file you want to import
and click on Open.

9.4. Tabbed Browsing

Firefox allows you to browse many web pages at a time through tabbed browsing. Tabs let you browse many
sites at once without opening another browser window. Just hit Ctrl-T to open a new tab.

Figure 9-4. Firefox Tabs

Located at the right of the tab list the cross button allows you to close the current tab. By right-clicking on it
you access more options.

9.5. Extensions

Extensions are addons or plugins which enhance Firefox’s functionalities. To install extensions access Tools→
Extensions and then Get More Extensions.
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Figure 9-5. Firefox Extension Page

Once you find an extension which interests you click on it and install it. You need to close and reopen your
browser for the extension to be activated. Access the Extensions sub-menu again. The new extension will be
there and you can check out its Options.

9.6. Themes

A theme is what determines a window’s appearance. To acquire new themes:

• access the Tools→Themes submenu;

• select a theme and install it;

• close and reopen Firefox.

9.7. Installing Plugins

Plugins are programs which let your browser handle content other than HTML and graphics, such as
animations, streaming audio, Javatm applets, and more. Firefox’s plugins are stored in the /usr/lib/
mozilla-firefox-VERSION/plugins directory and installing plugins requires root privileges.

We will look at the procedures to install Javatm, Flash® and Real plugins. If you own a commercial version of
Mandriva Linux, installation is greatly simplified and all the needed packages are on the CDs. If not you will
need to find them on the Web yourself.

If you are a Mandriva Club member, you may be able to install even
newer versions of the software mentioned here.

9.7.1. Javatm, Flash® and Real Player

To use Java install the jreRPM package. To view sites built with Flash technology install the FlashPlayerRPM.
To listen to streaming media install the RealPlayer RPM (see “Package Management through Rpmdrake”, page
95).
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Using Mandriva Linux on a Daily Basis

The following chapters introduce the applications available under Mandriva Linux, such as file managers and
external devices.

First, we explore the office suite domain. We discuss the basic uses of OpenOffice.org placing emphasis on its
word processing (Word Processor, page 65) and spreadsheet (Spreadsheet, page 67) components.

The next section (Managing Your Files, page 71) discusses using Konqueror to manage or share files. You can
also browse the web with Konqueror. Then we guide you through basic printing operations (Printing and Faxing
from Applications, page 73).

Multimedia applications are a must for any OS to be considered as a personal workstation. We introduce
you to the multiformat amaroK audio player (amaroK Audio Player, page 79), the KsCD CD player and KMix
(Using the KMix Mixer, page 80), a simple mixer. Then we show you how to use popular open-source movie
applications such as Kaffeine (Movie Applications, page 81) and how to burn music, data and even mixed data
onto CDs using K3b (CD Burning, page 82).
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Chapter 10. Office Work

10.1. Word Processor

This section will give you a brief introduction to OpenOffice.org Writer’s word processing functions.

In order to make the text a little easier to read, we will alternate
between the popular OOo acronym and the very long, yet full and
correct OpenOffice.org name.

10.1.1. OpenOffice.org Writer

OpenOffice.org Writer is the part of the OpenOffice.org suite which provides the word processing functions. Ope-
nOffice.org Writer can read most popular Office formats, easing the transition from, and ensuring compatibility
with, other Office suites.

10.1.1.1. Starting

To launch OpenOffice.org Writer, select Office+Wordprocessors→OpenOffice.org Writer from the main menu. You
can also open it from any other OOo application screen, by selecting File+New→Text Document, which will
open a blank OOo Writer document.

When you first launch OpenOffice.org Writer, a dialog will show up asking you whether you prefer to use the
Microsoft® or OpenOffice.org format to save your files.

Your decision depends on whether you plan to exchange a lot of files with people who only use Microsoft®

tools. If this is the case, click Use the Microsoft ® Word file format, but be warned that it is not perfectly
supported. Also this is only the default format and can always be overridden by changing the File type in the
Save as dialog.

10.1.1.2. Interface

Figure 10-1. OpenOffice.org Writer’s Main Window
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10.1.2. Using the Word Processor

10.1.2.1. Styles

Word processor users often waste a lot of time formatting (changing paragraph alignment, font family, weight
and size, etc.) their documents instead of using that time to concentrate on document structure and document
content writing.

Styles provide a structure-centric approach to writing documents with a word processor, while nor-
malizing document formatting and layout, and easily automating the generation and maintenance of
table of contents (TOC), indexes, references, etc. In OpenOffice.org Writer, styles are handled using the

Stylist, click on its icon in the tool bar to open/close it.

When you have a... Then apply the ... style

Chapter Title Heading 1

Section Title Heading 2

Sub-Section Title Heading 3

Sub-Subsection Title Heading 4

Paragraph Text Body, First Line Indent

List Item List

Table 10-1. Suggested Styles

Use the styles listed in table 10-1, as a guide. Select the region of the document to apply the style to, and in the
Stylist window, double-click on the style you want to apply to that region.

The styles you use from the Stylist automatically become available
in the styles drop-down list (the first one in the format bar), so you
have the most used styles handy.

10.1.2.2. Margins

You can always adjust margins by hand with the ruler, but if you want to format a long document, this may
not be the best solution. This is where the Stylist comes in handy.

By clicking on this icon in the Stylist, you will access the page formatting section of the Stylist. First,
make a copy of the Default style:

1. Right-click on the Default item in the Stylist.

2. Choose New from the menu which pops up.

3. Assign a Name to your new style. The Next Style field will be updated accordingly when you select it. For
the purpose of this example, Default Copy will be used as the style name.

4. Click on OK to insert your new style into the list of available styles.

Then, right-click on your newly created style item and choose Modify from the pop-up menu. The Page Styles:
Default Copy window will appear. Open the Page tab and modify the margins to your liking.

This is the same as choosing the Format→Page menu.

In the Page Styles: Default Copy window, you can modify many formatting elements. If most of your work with
a word processor consists of writing business letters with a predefined format, you could set it up right now,
thereby saving lots of time.
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If you modify an existing style, you will overwrite that style’s original
settings. If you feel that you have made a mistake, simply click on
the Reset button to return to the last saved settings.

10.1.2.3. Lists

Use lists to enumerate the properties of an object (“unordered” or “bullet” list), or the steps to be performed
in order to accomplish some task (an “ordered” or “numbered” list).

Clicking on this button will format the selected text into an unordered list. Selecting the list items and
choosing Format→Numbering/Bullets from the menu will allow you to change the bullet type from a
predefined set.

Clicking on this button will format the selected text into an ordered list. The same rules as for unor-
dered lists apply regarding to the numbering format.

10.1.2.4. Page Headers and Footers

By default page headers and footers are common to all pages of a document. Use them to describe certain
aspects about the document’s content, for example: page number, total number of pages, chapter, section,
document’s title, etc.

Choose Insert+Header→Default from the menu to add a page header to your document, and choose In-
sert+Footer→Default to add a page footer to your document. Just type the header/footer text you want to
be shown or use one or more of the Insert→Fields menu items to compose the header/footer.

10.1.3. Going Further

If you wish to learn more on the usage of OpenOffice.org Writer, you should consult the tutorial
available on the Tutorials for OpenOffice (http://www.tutorialsforopenoffice.org/category_index/
wordprocessing.html) Web site.

Also don’t hesitate to refer to the OpenOffice.org Writer’s help which is accessible through the Help→Contents
menu, or by pressing the F1 key. You are bound to find the answers to your questions.

OpenOffice.org Writer is able to export your documents in PDF
format (choosing File→Export as PDF from the menu). This allows
you to publish your documents in the Adobe® Reader® format.

10.2. Spreadsheet

This section will give you a brief introduction to OpenOffice.org Calc’s spreadsheet functions. We take for
granted that you know why you intend to use a spreadsheet and will not delve deeply into application-specific
(accounting, financial, simulation, etc.) considerations.
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10.2.1. OpenOffice.org Calc

10.2.1.1. Starting

To launch OpenOffice.org Calc, select Office+Spreadsheets→OpenOffice.org Calc from the main menu. You can
also open it from any other OpenOffice.org application screen, selecting File+New→Spreadsheet, which will open
an OpenOffice.org Calc window with a blank spreadsheet on it.

When you first launch OpenOffice.org Calc, a dialog will show up asking you whether you prefer to use the
Microsoft® or OpenOffice.org format to save your files.

Your decision depends on whether you plan to exchange a lot of files with people who use only Microsoft®

tools. If this is the case, click Use the Microsoft® Excel file format, but be warned that it is not perfectly sup-
ported. Also note that this is only the default format and can always be overridden by changing the File type
in the Save as dialog.

10.2.1.2. Interface

Figure 10-2. OpenOffice.org Calc’s Main Window

Format Bar

This is the standard format bar for all OpenOffice.org applications used to change fonts, colors, alignment,
etc. of the application’s data.

Formula Bar

Use it to enter, edit or delete formulas inside cells.

Work Area

Where you enter the data in the spreadsheet: numbers, dates, formulas, images, etc.

Select All

Clicking on this little area at the top left corner of the work area will select all cells at once. It’s useful
when you need to make changes which are “global” to the spreadsheet. For example, changing all font
sizes in the cells to 10pts (points).
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Sheet Changing Buttons and Tabs

Spreadsheets usually contain more than one sheet. Use these buttons to easily navigate through each of
the spreadsheet’s sheets. You may also use the tabs to switch between sheets.

10.2.2. Using the Spreadsheet

The following sections explore basic functions such as entering data and formulas in the spreadsheet and
adding graphics to represent that data. An example of an imaginary company’s monthly expenses and sales
figures is used.

OpenOffice.org Calc is an enterprise-ready spreadsheet application and includes many features way beyond
the scope of this document. Consult Going Further, page 70, for more information on how to make full use of
OpenOffice.org Calc.

10.2.2.1. Entering Data

To enter data into a cell navigate to the cell and type the data in it, pressing the Enter key when you are
finished.

Auto-completion simplifies data entry “guessing” the next cell’s value using the current cell’s value as a base.
It works for any kind of data which can be associated to a series of consecutive integral numbers.

Figure 10-3. Simplifying Data Entry Using Auto-Completion

To use auto-completion put your mouse over the cell “handle” (the little black square located at the bottom
right of the cell border), click on it and drag the cell. The cell values will be shown in a tool-tip (see figure
10-3). Release the mouse button to complete the cells once the desired final value is shown.

Cell data can also be sorted according to different criteria. Select the cells you want to sort and then open the
sort options dialog choosing Data→Sort from the menu. Specify the sort criteria, order and additional options
and click on the OK button to sort the cells.

Make sure you also select columns and rows which act as“headers”
for the data in order for those to“follow” the sorting of the data.
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10.2.2.2. Adding Formulas

Formulas can be used to “automate” the spreadsheet allowing you, for example, to run complex simulations.
Within cells, formulas are defined by preceding all cell data with the = sign. Anything else is treated as “static”
data.

Operations are expressed using conventional algebraic notation. For example =3*A25+4*(A20+C34/B34)
divides the value in cell C34 by the value in cell B34, adds the value in A20 to the result, multiplies that by 4
and adds to 3 times the value of cell A25. Thus, rather complex expressions can be made using simpler ones
as a base.

OpenOffice.org Calc gives you many pre-defined functions which you can use in your formulas, explore them
by choosing the Insert→Function menu.

10.2.2.3. Charts: Explaining Data in a Simpler Way

When a spreadsheet contains too much information it often becomes difficult to understand how pieces of
data relate to one another: too many numbers and too little meaning. The best way to represent this kind of
data is through a chart.

As in all data-analysis functions, you must select the region you intend to show in the chart. So, select a range
of cells and then chose Insert→Chart from the menu to bring up the chart assistant.

Make your selections for the chart type, variant, title, axis titles, etc. and then click on Create to create and
insert the chart in the spreadsheet (see figure 10-4).

Figure 10-4. A 3D Chart Inside the Spreadsheet

Charts are “dynamic” in the spreadsheet which means that when
you change data in a cell belonging to a chart, the chart will be
automatically updated.

Clicking and then right-clicking on an inserted chart brings up a me-
nu showing options to change many chart parameters. For instance,
the chart’s title can be changed by double-clicking on it.
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10.2.3. Going Further

If you wish to learn more on the use of OpenOffice.org Calc, you should consult the tutorial available at the Tuto-
rials for OpenOffice (http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html) Web
site.

Also, don’t hesitate to refer to OpenOffice.org Calc’s help accessible through the Help→Contents menu, or by
pressing the F1 key. There you are bound to find answers to your questions. Topics are accessible through a
table of contents. An index is also available as well as a contextual search tool.

10.3. Managing Your Files

File managers have grown to become multi-tasking applications, which don’t only take care of basic tasks
such as copying and moving files around. With Konqueror you can browse a LAN, listen to songs, view your
photos, and more.

Access your file manager by clicking on the Home icon located on the top left of your desktop.

Figure 10-5. Konqueror’s Main Window

10.3.1. Sidebar

A sidebar may appear on the left side of the main view. Select Window→Show Navigation Panel (or use the F9
key) to show it.

Here are short definitions of the icons in Konqueror’s sidebar:

Icon Meaning

amaroK. Gives you access to the amaroK music player (amaroK Audio Player, page 79).

Bookmarks. Quick access to your bookmarks.

History. Permits you to access folders and network (web, FTP, etc.) sites you visited
recently.

Home Directory. Represents your personal folder in which you organize your
personal files.
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Icon Meaning

Network. Gives you access to FTP archives as well as to Mandriva Linux- and
KDE-specific web sites (of course, you can add or delete entries too).

Root Folder. Lets you access your whole tree structure. Usually, you don’t have
sufficient rights to manipulate files outside your home directory. Only the system
administrator (root) can do this.

Services. Gives you access to all your applications as well as your Audio CD Browser,
your Fonts, your LAN Browser, Printer Browser and your system Settings.

Table 10-2. Konqueror Sidebar Icons

10.3.2. Accessing Storage Media

Access the Go→Storage Media menu to read the contents of your USB keys, external hard drives as well as
every media your computer contains (hard disks, mounted partitions, CD drives, etc.).

10.3.3. Manipulating Files

There are many ways to manipulate files within your file manager.
Drag’n’drop, keyboard shortcut combinations, opening two file ma-
nagers, etc. Choose the method you prefer (check out the Edit and
Window menus).

Copying Files. The easiest way to copy a file elsewhere in your tree structure is to select it and then to press
the Ctrl-C keys. Go in the directory in which you want to copy the files and press the Ctrl-V keys.

Moving Files. The same principle applies to moving files around. Cut the file using the Ctrl-X keys and paste
it with Ctrl-V keys.

Linking Files. Linking files allows you to access them without actually copying them to a different location.
Let’s imagine one of your files is buried into the /home/queen/Music/Artists/FavoriteArtist/ directory
and you want to access it quickly. Simply drag it to the desired folder, release the mouse button and select Link
Here.
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Deleting Files. The safe way to remove a file is to move it to the Trash, while the unsafe way is to delete it
for good directly. Select a file and press the Del key to remove it. To restore it, double-click on the Trash icon
on your desktop and drag the file(s) back into your Konqueror. To delete trashed files, simply Empty Trash Bin
by right-clicking on the Trash icon. To delete a file directly and permanently, select it and press the Shift-Del
keys.

10.3.4. Browsing Web Pages

If you frequently browse through directories containing HTML files, for example your distribution’s docu-
mentation, these directories generally contain a file called index.html.

Let’s take the /usr/share/doc/mandriva/en/Drakxtools-Guide.html/ directory as an example. Click on
index.html to display its contents and browse through the documentation.

10.3.5. File Sharing

This feature allows you to share your documents with other people on a local network and to access docu-
ments other people share. It also enables system administrators to provide users with common repositories
where everyone can add, modify and consult files.

10.3.5.1. Sharing Files

If file sharing is activated through the Mandriva Linux Control Center (please see Allowing Users to Share Folders,
page 161) right-click on folders in your Konqueror window and choose Share which enables you to share one
or as many folders as you like through NFS1 or Samba2.

10.3.5.2. Browsing Shared Files with Konqueror

The lisa package must be installed for LAN browsing to work. If
not, you will have to start the lisa service after installing it.

Browse all available shared files on the network by opening the LAN Browser section in the Services sidebar. All
machines offering shared files will appear as folders under this section. Inside the host name folder appears
one folder per protocol supported by this machine. Those may be:

FISH

This protocol relies on ssh communications. Every local machine running an ssh server is able to connect
(providing proper authentication) and browse all the folders you have access to.

NFS

Under this Remote Share folder the shares provided by UNIX® machines are displayed (see Importing
Remote NFS Directories, page 161).

SMB

Shares provided by Windows® or SMB-enabled machines (see Importing Remote SMB Directories, page 159)
show up under this Remote Share folder.

1. NFS (Network File System) allows you to share files to or from your computer in a networked environment. Although
the NFS setup is easier than the Samba one, it can only be used within a UNIX®-based system (like GNU/Linux). Moreover,
NFS is an insecure protocol and should be used exclusively in a secure local network environment.
2. SMB is a protocol by which PCs share resources such as files and printers. Windows® and GNU/Linux (through Samba)
and OS/2 operating systems, among others, support the SMB protocol. It can be considered an alternative to Netware and
NFS.
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10.4. Printing and Faxing from Applications

GNU/Linux applications support a simple printing method based on a program called kprinter which can even
be used to build PDF files and to send faxes.

10.4.1. Accessing KPrinter

Just click on any application’s print button to invoke the printing interface. In most cases, this is kprinter. Select
the different printing settings and click on the Print button to start printing.

Every X application which supports the definition of its printing command can use kprinter. All you have to
do is invoke the application’s print options, look for an option named “Print command”, “Printer”, “Printer
Options” or similar, and fill it with kprinter --stdin. Then when clicking on the Print button kprinter’s
main window is displayed (no actual document will be printed at this point).

10.4.2. KPrinter’s Interface

kprinter allows you to set many options for printing your documents3, such as the output device (generally a
physical, local or remote printer), the number of copies, the paper size, the printer resolution, etc.

Figure 10-6. KPrinter Window

Choose the printer using the pull-down list in the Printer section. You can further configure the printer settings
by clicking on the Properties button. Click on the Options >> button at the bottom to set more printing options
and on the System Options button to access global printing configuration.

Usually, your local printer, the “Print to file” printers (both PDF
and Postscript) and the“Fax”printer are listed. However, if you are
in a network, all printers available on the network will be listed too,
so network printing becomes very simple.

3. The actual printing options you are able to set depend on the output device you have selected.
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10.4.2.1. Printer Properties

Figure 10-7. Printer Properties Window

One option worth mentioning is Pages per sheet (set to 2 in the example). This allows you to put up to 4 pages
onto a single sheet of paper (or 8 if you can print on both sides). This is a nice feature to save paper when
printing book drafts or other lengthy material which changes often.

Figure 10-8. Changing Printer Resolution

Click on the Driver Settings tab to change printer-specific options such as the resolution of the printing device.
When you click on the Resolution option the available resolutions are displayed, select the one you want from
the list.
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Other settings include printing modes which use much less toner or ink (search for something like “Economy
Mode”, “Toner Density” or “Toner Saving”). However, the output is much paler. If this is not available, choo-
sing a lower resolution often has similar effects.

Use the Save button to store current settings, making them the
defaults for subsequent printing jobs.

10.4.3. Building PDF Files

Select the Print To File (PDF) special printer, enter the file name in the Output file field as shown in figure 10-9,
and click on Print to build a PDF file.

Figure 10-9. Generating a PDF File

10.4.4. Sending Faxes

The special Send To Fax printer allows you to send the document you are working on directly by fax4. When
you click on the Print button, a dialog (figure 10-10) will appear.

4. Of course a modem fax must be installed on your computer and connected to the phone line.
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Figure 10-10. Faxing Main Window

The first time you need to make sure that your fax modem is properly configured, select Settings→Configure
KdeprintFax from the menu. Fill the information under the Personal section with your name, company and fax
number. In the System section make sure that the correct faxing system and its corresponding parameters are
set. An example is shown in figure 10-11.

Figure 10-11. Fax Settings

Fill in the Fax number field and click on the Send Fax button, or press the Enter key, to send the fax
immediately.

The View Log button (Ctrl-L) shows a window with the fax activity log (check it to make sure your fax
has been sent correctly).

The Address Book button (Ctrl-A) opens the KDE address book to let you select fax numbers to dial.
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11.1. Audio Applications

11.1.1. amaroK Audio Player

amaroK is “the” multimedia application to use to listen to your favorite music. You can organize your music
in collections, get information about recordings such as artist, lyrics, album covers, and more.

In this section we go through its essential features. Choose Multimedia+Sound→Amarok from the main menu
to launch amaroK.

Figure 11-1. amaroK’s Main Window

Once amaroK is launched this icon appears on the panel.
Right click on it to access its options.

Click on the Build Collection button to configure a collection, check all folders you want amaroK to look
for music files and click Ok to start building the collection.

Choose Settings+Configure amaroK→Collection from the menu to add more folders to your collection. Then
choose Tools→Rescan Collection from the menu to update the collection.

If you added files from removable devices (such as a USB key or
an external hard drive), make sure they are mounted at the same
location as when you originally added them to your collection or
amaroK won’t be able to find the files they contain.

Click on this tab to access all your playlists. If you don’t have any you can listen to the Cool-Streams,
which is a collection of online radio broadcasts. To build a playlist, simply drag tunes into the playlist then
select Playlist→Save Playlist As and give it a name.
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Click on the Media Device Browser tab to transfer songs to your portable audio device, such as an iPod.

Finally this icon allows you to access you local file system. You can use it as an alternative to amaroK’s
Collection.

11.1.1.1. Burning Tracks with K3b from amaroK

Right-click on songs or music folders and access the Burn contextual menu item (it’s slightly different whether
you choose to burn an entire album or a single song). You can burn in two formats: the “data” format means
you’ll be able to listen to the songs on your computer and your MP3 CD player, for example, while the “audio”
format also permits you to listen to the music through a traditional CD player.

11.1.2. KsCD CD Player

When you insert an audio CD in your CD drive the KsCD player starts up.

Figure 11-2. KsCD’s Main Window

On the left you have the typical CD player controls: Play/Pause, Stop, Eject, etc. The ones below alter the
playing order. Then, there are buttons to give you information on the disk you are listening to and to access
more advanced configuration options.

11.1.3. Using the KMix Mixer

KMix is a sound card mixer application under KDE. It allows you to fine-tune your sound cards through
various sliders.

Figure 11-3. KMix Main Window

The Output tab controls the volume levels of the sound sources of your sound card. The most important one is
the Master which controls the general volume. By right-clicking on each slider you have extra options such as
Split Channels, Muted Hide, etc. Clicking on the green dot at the top of a column will mute/unmute that sound
source.
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Clicking on this icon pops up a slider which lets you control
the master volume, as well as to mute all sound and to launch the
full mixer window.

The Input tab controls the volume levels of the recording sources of your sound card. If you use videoconfe-
rencing software or are a musician, this is where you’ll want to adjust your microphone and your auxiliary
devices. Clicking on the green dot at the top of a column will mute/unmute that recording source, the red dot
at the bottom enables or disables it.

The Switches tab goes deeper into your sound card’s configuration. Boosting your microphone, using an exter-
nal amplifier: these features are for advanced users who wish to really master their sound system. To activate
them, simply click on the dot at the top of each column.

Finally the horizontal slider enables you to balance your sound between the left and right speakers. Notice
that if your sound card supports separate levels for master’s right and left, the Output’s Master controllers will
be modified following the movement of the horizontal balance slider.

11.2. Movie Applications

11.2.1. Introduction

The main problem with video players under GNU/Linux is that most popular video codecs are proprietary, and
to implement them in a free software application (mainly due to the cost of licensing), the codecs have to be
reverse-engineered. This is very complex and may not be legal in some countries, which limits the availability
of such codecs, and thus the type of video files which may be displayed under GNU/Linux.

For example, it’s virtually impossible to play some compressed digital video files or DVDs without downloa-
ding the corresponding codecs from the Internet.

In some countries, the status of DVD playback and reverse-
engineered codecs are still under review. That is why Mandriva
does not include all the plugins to use those codecs1. The infor-
mation included here is meant to help Mandriva Linux users who
know that, in their country, using these codecs and plugins is legal.
Mandriva does not encourage law violation and you should ve-
rify the law(s) which apply in your case before you download
and use these codecs and plugins.

11.2.2. Kaffeine

Kaffeine is based on Xine libraries which can play video files and streams.

Double-clicking on a supported video file launches Kaffeine, opens the file, and starts playing it. You can also
launch Kaffeine by selecting Multimedia+Video→Kaffeine from the main menu.

The first time you run Kaffeine, a configuration wizard pops up and
we recommend you accept the default options.
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Figure 11-4. Kaffeine’s Interface

Kaffeine’s simple interface (figure 11-4) is comprised of the following:

• Display Area. Where the movie being played is shown. Press the Ctrl-Shift-F keys to switch between full-
screen and windowed modes.

• Position Control. You can “jump” to any part of the movie by dragging the slider right (or press the right
arrow key) to go forward; drag the slider left (or press the left arrow key) to rewind.

• Volume Control. Drag the slider right (or press the plus key) to make the sound louder; drag the slider left
(or press the minus key) to make it softer.

• Play Controls. A reduced set of the usual VCR controls: Previous, Play/Pause (keyboard shortcut: Space Bar),
Stop (keyboard shortcut: Backspace) and Next.

• Status. Located at the bottom right of Kaffeine’s window, it shows information about the playlist and the
movie being played.

To play a DVD, simply insert the disc in the drive and Kaffeine starts playing the DVD title. We recommend
you use full-screen mode to play DVDs.

11.2.3. Other Movie Applications for Linux

Xine

Xine is one of the most interesting video application for GNU/Linux. It supports a wide range of formats
and input sources. It’s fast, flexible and extensible. It’s also provided as a library on which many players
are based.

MPlayer

MPlayer is yet another interesting application and supports multiple output drivers, and even older video
cards. It can also handle DVD, AVI, VideoCD, amongst others. However you’ll probably have to download
and install winDLLs and proprietary codecs to make it work with many popular video formats. On one
hand this might seem unfortunate, but on the other it gives you access to all formats supported under
Windows®.

Totem

Totem is a GNOME 2 application based on Xine’s libraries. As you might imagine, its capabilities are very
similar to those of its “parent”, but it’s better integrated in the GNOME environment.
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11.3. CD Burning

In this section we discuss using K3b to perform common CD burning operations. K3b also supports DVD re-
cording, but we concentrate only on CD recording in this section. You only need to install the k3b-dvd package.
DVD recording is very similar to its CD counterpart.

Copyrighted Material. Please note that data, audio, video CD
or DVD copying is often forbidden by copyright law. The examples
provided here are informational only and are not intended to make a
CD/DVD pirate out of you. We assume that if you want to duplicate
copyrighted material, it’s because you have the right to do so.

11.3.1. Getting Started

K3b is automatically configured to give normal users access to the CD burner. However, we highly recommen-
ded that these users be part of the cdwriter group to minimize burning errors due to system overload. So,
go ahead and add those users to the cdwriter group. Please refer to Managing Users and Groups, page 144,
for information on users and group management.

Choosing System+Archiving+CD burning→K3b from the main menu starts K3b. figure 11-5 shows K3b’s inter-
face with a new data project open.

Figure 11-5. K3b’s Interface

Tool Bar. Where buttons to perform common actions lie. See table 11-1.

File Manager. To choose which files to include in the burned CD. Use the left-side tree to navigate the file
system and drag and drop the files you want to include in the project into the Project Manager.

Project Manager. Where all files which will be on the burned CD are shown and handled. Files can be removed
and their location (directory) on the CD can be changed here.

The following table shows the most important buttons available in K3b’s tool-bar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.
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Not all buttons are enabled at all times. For example, the Save
button is not enabled if there is no active project.

Button Keyboard
Shortcut

Function

Create a New Project. Once you click on this button a list of available
project types are shown: choose New Data CD Project to create a data
CD (see Burning Data CDs, page 84) ; choose New Audio CD Project to
create an audio CD (see Burning Audio CDs (CDDA), page 87); choose
New Mixed Mode CD Project to create a mixed mode (data+audio) CD;
choose New Video CD Project to create a digital compressed video CD;
choose New eMovix CD Project to create an eMovix
(http://movix.sourceforge.net) CD.

Ctrl-O
Open an Existing Project. A standard file dialog opens from where you

can choose the project you wish to open. Select the project you are
interested in and click the OK button.

Ctrl-S
Save the Current Project. A standard file dialog opens where you can

enter the name under which the current project will be saved. Type the
name of the project and click the Save button.

Copy a CD. To make an exact copy of a CD. It opens a window which
asks for the copy settings. Refer to Duplicating a CD, page 88, for more
information. Please note that you cannot duplicate copyrighted DVD
movies with this function, as they are encrypted.

Erase a CD-RW. To erase re-writable media. It opens a window which
asks for the erase operation settings. Please refer to Erasing CD-RW
media, page 90, for more information.

Table 11-1. K3b’s Toolbar Buttons

11.3.2. Burning Data CDs

11.3.2.1. Burning From an ISO Image

Let’s presume you have downloaded a CD-ROM image from the Internet and you want to burn it on a CD.
Choose Tools→Burn CD Image from K3b’s menu. Click the “open file” button to browse for the CD image file
and select the file in the standard open file dialog. The CD image is then verified and information about it is
displayed (see figure 11-6).
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Figure 11-6. Burn CD Image Options

Once the image is verified, you can insert the recordable medium and click on Start to write it to the disc.

If an already written re-writable medium is found in the CD burner,
a dialog pops up asking you whether to erase it first. Click Yes and
follow subsequent instructions if you want to erase it, or change the
medium for a non-written one and click No.

The Speed pull-down list should be set to Auto to make K3b select
the fastest possible recording speed supported by the combination
of your CD burner and the currently inserted recordable medium.
The“slowest”speed between the two limits the maximum recording
speed.

11.3.2.2. Burning a Set of Files or Directories

Choose File+New Project→New Data CD Project from K3b’s menu . Then drop into the Project Manager the
files and directories you want to include on the CD (see figure 11-7).
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Figure 11-7. Selecting Files and Directories to Include on a CD

Adding directories containing lots of files can take some time. Plea-
se be patient and wait until the Adding files to Project
PROJECT_NAME message disappears.

The space occupied by the selected files and directories is shown by a color-coded bar at the bottom of the Pro-
ject Manager, together with the volume expressed in MB and the available MB of the medium’s total capacity.
The bar’s color codes are as follows:

Green

The size of the set is less than that of the selected medium’s capacity (700 MB by default). There are no
capacity-related problems.

Yellow

The size of the set is nearly equal the selected medium’s capacity. If it’s a few MB below the medium’s
capacity, there won’t be any capacity-related problems; if it’s a few MB above the medium’s capacity, the
CD might be written without problems, but there’s little guarantee of success.

Red

The size of the set exceeds the medium’s capacity by many MB. The CD won’t be recorded properly.

Right-clicking on any file or directory in the Project Manager pops up a contextual menu with options to
remove and rename files, create new (empty) directories, etc. Files and directories can be relocated (change the
directory under which you want them to appear) on the CD using drag-and-drop.
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Renaming the top element of the left side tree in the Project Ma-
nager changes the CD’s volume name (K3b data project by
default for data CDs).

Choosing the Project→Burn menu entry displays a window where you can select writing parameters (see
figure 11-8). Insert a recordable medium in the CD burner and click the Burn button to start writing the CD.

Figure 11-8. Setting Writing Parameters

11.3.3. Burning Audio CDs (CDDA)

By audio CDs, we mean the ones you play in your car or home stereo equipment, not data CDs containing
OGG, MP3 or any other digital audio format files.

At the time of writing, K3b supports recording audio CDs from tracks digitized in Wave (*.wav), Ogg Vorbis
(*.ogg), and MP3 (*.mp3) formats. You can mix digital audio formats since K3b decompresses the compressed
ones on-the-fly. K3b can also create digital audio tracks from audio CDs, also known as “ripping” (see Audio
CD Extraction (Ripping), page 89).

Choose File+New Project→New Audio CD Project from K3b’s menu. Select K3b’s File Manager’s filter to Sound
Files, navigate to where the digitized audio files are and then drag the audio tracks and drop them in the
Project Manager (see figure 11-9).
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Figure 11-9. Selecting Audio Tracks to Include on the CD

Use drag and drop to move the files up and down the compilation. Once you have the tracks compiled in the
order you want in the Project Manager, you can write them to CD.
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11.3.4. Duplicating a CD

Figure 11-10. Setting Options to Copy a CD

Choose Tools→Copy CD from the menu. Select the number of copies (1 in the example), whether to remove
the temporary image or not (yes), the reader and burning devices (automatically set) and click on Start. The
“source” CD is then read, an image of it is made and the “target” CD is written.

11.3.5. Audio CD Extraction (Ripping)

Make sure that enough temporary space is available. You can check the available space in K3b’s status bar
near the right. Bear in mind that each minute of CD-quality digitized uncompressed audio takes a bit more
than 10MB of disk space.

Insert the audio CD to rip tracks from and double click on the drive in the left side of the File Manager.
The CD is read and, by default, all tracks are marked to be ripped. Remove the check mark from those you
don’t want to rip and click on the gears button to show a dialog to set ripping options (see figure 11-11).
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Figure 11-11. CD Ripping Options

Review the different ripping options (especially the file naming ones) and once you’re satisfied with your
settings click on the Start Ripping button.

11.3.6. Erasing CD-RW media

Figure 11-12. Setting CD-RW Blanking Options

You might want to format your CD-RW media in order to write it with different data. To do so, choose Tools→
Erase CD-RW from the menu (see figure 11-12). The Erase Type can be set to Fast (the CD-RW is quickly erased
in up to 3 minutes); Complete (the CD-RW is completely erased taking up to 90 minutes); and a few options
related to multi-session recording are also available. Insert the medium on the CD burner and click the Start
button to erase the CD-RW.
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12.1. MCC’s Components

The Mandriva Linux Control Center (MCC) enables the system administrator to configure the hardware and the
services used by all users in a friendly way.

Access the Mandriva Linux Control Center through the main menu (System+Configuration→Configure
Your Computer).

Figure 12-1. The Control Center’s Main Window

Here are some of the available menu entries:

• Options→Display Logs. When activated this option displays a Tools Logs window. It shows all system mo-
difications made by the configuration tools launched from within the Mandriva Linux Control Center.

• Options→Expert mode. Gives you access to some of the more advanced tools, which are shown in the table
below.

• Profiles. This menu gives you access to the configuration profiles features. We cover this topic in Managing
Configuration Profiles, page 92.

• Help→Help. Opens the help browser which displays documentation about the active configuration tool.

• Help→Report Bug. Allows you to report a bug to the development team. See The Drakbug Reporting Tool,
page 93.

The tools are sorted into categories. The following table lists them all and refers to the corresponding sections
of this manual.

Software Management “Package Management through Rpmdrake”, page 95

Hardware Configuring your Hardware, page 103

Controlling the Graphical Configuration, page 104

Changing your Keyboard Layout, page 108

Changing your Mouse, page 108

Configuring Printers with PrinterDrake, page 109
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Installing and Using Scanners, page 120

Setting up your UPS, page 126

Network & Internet Network and Internet Connection Management, page 129

DrakProxy: enables you to configure a proxy to access the Internet.

Internet Connection Sharing, page 134

System Customizing your Menus with MenuDrake, page 137

Display manager chooser: allows you to choose the X11 display manager
for users who graphically log onto the machine. Basically, all display
managers offer the same features, it’s just a question of taste.

Configuring Start-Up Services, page 140

Managing Available Fonts on your System with DrakFont, page 141

Setting your Machine’s Date and Time, page 142

Monitoring System Activity and Status, page 143

Console: simply opens a terminal to directly enter commands with the
administrator account (root).

Managing Users and Groups, page 144

Backing Up and Restoring your Files, page 147

Mount Points Managing your Hard Drive Partitions with DiskDrake, page 155

Managing Removable Devices, page 158

Importing Remote NFS Directories, page 161

Importing Remote SMB Directories, page 159

Allowing Users to Share Folders, page 161

Securing your Internet Access via DrakFirewall, page 168

Boot Configuring the Login Mode, page 171

Changing your Boot-up Configuration, page 171

Customizing your Boot Theme, page 172

Table 12-1. Overview of Graphical Tools

Additionally, the Online Administration category only appears if
the rfbdrake package is installed. This tool allows you to take
control of a remote host (Linux/UNIX®, Windows®).

Some more categories appear if the drakwizard package is
installed. The documentation for those wizards is available ondisk
as well as in the Server Administration Guide. Those wizards
enable you to do basic configuration of common LAN services such
as web, FTP, mail and database servers.

12.2. Managing Configuration Profiles

By default Mandriva Linux Control Center profiles enable you to configure network setups for different locations.
This is especially useful for laptops which need a different configuration for home, at the office, the coffee
shop, etc. It also allows you to activate different services from one profile to another (see Configuring Start-Up
Services, page 140).

12.2.1. Profile Handling

New profiles you wish to create are based on the active one. All modifications are automatically recorded in
the active profile. A single menu (Profiles) lets you manage them.
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Figure 12-2. The Control Center’s Profile Menu

New

Creates a new profile based on the active one’s settings. A dialog pops up asking for the name of the new
profile. Don’t forget to switch to that profile after creating it.

Delete

Shows a list of profiles you can remove. The active profile won’t be shown because it can’t be removed
while being used.

default

The entries which follow correspond to all available profiles, the active one being checked. Click on a
profile name to switch the host configuration to that profile.

Let’s take an example. You come back home with your brand new laptop which your system administrator
configured so you can connect to your corporate network. You now want to configure the network to access
the Internet from home with a dial-up connection.

1. Create a new profile called “Home”.

2. Switch to it.

3. Reconfigure your network so that the modem, instead of the network card, is used to access the Internet
(see Network and Internet Connection Management, page 129).

4. Connect to the Internet.

5. When back at the office, switch back to the “default” profile.

12.3. The Drakbug Reporting Tool

If you encounter unexpected behavior in Mandriva Linux-specific tools, Drakbug allows you to report it to the
development team.

To be able to report bugs using Drakbug, you need a working
Internet connection as well as a Drakbug account (http://qa.
mandriva.com/createaccount.cgi).

To run Drakbug, go to the Help→Report Bug menu entry of the faulty tool, or run it from Mandriva Linux Control
Center’s own menu. Drakbug can also be triggered automatically by a crashed Mandriva Linux tool.
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Figure 12-3. Reporting a Bug

In order to correctly report a bug, it is important to identify the package it is related to. To make this task easier,
enter the application name in the Application Name (or Full Path) field and click on the Find Package button.

Click on the Report button. Your web browser will then open. If you are not logged in to the Mandriva Bugzilla
web site (http://qa.mandriva.com/) you will be asked to log in (or create an account if you do not have one).
Once you are logged on the site, complete the bug report as completely and accurately as possible and click
on Commit
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Mandriva Linux uses the RPM packaging system and provides convenient tools to simplify package installation
by handling software dependencies automatically. The urpmi set of tools is command line based and discussed
briefly in the Reference Manual; here we will concentrate on Rpmdrake: Mandriva Linux’s graphical software
installation tool.

Rpmdrake consists of different tools, which you access by choosing one of the entries of System+Configuration+Packaging
in the main menu or by clicking on Software Management in the Mandriva Linux Control Center (see figure 13-1).

Figure 13-1. Software Management in the Mandriva Linux Control Center

We recommend that you access Rpmdrake via the Mandriva Linux Control Center.

13.1. Install Software

When launching this tool you have to wait a few seconds, while Rpmdrake searches the available
packages database. Then you are presented the Software Packages Installation interface.
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Figure 13-2. The Software Package Installation interface

The window is divided into four parts: the upper part offers you some possibilities to manipulate the list of
packages you can install. You will find this list in the middle on the left. Next to it, on the right, you have an
area where you can find a description of the currently selected package. At the bottom of the window you will
find two buttons and information about how much space is required to install the selected packages and how
much space you have available on your disk.

Additionally, a status bar in the lower part of the window displays
messages about actions currently in progress or completed.

13.1.1. Selecting Packages to Install

Let us have a closer look at the interface as shown in figure 13-2. A package named “frozen-bubble-1.0.
0-7mdk” is selected in the tree-view and in the package description area you see the required disk space,
a short summary (Frozen Bubble arcade game) and a detailed description (Full-featured, colorful animated
penguin eye candy...).

If your software medium repository is configured to use comple-
te package lists (not the summary synthesis files, but the full
hdlist ones, which happens to be the default option after insta-
lling your Mandriva Linux system), you may get more information
on the package by choosing the Maximum information radio button
in the access-area. In addition you can see a list of the files provided
by the package and the change log.

The status bar shows you the disk space required by the selected packages as well as the current free space.
Please note that due to dependencies, the disk space required by the selected packages might be greater than
the size required by the chosen package by itself.
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Rpmdrake shows you an alert box if you try to install more software
than the free available disk space. Nevertheless you may proceed
(you may, for example, be able to remove some no longer requi-
red files, such as programs downloaded from Internet in the past
and which you do not use anymore, to allow the installation to
continue).

Now you can begin the installation, by simply clicking on the Install button. A new window appears, showing
you a progress bar of how your installation is proceeding. If you prefer to leave without doing anything, you
can just click on the Quit button.

While selecting applications to install, it may happen that you choose a package which requires dependencies
(additional libraries or another tool) to work correctly. In this case Rpmdrake displays an information window
allowing you to choose whether to accept the selected dependencies, or to Cancel the operation (figure 13-3).

Figure 13-3. Rpmdrake — dependency alert box

Another possible scenario might be: you want to install a package which requires dependencies, and various
packages are capable of providing that dependency. The list of alternatives is then presented (figure 13-4).
You may read the additional information presented by clicking the Info... button to help you choose the best
alternative.

Figure 13-4. Rpmdrake — package alternatives

We will now take a closer look at the search and sort functions provided to ease your job as a system adminis-
trator.

13.1.2. Searching Packages

Sometimes you may know about some tool you saw somewhere or you heard of at a friend’s place, now you
wonder how to find and install them on your system.

It is really easy: just type the name, (or part of the name), in the text area next to the Search button. Then choose,
from the pull-down list, where you want to look for it (either in the package name, in the description provided
with the package or in the names of the files stored in the packages). After clicking on the Search button, a new
list appears (Search results), showing you the results Rpmdrake found while scanning the packages databases.

Let us take a look on the different sort orders:
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Mandriva Linux choices

This sort order shows the list of packages in the four groups you saw during the installation of Mandriva
Linux. This is the easier sort order because it focuses on a selected part of the available packages, those
which are considered to be the most useful of the distribution.

All packages, alphabetical

Instead of a tree view, you are presented with a flat list of all available packages you can install on your
system.

All packages, by group

Here you are shown the list of packages grouped by their functions (e.g. Games, System, Video, etc.).

All packages, by size

Here you get a list sorted by size (the biggest package at the top, the smallest at the bottom of the list).

All packages, by selection state

If you choose this presentation, you end up with a flat list, in which all selected packages are shown first,
the other available packages below them. To make it easier for you, those two parts are sorted alphabeti-
cally. This sort order is particularly useful just before the actual package installation, because it helps you
to see the selection of packages to be installed.

All packages, by medium repository

Once again you find the packages sorted alphabetically, but this time they are shown under the name of
the data medium they belong to.

All packages, by update availability

In this mode, you might get two groups of packages: a list of packages which might be added to your
machine, and a second list of the packages of which you have an older version already installed on your
computer.

13.2. Remove Software

As this interface works like the “Install Software” one, we will not repeat its basic functions. The
only difference to the installation interface is that you will deal with the already installed packages
list from which you’ll choose those you want to remove, instead of those packages which might be

useful to install on your computer.

13.3. Mandriva Linux Update

Mandriva now provides an automatic updates service; see“Mandriva
Online Services”, page 175.

Once again: if you have already worked with Rpmdrake’s software installation interface, you should
feel comfortable with Mandriva Linux Update. But let us look at the details.

When you launch this tool, it first asks you to choose an Internet repository to check for updates. You should
choose one in a country near you.

A small difference to the “Install Software” interface is the ability to choose which kind of update you want to
install on your computer by grouping them in certain ways. You may select:

Security updates

These updates solve security issues and should be installed as soon as possible.
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Bugfixes updates

These updates fix application misbehavior.

Normal updates

These updates just bring slight improvements.

The other difference is a new text section (Reason for update) inside the package description area. It provides
you with information about why this update was made available. This may help you decide if you want to
update certain packages or not. When you have a slow Internet connection or you have to pay per MB when
you are downloading, it would be wise to read it.

If you are not yet familiar with the interface, please go back to Install Software, page 95 to learn about it.

13.4. The Software Media Manager

This part of Rpmdrake is dedicated to the configuration of the package media repositories. As you
can see in figure 13-5 there are some media configured: “Main”, “Contrib”, etc. With this tool you
can add other software media: a CD from a magazine containing RPMs, a Web repository, etc.

Figure 13-5. The “Software Media Manager”

The check boxes in the left-hand columns allow you to flag the repositories:

Enabled?

Uncheck this box to temporarily disable the corresponding medium. The packages contained in this me-
dium will not be available for installation until you enable the medium again.

Updates?

This box must be checked for update media, that is, media that contains updates of packages that are
already in another medium, albeit with an older version number. Thus only update media are taken into
account when looking for updates.

Various buttons allow you to perform actions on the selected media.
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Remove

Allows you to remove a medium which you no longer use. Simply select the medium to be removed in
the list and click this button.

Edit

Here you may change the URL or the relative path to the synthesis/hdlist (if you do not know what
we are talking about it is wise to leave this window via Cancel instead of Save changes).

In case you need to pass through a specific proxy to access this medium, you can configure it here by
clicking on the Proxy... button. Note that you can also define a global proxy for all remote media through
the Proxy... button of the main interface.

This option also allows you to change from using hdlist files to synthesis files, which are much smaller
but with less information on packages. Synthesized files only have information about package names,
their dependencies and a short summary, you won’t be able to search for files inside uninstalled packages,
for example, and you won’t be able to see the full description for a package if you click on its name.

Add...

Use this button to add to your system all publicly available official package sources from Internet reposi-
tories. This is useful for example if you have a fast Internet connection or only have the first installation
CD at hand. Choose a mirror geographically near to your location.

After choosing a mirror and clicking Ok, package information for the source you chose is downloaded
and all included packages will be available for you to install and update your system.

Add custom

This button provides access to a new dialog, in which you may reference a new software package medium.

Figure 13-6. Rpmdrake — adding Media

Update...

You are here shown a list of already defined data media. You can choose the ones where you want to
update the list of available packages in it. This is useful for remote media to which new packages are
being added. Just start the process by clicking on Update.

Manage keys...

It is important that any new packages you install are authenticated. To do so, each package can be electro-
nically signed with a “key”, and you can allow/disallow keys on a per-medium basis. On figure 13-7, you
can see that Mandriva Linux key is allowed for medium “Installation CD”. Click on Add a key... to allow
another key for the selected medium (beware, do this with care, as with all security-related questions),
and on Remove key to remove a key from the selected medium.
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Figure 13-7. Rpmdrake — managing keys

Proxy...

If you are sitting behind a firewall and you still need to access remote media (especially for package
updates), you can do so if you have a proxy server which leads to the Internet (at least in an area where
you can find a package server). Normally it should be enough to fill in the Proxy hostname to get it working
(figure 13-8). If you need a user / password combination to get through the proxy, you can also specify
these here. Just confirm your changes by clicking on OK and you are done.

Figure 13-8. Rpmdrake — configuring a proxy

Parallel...

If you are running a large network of computers, you may want to install a package on all the computers
in parallel; this button opens a dialog window allowing the configuration of the “Parallel” mode. As it
is rather complicated and only useful to a limited group of people, this short introduction will not give
more details about it.

Global options...

This button allows you to configure the program used to download new packages and if the source should
be checked against a given key. These choices are used on all installed sources.

Up and Down arrows

These buttons allow changing the order that sources will be used when installing a package.

For advanced users
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Rpmdrake processes the urpmi configuration file (/etc/urpmi/
urpmi.cfg) from top to bottom to obtain a list of medium
repositories and the packages that each contains.

If a given package appears in more than one medium, and
versions differ, then the one with the newest version will be used,
ignoring the rest.

When a package with the same version appears in more than one
medium, only the one appearing first will be used, the rest will be
ignored.

Either way, you won’t miss available packages, the newest
one appearing first is the one that will be used.

Rpmdrake processes the urpmi configuration file (/etc/urpmi/
urpmi.cfg) from top to bottom to obtain a list of medium
repositories and the packages that each contains.

If a given package appears in more than one medium, and
versions differ, then the one with the newest version will be used,
ignoring the rest.

When a package with the same version appears in more than one
medium, only the one appearing first will be used, the rest will be
ignored.

Either way, you won’t miss available packages, the newest
one appearing first is the one that will be used.
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14.1. Configuring your Hardware

14.1.1. Hardware Detection and Configuration

The HardDrake project has been developed to simplify hardware detection and configuration
under GNU/Linux by providing a user-friendly interface.

14.1.1.1. What Is HardDrake?

HardDrake is a service for hardware detection, run at system boot time, and also a full GUI-based tool which
ties together many of the tools already included in a GNU/Linux distribution. It automates and simplifies the
process of installing new hardware. For the most part, HardDrake will be able to detect most devices.

On one hand, HardDrake is used to display information, and on the other, it can launch configuration tools.
With its easy-to-use interface, you can browse all the hardware your system contains.

HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you may try to upgrade the
ldetect library itself and its hardware database, located in the ldetect-lst package.

14.1.1.2. Usage

To launch HardDrake, you can start it through:

• the Mandriva Linux Control Center: click on the Hardware category, and then on the Hardware icon.

• a terminal: type harddrake2 as root. You can also pass parameters to HardDrake through the command
line (type harddrake2 -h to get a list of possible parameters).

• the desktop: go to the main menu. The HardDrake entry is in the System+Configuration+Hardware→HardDrake
sub-menu.

After all devices have been detected, the main HardDrake window will appear (see figure 14-1).

On the left, you can see the device tree showing you all of the hardware categories.
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Figure 14-1. Selected Device

By selecting a device, you will see additional information about it in the right frame. To better understand
the meaning of the information presented, you can consult the help page accessible by choosing Help→Fields
description from the menu.

Depending on the device selected, two other buttons may appear:

• Configure module. This pops up a window with all the module device parameters listed. For experts only!

• Run config tool. Launches the Mandriva Linux configuration tool (available through the Mandriva Linux
Control Center) associated with that device.

A special category called Unknown/Others might also show up, containing all the currently unknown hard-
ware in your system, as well as known hardware that does not fit into the existing categories (such as thermal
sensors, random number generators, etc.).

You can also toggle the entries in the Options menu to enable automatic detection of some hardware which
wouldn’t have been detected otherwise. You need to restart HardDrake for those changes to have effect.

If you have a Mandriva Online account and want to help us improve hardware support under Mandriva Linux,
or want to see your hardware better supported in the future, you can choose File→Upload the hardware list
from the menu and fill the form with your account data, then click on the Ok button: your hardware list will
be uploaded. You need a working Internet connection.

14.1.2. Problems/Troubleshooting

If you think you have found a bug related to HardDrake, report it using the Mandriva Linux bug reporting tool
(see The Drakbug Reporting Tool, page 93).

HardDrake does not probe for ISA PnP devices. If you have an ISA PnP sound card, run sndconfig or
alsaconf from the command line. You may need to install the sndconfig package or the alsa-utils packa-
ge.
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14.2. Controlling the Graphical Configuration

This set of tools allows you to configure your graphical display. With it you will be able to change your
video card, your resolution and your monitor. It can be useful if you happen to change one of your graphical
components after the initial installation.

If you cannot boot into graphical mode and you end up in a console
(command-line interface), log in as root and launch XFdrake.
You will get a tool similar to the one described in Controlling All
Video Parameters, page 106, but in text mode.

The graphical configuration tools are accessible through different icons in the Mandriva Linux Control Center
Hardware section.

14.2.1. Changing the Monitor

Figure 14-2. Choosing a New Monitor

This tool allows you to change the monitor type currently in use. When you click on it a win-
dow pops up, listing many monitor models (see figure 14-2). If your monitor was automatically
detected it will be listed as Plug’n Play along with its model.

If your monitor wasn’t automatically detected, you can choose it from the list. If you don’t find your monitor
or a compatible one, choose one with parameters corresponding to your own monitor from the Generic entry,
at the bottom.
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14.2.2. Changing Resolution

Figure 14-3. Changing the Resolution of your Screen

This tool enables you to change the current screen resolution (800x600, 1024x768, etc.) and the
color depth. Simply choose the one you wish to use. The monitor in the window displays what
the desktop will look like with the chosen configuration (see figure 14-3). If it looks good, click on
OK.

The changes will be activated after you quit and restart your graphical environment.

By default, the available resolution list only shows resolutions supported by your video card and monitor
combination. There is a special entry named Other which adds more possible resolutions along with their
ratio. Bear in mind that most monitors are designed with a 4:3 horizontal vs. vertical ratio.
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14.2.3. Controlling All Video Parameters

Figure 14-4. XFdrake Main Window

If you happen to change your video card after installing your system, or want to have full control over the
graphic configuration, run as root, XFdrake from a console. The tool shown in figure 14-4 will be shown.

Let’s look at the interface. The first three buttons allow you to change certain aspects of the graphical configu-
ration:

Graphic Card

The button displays the name of the graphic card currently configured. If you wish to change it, just click
on it. Depending on your card, different servers may be available, with or without 3D acceleration. You
may need to try different ones until you get the best result.

In case you cannot find the graphic card you have, but you know which driver supports it, select it from
the Xorg entry at the bottom.

Monitor

Enables you to change the monitor with the tool described in Changing the Monitor, page 105.

Resolution

Enables you to change the pixel resolution and the color depth with the tool described in Changing Reso-
lution, page 105.

If you are using KDE you can also change the screen resolution on
the fly by using the screen resize applet, accesible choosing Sys-
tem+Configuration+Hardware→KRandRTray from the main me-
nu.

Then, there are more buttons:

• Test. Click on this button to verify that your modifications actually work. It is highly recommended you do
test it, because if it does not work, it will be harder to recover a working graphical environment later. If the
test fails simply wait until it ends. If you are not satisfied with the suggested settings, choose No during the
test, and you will be returned to XFdrake’s main menu.
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Depending on your video card, video testing may not be availa-
ble. You will be warned of such a situation. If it happens that the
settings are incorrect and your display does not work, refer to“Trou-
bleshooting”, page 181 to use XFdrake’s text version.

• Options. You can choose to start the graphical server when your system boots. Answer No if you prefer to
have a text login. Selecting Yes will launch the graphical login manager at boot time.

• Quit. If you modified your graphical display in some way, the current configuration will be displayed and
XFdrake will ask you whether you want to keep your changes or not. This is your last chance to go back to
the old configuration. If all seems OK, click on Yes. If you wish to restore the previous parameters, click on
No.

The changes will be activated after you confirm them and restart your graphical environment.

14.3. Changing your Keyboard Layout

This tool allows you to define another keyboard layout. This is commonly done when the
keyboard you want to use is different from the one chosen at installation time.

Figure 14-5. Choosing a Different Keyboard Layout

Select your keyboard’s language and then its model from the lists shown in figure 14-5. If you own a multi-
media keyboard and are lucky enough to have it listed in the manufacturer list, chances are most multimedia
keys on it will be supported. Otherwise, choose your keyboard type under the Generic branch. Changes are
effective immediately after clicking OK.

If you choose a keyboard layout based on a non-Latin alphabet,
the next dialog will ask you to choose the key binding that will
switch the keyboard configuration between the Latin and non-Latin
layouts.
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14.4. Changing your Mouse

This tool enables you to set up a different mouse, which is useful if the mouse you are currently
using is not the same as the one you chose at installation time.

Synaptics Touchpad function is automatically configured to work
with almost every touch pad found on notebook computers. The
same goes for Wacom® tablets.

Figure 14-6. Choosing a Different Mouse

Mice are sorted into a tree according to their connection type and model (see figure 14-6). Highlight the mouse
of your choice and click OK. Changes take effect immediately after the mouse test is done.

The Any PS/2 & USB mice option works with virtually all modern
mice.

14.5. Configuring Printers with PrinterDrake

This tool allows you to:

• configure a newly installed printer on your machine;

• configure your machine to act as a server for a printer which has just been connected to your local network;

• set up your machine to access network printers served by other servers (GNU/Linux as well as Windows®

ones).

If you just installed a printer that wasn’t available when you installed
Mandriva Linux, make sure it is correctly connected and powered
on before launching the configuration tool.
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14.5.1. Initial Configuration

When you first launch the PrinterDrake tool, it may be in one of these states:

14.5.1.1. There is no printer directly connected to the computer.

Figure 14-7. Activate Printing

The tool did not detect any local printers. However you can print on network printers, or manually install
printers which weren’t detected by clicking on Yes.

Figure 14-8. Activating Network Printers

• Select the Local CUPS printing system option if you wish to configure your machine to act as a print server
for either a local printer which was not detected, or a network printer connected to your local network.

Any required software will be installed and then the main configuration interface (see figure 14-10) appears.
Click on Add Printer to install the network printer.

• Select the Remote server option if you wish to be able to print on printers served by another CUPS printing
server on the network. Your applications will immediately have access to all public printers served by that
server. You only need to provide the hostname or IP address of that server in the field (ask your system
administrator).

When this is done, the main configuration interface (see figure 14-10) appears. The Configured on other
machines tab will be filled with the available network printers.

110



Chapter 14. Hardware Setup

14.5.1.2. New Printer Detected

The following window appears when PrinterDrake detects a new printer.

Figure 14-9. A New Printer Is Detected

Simply confirm the automatic installation of the new printer. The main configuration interface (see figure 14-
10) is then displayed. Make sure you check that the printer parameters fit your needs (see Reconfiguring an
Existing Printer, page 118).

14.5.1.3. Printer Configured at System Installation Time

The main configuration interface (see figure 14-10) is shown. Make sure that the printer parameters fit your
needs (see Reconfiguring an Existing Printer, page 118).

14.5.2. The Printer Management Interface

Use the printer configuration tool’s first tab for locally connected printers (Configured on this machine), and the
other tab for printers available on your local network (Configured on other machines).

If your local printer was automatically added you should now verify
its configuration. Select it in the list, click on Edit and check the
Printer options.
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Figure 14-10. Managing Printers

The following buttons give you access to all available maintenance tasks:

• Add Printer: launches the printer configuration wizard described in The Printer Configuration Wizard, page
114.

• Set as default: sets the selected printer as the default printer when no specific printer is chosen at print time.
A cross appears in the Def. column of that printer.

• Edit: opens the printer configuration dialog described in Reconfiguring an Existing Printer, page 118.

• Delete: removes the selected printer from the available printer pool.

• Refresh: updates the list of printers with possible new or removed printers, especially useful for networked
printers.

• Configure CUPS: by default, your system is totally open. PrinterDrake uses all of the network’s available
printers and shares all of its local printers with the local network. Click on this button if you don’t want to
access network printers, or if you want to restrict the access to your local printers. This dialog also lets you
configure access to servers outside the local network.

The Options→Expert mode menu adds extra features to the tool.
See Expert Mode, page 119.

14.5.3. Print Server General Configuration

The Configure CUPS button allows you to control the behavior of printers connected to your machine and to
your network.
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Figure 14-11. CUPS Printer Server Configuration

This dialog enables you to switch between the client and server printing modes through the Remote CUPS
server and no local CUPS daemon button.

14.5.3.1. Client Mode

Figure 14-12. Client Mode Configuration

Select the On option to connect to another printer server. You then just need to specify the name or IP address
of that server in the field below.

If you choose this mode, your printing configuration is now finished. Accept the options by clicking the OK
buttons, and you will be able to check the list of available printers in the Configured on other machines tab of
the main interface (see figure 14-10).
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14.5.3.2. Server Mode

If you want your machine to access locally connected printers (through parallel or USB ports), or network
printers not already configured on another server, you need to select the Off option. Click OK, and you will
then be able to fine tune your printer server (see figure 14-11).

A number of options are available to further secure and enhance your print server features:

The printers on this machine are available to other computers

Allows other computers to print on printers configured locally. Remember to restrict access by clicking
on Printer sharing on hosts/networks (see below).

Automatically find available printers on remote machines

Tells your print server to automatically make all printers found on other servers available on the local
network, as if they were locally connected to your print server. This way your system’s users are able to
print on any printer the print server “sees”. If the remote printers you intend to use are served by a server
not on your local network, you can still tell the print server to use them with the Additional CUPS servers
button (see below).

Printer sharing on hosts/networks

Allows you to specify from which networks the local printers are made available.

Additional CUPS servers

Allows you to specify one or more CUPS servers to which you can connect and access printers. Specify
the IP address and port of the CUPS server in the dialog.

Japanese text printing mode

Replaces the original text filter for one more suited to Japanese texts, but with less features. Use it if you
have to print Japanese text-only files.

14.5.4. The Printer Configuration Wizard

Click on Add printer and the configuration wizard comes up.

14.5.4.1. Detecting a Printer

This tools enables the auto-detection of locally connected printers, network printers, and finally printers ser-
ved by SMB (Windows®) servers. First choose which type of printer you want to add (Local printer, Network
printer, Printer on remote lpd server, etc.).
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Figure 14-13. Printer Type

Select the printer you want to add from the list. If the detected printer isn’t the correct one check the Manual
configuration box and proceed with the printer model step (see figure 14-15). If autodetection fails, remove the
check mark from all check boxes, click on Next and follow the instructions below.

If you own a multi-function device such as those of HP or Sony, an information window pops up and gives
you information about your scanner and scanner software (ScannerDrake, page 121). Additional packages are
also installed.

PrinterDrake displays your printer’s model name. Choose Select model manually if it’s incorrect. Select the
printer you have or a compatible one (see figure 14-14) if yours is not specifically listed.
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Figure 14-14. Choosing the Printer Model

If you want to install the driver supplied by your printer manufacturer, click on the Install a manufacturer-
supplied PPD file button and select the medium containing the PPD file and browse to it. Accept subsequent
dialogs to use your chosen PPD file.

Figure 14-15. Choosing a Name for your Printer

Provide a name for your printer. The printer name must contain only letters, numbers and the underscore
(“_”) character. It’s better to limit its length to 12 characters maximum so that Windows® clients don’t have
problems when accessing it through Samba.
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If you have one or more configured printers, you are asked whether
the printer you are configuring is to be the default printer. If you
say No, the previous default printer will be retained.

Finally we strongly recommend that you print a test page in order to make sure everything works as expected.

14.5.4.2. Printing Options

Once the configuration is done, the options associated with the chosen printer are shown (see figure 14-16).
It’s important you choose the proper settings (such as paper size, media source, etc.) currently installed on the
printer. If the settings you choose are incorrect, printing may fail.

Figure 14-16. Configuring the Printer’s Options

For settings referring to printout quality, bear in mind that higher
quality levels may make the printing operation slower and may con-
sume more ink.

14.5.4.3. Printer Test

A few test pages are available (see figure 14-17). We recommend you print at least one test page so you can
immediately correct the parameters if something goes wrong. The printer should begin to print almost imme-
diately.
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Figure 14-17. Testing the Printer

14.5.4.4. It’s Done

If you’re not satisfied with your test page, answer the appropriate question with No and you will be led to the
printer configuration menu (see figure 14-18) where you can correct the settings. See Reconfiguring an Existing
Printer, page 118.

Your printer will now appear in the list of available printers in the main window (see figure 14-10).

14.5.5. Reconfiguring an Existing Printer

Double-clicking on a printer’s name in the list, or clicking on the Edit button, displays a menu where you can
choose actions to take on the selected printer (figure 14-18). Each option gives access to a particular step of the
wizard we described above (see The Printer Configuration Wizard, page 114). One difference is that the current
settings are predefined in all fields, and you may update them where required.
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Figure 14-18. Modifying an Existing Printer

There are a few additional options:

1. Disable Printer. Use this option to remove that printer from the printers available to the system’s users.
You might need to temporarily disable a printer under maintenance so that users don’t try to use it in the
meantime. When a printer is disabled, that option changes to Enable printer.

2. Learn how to use this printer. Displays information on how to use a particular printer model. In the case
of a multi-function device from HP, information about scanning and photo memory card access is also
displayed.

3. Remove printer. Deletes that printer’s configuration from the system.

Select an action in the dialog and then click on the Do it! button to perform it.

14.5.6. Expert Mode

The expert mode has three additional features:

• Choose a Different Driver to the Default One for a Printer. Different drivers are available for the same
printer. In expert mode, a third level appears in the printer model selection list (see figure 14-14). It allows
you to change each printer’s driver.

• Install Many Kinds of Remote Printers. This feature enables you to print on remote printers using the LPD
protocol, printers on Windows® servers which require authorization, or other arbitrary printer types.

If PrinterDrake is in expert mode, it doesn’t automatically confi-
gure new local printers on start-up. Use the Add printer button to
configure the printer. However you can choose to Configure Auto
Administration from the Options menu to override that behavior.

If you start the new printer wizard in expert mode, there is an additional step at the beginning.
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Figure 14-19. Configuring a Remote Printer

Different connection types are available:

• Local printer. A printer directly connected to a parallel or USB port on your computer. In most cases, the
printer model will be auto-detected.

• Printer on remote lpd server. A printer already served by another machine on a lpd server.

• Network printer (TCP/socket). A printer directly connected to your local network. The network can be scan-
ned and printer models automatically detected provided the Printer auto-detection box is checked.

• Printer on SMB/Windows 95/98/NT server. Relevant for printers already connected to a computer running
an OS which serves printers with the SMB protocol, including Samba printers (the necessary Samba compo-
nents will be automatically installed in this case). The network can be scanned provided the Printer auto-
detection box is checked.

• Enter a printer device URI. This option allows you to directly enter the printer’s Universal Resource Identifier
(URI) on your network. It can be used for any of the above remote connections, and more. This is useful
when your system administrator provides you with the printer’s URI.

Click on the Modify timeout for network printer auto-detection button to change the default timeout (4000 milli-
seconds, or 4 seconds) for detection of networked printers. Please bear in mind that the bigger the timeout, the
better the chances of detecting remote printers. However the auto-detection process will also take more time.

14.6. Installing and Using Scanners

This section explains how to install a scanner using ScannerDrake, and how to use it with SANE and XSane
(scanner interface software). We also present a list of other scanner interface software you could use with
GNU/Linux.

Please note that not all scanners are supported under GNU/Linux.
Before buying new hardware, remember to check out Mandriva’s
Hardware Database (http://www.mandriva.com/hardware) and
the SANE home page (http://www.sane-project.org/) for com-
patibility issues.
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14.6.1. Configuring your Scanner

14.6.1.1. ScannerDrake

The ScannerDrake wizard helps you install your scanner. Make sure your scanner is powered on and
launch ScannerDrake by clicking on the Scanners entry of the Mandriva Linux Control Center’s Hardware section.

The program tries to detect your scanner’s manufacturer and model. If it finds one then information about it
is displayed in the upper part of the wizard’s main window. Other options are also available (figure 14-20):

Figure 14-20. Installing your Scanner

Click on Search for new scanners to autodetect a new scanner you just plugged in. Click on Add a scanner
manually if the automatic detection fails and look for the specific model you own by browsing through the list
of available models.

Figure 14-21. The Tree-list of All Known Scanner Models

After choosing the appropriate model, you can leave the default Auto-detect available ports option and click on
OK. If you have a parallel port scanner, selecting /dev/parport0 in the pull-down list should be the right
choice.

Your scanner should now be installed and you should be ready to use the programs which come with SANE,
XSane or other acquisition software.
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Note that HP multi-function devices, such as the OfficeJet and PSC
printers, must be configured through PrinterDrake. Please refer to
Configuring Printers with PrinterDrake, page 109. The scanning
part of non-HP multi-function devices can be set up with Scanner-
Drake as a stand-alone scanner.

To test that everything works correctly, launch xscanimage1 from a terminal and try to acquire a picture from
your scanner. You may first acquire a preview of the scanned image by clicking on the Preview window button,
as shown in figure 14-22.

Figure 14-22. Acquiring Images with xscanimage

Note that xscanimage can also be launched directly from GIMP by choosing File+Acquire+xscanimage→Device
dialog.

ScannerDrake allows for scanner sharing between users connected via a LAN. Installation is very easy: just
click on Scanner sharing and either select The scanners on this machine are available to other computers or Use
scanners on remote computers depending on what you want to do. With these buttons you can define which
machines are allowed to use your scanners and which remote scanners you want to use.

1. The sane-frontends package must be installed.
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Figure 14-23. Sharing Scanners within a LAN

In order to share your scanner on your LAN, the saned package
needs to be installed. If it isn’t, ScannerDrake will ask you if you
want to install it. You also need to set up scanner sharing on the
machines from which you want to access the scanner. Check the
Use scanners on remote computers box, and then click on Add host.
Fill in the information in the Name/IP address of host field for each
of the machines which scanners.

14.6.2. Using Image Acquisition Software

14.6.2.1. XSane

While xscanimage is more than enough for your basic scanning needs, more experienced and/or graphic-
oriented users will want to use a more sophisticated program. XSane2 offers more options and a more infor-
mative display during the image acquisition process.

You can launch XSane through the Multimedia+Graphics→XSane menu item. Several windows pop up on your
screen.

2. The xsane package must be installed.
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Figure 14-24. XSane Multiple Windows

If the xsane-gimp package is installed, a GIMP plugin will be at
your disposal. It allows you to import your images directly into
GIMP for image retouching tasks. Choose File+Acquire→XSane:
device dialog to launch XSane. You can now scan your image and
have it sent directly to GIMP.

14.6.3. Advanced Configuration

14.6.3.1. Fine-Tuning the Resolution

Most modern scanners boast high resolutions, such as 1200, 1600 or 2400 DPI (Dots Per Inch). But it would be
a mistake to perform all of your scanning at the maximum available resolution. You will notice very little —
if any — quality difference between a 300 and a 600 DPI image scan, but the file size will grow exponentially,
up to many MBs of disk space for a single image file.

The resolution value should be chosen according to the device on which the image is to be reproduced. For
images to be viewed on computer monitors, e.g. for web sites, the resolution should be close to typical mo-
nitor resolution values, between 70 and 100 DPI. Higher values will result not only in bigger images, but the
dimensions will also increase, so that an image scanned at 160 DPI instead of 80 will be about twice as large3.

If you intend to print your images, a resolution of 300 DPI should be enough for most home printers. Increase
this value if you have a very high quality printer.

Higher values should be chosen only for specific uses, such as enlarged images on very high quality printers,
or quality scans of black and white originals. You will have to experiment a little until you’re satisfied with
the results.

14.6.3.2. OCR Software

By installing the kdegraphics-kooka and ocrad packages, you’ll be able to use Kooka, a simple graphical
front-end to SANE which is also able to perform OCR tasks. To launch it, choose Multimedia+Graphics→Kooka
from the main menu.

3. However scanning at a higher resolution and then reducing the resulting image size using graphic manipulation soft-
ware such as GIMP is one method often used to obtain better results than directly scanning at the desired final resolution.
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First choose the scanning device and then Kooka’s main window appears.

Figure 14-25. Kooka’s Main Window

Place the image you want to scan onto your scanner and click on Preview Scan at the bottom left of Kooka’s
window. For better results, you should choose the Binary Scan mode, and set the resolution to no less than 300
DPI. Then select the part of the image to be scanned and click on Final Scan.

To benefit from Kooka’s OCR features, you must configure it. Access the Settings→Configure Kooka menu, click
on OCR, and select the OCR engine you want to use.

Figure 14-26. Kooka’s Configuration Window

Once this is done you can click on this icon (Image→OCR Image) and click on Start OCR. The resulting
text will appear along with a spell-correction window.

Kooka is still in beta phase. Although it’s possible to make it work
properly you will need to adjust its parameters until you obtain a
decent rendering. For more information on Kooka please read its
handbook (Help→Kooka Handbook).
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14.6.4. Other Scanner Interface Software

Here is a list of other scanner interface software which is known to work under GNU/Linux.

• Users of the FLTK (“Fast Light Tool Kit”) graphic user interface could try FlScan (http://freshmeat.net/
projects/flscan/), a FLTK front-end for SANE.

• For EPSON scanners, you could download Image Scan! for Linux (http://www.avasys.jp/english/linux_
e/index.html), a scanner utility provided free of charge to GNU/Linux users by EPSON KOWA Corporation.

• While multi-functional HP devices are configured using PrinterDrake, owners of these devices should have
a look at the HP Linux Inkjet Project (http://hpinkjet.sourceforge.net/). The developers involved in
the project aim at providing GNU/Linux support for most Hewlett-Packard OfficeJet, PSC, LaserJet, and
PhotoSmart printer multi-function peripherals (MFPs).

14.7. Setting up your UPS

The role of a UPS (Uninterruptable Power System) is to provide you with electrical power whatever
happens. A UPS enables you to continue working for a certain amount of time due to its battery (usually up to
10 minutes depending on the model) even if there’s a power outage in your area. Its main function, however,
is to allow you to save your data and to cleanly close your machine, minimizing and even avoiding data
corruption and loss.

Open the Mandriva Linux Control Center in the hardware section and click on Set up a UPS for power monitoring
to launch DrakUPS.

The nut-server (“nut” stands for Network UPS Tool) package
needs to be installed.

Figure 14-27. DrakUPS Setup

Next let DrakUPS autodetect your UPS. If all goes well you should get a congratulation message. If not try to
do it manually.
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Select your UPS in the list of manufacturers and models.

Figure 14-28. Selecting the Manufacturer and Model

Then assign a Name, Driver, and Port4.

Figure 14-29. Name, Device and Port Names

If all went well your UPS should now be configured and ready to help avoid bad power outage surprises.

4. The Name and Driver fields should automatically be filled. Of course, you can change its name but we recommend you
keep the driver name.
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15.1. Network and Internet Connection Management

Before connecting to the Internet, you are encouraged to set up a
firewall on your machine so as to avoid bad surprises such as intru-
sions on your system. You can set up a very simple, yet effective,
firewall using DrakFirewall. Please refer to Securing your Internet
Access via DrakFirewall , page 168 for more information.

The drakconnect set of tools allows you to easily configure your network access, whether it be to the Internet
or to a local network. Open Mandriva Linux Control Center and select the Network & Internet section to access
drakconnect tools. A view of the main interface is shown in figure 15-1. The Internet connection sharing tool is
described in Internet Connection Sharing, page 134.

Figure 15-1. DrakConnect Tools

15.1.1. Set Up a New Network Interface

drakconnect supports different types of Internet and network connections. The first step consists
of choosing which type of connection you wish to configure. Always make sure you have all the
information provided by your ISP or network administrator at hand.

15.1.1.1. LAN Connection

Select the LAN connection type and continue to the next step. Your NICs are detected automatically; if you
have more than one, you have to select the one you wish to configure. You can also load a driver for your NIC
manually.

Then, you have to specify if the network parameters will be automatically set up (Automatic IP (BOOTP/DHCP))
or not (Manual configuration): fill the next steps with the parameters which your ISP or network administrator
gave you.
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Check the Network Hotplugging box to have your network brought
up and down automatically when you connect and disconnect the
network cable. This is specially handy for laptop users.

If you configure the network with DHCP you can optionally provide the machine’s hostname. Then you
can supply the Zeroconf hostname: this is the name which will be assigned to the machine when no network
configuration has been found.

After the configuration is done, you can bring the network connection up or down as described in Monitoring
Connections, page 133. Please bear in mind that LAN connection types are set up to always be started at boot
time.

An applet appears in the desktop’s panel indicating that the con-
nection is up

or down

. Right click on it to access a menu that will also let you
control the connection’s state as well as other parameters.

15.1.1.2. Wireless Connection

This entry allows to configure WiFi PCMCIA or PCI devices.

1. Choose the card you wish to configure. If your card is not listed, choose the Use a Windows driver entry.
The next step then asks you to select the driver from the manufacturer’s card drivers CD.

2. Network configuration is then similar to the LAN connection type (see LAN Connection, page 129).

3. Finally some wireless specific parameters are asked, make sure to set them correctly according to your
wireless access point configuration.

15.1.1.3. ISDN Connection

Simply make sure you select the right parameters in all steps, concerning your area and provider.

The last step gives you the option to handle the connection status through the net applet, this can prove useful
if you only need the Internet connection from time to time.

15.1.1.4. Modem Connection

A list of detected modems is shown. If no modem was detected then only the Manual choice option is shown,
click on Next and choose the communications port the modem is connected to. The required packages will be
installed.

You will then see a list of countries/ISPs. If yours is listed select it and continue to the next step: some para-
meters (connection name, phone number to dial, and authentication scheme) will be automatically set. Verify
them, add the missing ones and accept them. If yours is not listed, select the Unlisted - edit manually option,
click on Next and fill the parameters with the settings provided by your ISP (see figure 15-2).
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Figure 15-2. Entering Dial-up Connection Parameters

All parameters should be obvious, except for the authentication type. The value in the Authentication pull-
down depends on what your ISP supports: Script-based (an old type of authentication method based on “ex-
pect” and “send” types of chat between your system and your ISP); Terminal based (a terminal window will
pop up when the connection is made and you will have to login interactively); PAP, CHAP, or PAP/CHAP
(authentication information exchange protocols, CHAP is preferred because it is more secure, PAP/CHAP will
automatically choose the supported one).

Then come the IP, DNS and gateway settings. Nowadays, most ISPs provide them automatically when a
connection is made, so selecting the Automatic option on them is usually a safe bet. You will then be asked
whether you wish to allow users to start the connection. The safest choice is No. Otherwise any user will be
able to take the link down, therefore disconnecting every other user.

During the next step you will be asked whether to start the connection at boot time or not: it is probably safer
and cheaper to choose No. Finally you will be asked to test the connection: we recommend you to do so to
make sure all parameters are accurate. You can now control your Internet connection using the net applet. You
can also use the kppp remote access connection dialer (package kppp) through the main menu: Internet+Remote
Access→KPPP

15.1.1.5. DVB Connection

This connection type is used for satellite connections.

1. Choose the connection card you wish to configure, and then the adapter settings.

2. Network configuration is then similar to the LAN connection type (see LAN Connection, page 129).
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15.1.2. Internet Settings

Figure 15-3. Configuring the Internet Access

This tool allows you to specify Internet access parameters if they need to be modified after your
initial configuration. Please bear in mind that these parameters are system-wide and apply to all
interfaces.

15.1.3. Reconfigure Interfaces

Figure 15-4. Manage Network Connections

This tool permits you to modify network interface-specific parameters, after you have set them
up through the new interface wizard (see Set Up a New Network Interface, page 129). Use the drop-
down list at the top to select the interface you want to configure. The tabs allow you to change
parameters and options according to the network interface type selected.
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This interface can be brought up by users through the net applet
to monitor traffic.

15.1.4. Monitoring Connections

Figure 15-5. Real-Time Network Connection Monitoring

This tool shows the network interfaces activity. You can specify some options for the traffic graphic
and statistics: update interval, scale, etc (see figure 15-5). It can also be used to control the status
of the network connection, bringing it up or down using the button at the lower left.

15.1.5. Removing a Connection

This tool simply allows you to remove a network interface. Select the interface to be removed in
the Net Device pull-down list.

You will not be asked for confirmation. Once an interface is selected
for removal, pressing the Next button deletes it immediately.

15.1.6. Proxy Settings

This tool allows you to define the hostnames or IP addresses of proxies for the FTP and HTTP
protocols your computer will use. Fill the fields with the required values and click OK.

A proxy is a server which retrieves information from the Internet on your behalf, keeping a local copy of
the web pages which are most frequently requested. They are referred to as “caching proxies”, and optimize
bandwidth usage. In some organizations, you cannot access the Internet directly. You must pass through a
proxy which authenticates you before allowing you to connect to the Internet. This is usually combined with a
firewall which only guarantees the proxy direct access to the Internet. They are referred to as “authentication
proxies”. In corporate or business environments, proxies perform both caching and authentication functions
for performance and security reasons.
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15.1.7. Wireless Connection Management

This tool shows the wireless networks currently available allowing you to switch between them.

15.2. Internet Connection Sharing

This tool configures your system so that it acts as a gateway to the Internet for other machines
connected to it via a LAN. This is very useful at home for example, if you wish all computers
to access the Internet through the same Internet link.

Figure 15-6. A Simple Gateway Configuration

The overall procedure is the following:

1. Configure your Internet access (Network and Internet Connection Management, page 129). In order for your
machine to act as a gateway, you will need an already configured and working connection to the Internet,
plus a network connection to your LAN. This implies at least two interfaces, for example, a modem and
an Ethernet card.

2. Setup the gateway (The Gateway Connection Wizard, page 134).

3. Configure the other local machines as clients (Configuring the Clients, page 135).

This wizard will also configure a firewall to block most connections
from the Internet. You are encouraged to check that the firewall
configuration (Securing your Internet Access via DrakFirewall , page
168) suits you after completing the wizard.

After you complete this wizard, all computers on the LAN will be able to access the Internet. Their configura-
tion will be automated due to the DHCP server which will be installed on your gateway, and the web access
will be optimized due to the use of the Squid transparent proxy cache.

15.2.1. The Gateway Connection Wizard

These are the steps that the wizard takes:

1. Choosing the Internet Interface

You first need to specify the name of the interface connected to the Internet. Make sure you select the
correct one: use the examples in the on-line help as a guide.

2. Choosing The LAN Network Adapter

If you have more than one Ethernet interface, and depending on what you chose as your Internet interface,
the wizard might ask you to select the one connected to your LAN. Make sure you select the correct one.
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Note that all traffic to and from this network passing through the gateway will be masqueraded, that is: it
will appear to come from the gateway instead of from the LAN.

3. Local Area Network Settings

Figure 15-7. Configuring The LAN

At this point, if it is the 1st time the system has been configured as a gateway, the wizard proposes default
parameters for the new local network to be managed. Check that these values are not already in use in
your network, and go on to next step.

Otherwise, the wizard will first offer to reconfigure the LAN interface so that it will be compatible with
the gateway services. It is recommended that you leave the default options and click on Next. Then, all the
software needed will be installed.

4. DNS Configuration

If you plan on having a local name server on your machine, you can check the box. Otherwise you can
choose to use the name server of your provider. If you don’t know what a name server is, leaving the box
checked is safe.

5. DHCP Server Configuration

Installing a DHCP server on your machine will allow all client machines to have their network configu-
ration automatically done. Otherwise you will have to configure each of the clients by hand: IP address,
network, gateway, DNS.

6. Proxy Caching Server (SQUID)

A caching server records the Internet pages requested by local browsers. Then if the same page is asked
for again by someone else, it’ll be able to serve it without needing to retrieve it again from the Internet,
thus saving bandwidth, and improving response time. This is very useful for many clients.

The application used to perform this task is Squid (http://www.squid-cache.org/).

When the wizard is completed, any required packages are installed and configured.

15.2.2. Configuring the Clients

Configuration of the clients mainly depends on whether you chose to install a DHCP server on your gateway
or not. By configuring the clients on the local network to use DHCP, they will automatically use the Mandriva
Linux machine as a gateway to the Internet. This works for Windows®, GNU/Linux and any other OS which
supports DHCP.

If you have no DHCP server, you will have to configure each of your machines manually, according to the
network settings configured during the connection sharing wizard.
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For DHCP, on a Mandriva Linux client system, make sure you selected DHCP in the Protocol pull-down list
when configuring the network as shown in figure 15-8.

Figure 15-8. Configuring a Client to Use DHCP
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16.1. Customizing your Menus with MenuDrake

In order to help you manage the main menu of your preferred graphical interface, Mandriva
Linux provides you with a menu editor which ensures menus from all desktop environments
(such as KDE or GNOME) are coherent.

This tool allows system administrators to control the menus for all users (the system menu) but can also be
utilized by users to personalize their own menus. You can launch MenuDrake from the Mandriva Linux Control
Center or from the System+Configuration+Other→Menudrake menu entry.

Figure 16-1. Launching MenuDrake in System or User Mode

If started by root, MenuDrake can be used in two different modes: either changing menus for all users, or
customizing the menus for user root. You will be able to switch from within the application thereafter, but
for now, click on:

• System menu to make changes to menus available for all system users;

• Root menu to customize the menus for the root user only.

When you launch MenuDrake, it first scans your current menu structure and displays it. The main window (see
figure 16-2) is divided in two parts: the menu itself on the left, and a form relative to the highlighted menu
item on the right.
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Figure 16-2. MenuDrake’s Main Window

You can click on the tree’s [+] signs to view the content of the related sub-menus, and on [-] to hide them.

In your tree you may see entries which do not appear in your actual
menu. These are empty directories which are not displayed but can
be used for future applications which you may wish to install.

16.1.1. Adding a New Menu Entry

This should seldom happen as all Mandriva Linux graphical applications should provide a menu entry. Howe-
ver if you want to add a menu entry for a package you compiled yourself, or for a console mode program,
use this function. Let’s suppose you want to run the top command in a terminal window to view running
processes and the utilization of system resources through a menu entry in the System→Monitoring menu.

Select the System→Monitoring entry, and click on the tool bar’s Add application button. A dialog will appear
asking you for the title of the menu entry and the command associated with it.

Figure 16-3. Adding a New Menu Entry

Edit the title (you could insert “Table Of Processes”) to be shown in the menu. Then you need to provide the
action the system should execute in the Command field: top. Click on OK and the entry will be added to the
menu tree.

You can also choose an icon for your entry from the list which appears once you click the icon button itself.
The new entry is shown in figure 16-4. Do not forget to check the Open in a terminal box to have the program
run in a terminal window.
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Figure 16-4. A New Menu Entry with MenuDrake

While modifying your menus, you might make a big mess out of
them... Remember that you can reload the menus as you last saved
them by pressing the Ctrl-R keys (or accessing the File→Reload
user config sub-menu). You can also revert to the default menus by
accessing the File→Reload system menu sub-menu.

Finally to activate your modifications, click on the Save button and that’s it. Congratulations! You can now test
your new settings by accessing the main menu.

Depending on the graphical interface you are using, the changes to
your menu may not be shown immediately. In some cases, you may
need to log out and back in again for the changes to take effect.

16.1.2. Advanced Features

16.1.2.1. Different Menu Styles

Depending on the experience the users working with your machine have, you may want to provide them with
different menu styles. Mandriva Linux provides a few template menus which you can eventually customize.
They are available through the main window’s Menu Style button.

Figure 16-5. Choosing a Menu Style
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Choose one of the available options:

• Use system administrator settings. If you started MenuDrake as a simple user, you can choose to set your
personal menu style to use the menus prepared by the system’s administrator.

• All applications. This is the traditional menu shipped with Mandriva Linux and it contains nearly all the
available applications, sorted into functional categories.

• What to do? Specifically designed by our ergonomics team, this menu provides a fast access to most com-
mon applications sorted by usage, such as Play a game, Use the Internet, etc.

• Original menu. These are the plain menus as provided by the KDE or GNOME desktops. This menu probably
lacks some applications.

When you have chosen a menu style, click on OK. You will then be able to see the corresponding menu
structure in the main window, and you can then customize it.

16.1.2.2. About the Environment Menu

The entry we have just added to the menu is now available in the active graphical manager menu. It is also
possible to make modifications to all graphical manager menus by choosing Environment→All environments.

All entries which only apply to the active graphical environment appear in blue in the tree structure on the
left.

16.1.2.3. Moving and Removing Entries

MenuDrake entries support the drag-and-drop feature. Similarly, you may have noticed that whenever you
remove an application from the menu, it appears in the “attic”, that is the Available applications list on the
bottom right corner. If you ever wish to add them again, you simply have to drag them to the desired place in
the menu tree.

16.2. Configuring Start-Up Services

At boot time, the system starts a number of services (programs running in the background to
perform a variety of tasks). This tool gives the administrator control over those services. See
the The Start-Up Files: init sysv chapter of the Reference Manual for more information.
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Figure 16-6. Choosing the Services Available at Boot Time

For each service, this is the list of items found in each column:

• Service name;

• Current Status: either running or stopped;

• Info: click on this button to get a little explanation about that service;

• On Boot: check this box if you wish this service to be automatically brought up at boot time1. Alternatively,
if xinetd is installed and the service is a xinetd service, the label Start when requested will be displayed.
Checking the box will then mean to activate that service in xinetd. You will also have to make sure that the
xinetd service itself is activated.

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

For both the Start and Stop buttons, a tool tip will show you the status of the operation.

16.3. Managing Available Fonts on your System with DrakFont

This tool enables you to review the different font families, styles, and sizes available on your
system. It also allows the system administrator to install new fonts.

The main window (see figure 16-7) shows a visual appearance of the currently selected font combination.

1. Generally in runlevels 3 and 5.
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Figure 16-7. DrakFont’s Main Window

drakfont is made up of a number of windows which are accessible through the buttons located at the bottom-
left corner.

Options

Allows you to specify which applications and devices (such as printers) will support the fonts. Select the
ones you want support for and click on the OK button.

Uninstall

Allows you to remove installed fonts, in order to save space for example. Use this with great care, it could
have side effects on your applications. You should notably not remove fonts you did not install yourself.

Import

Allows you to manually add fonts found outside the Mandriva Linux distribution, on a local Windows®

installation or from the Internet, for example. Supported font types are ttf, pfa, pfb, pcf, pfm, gsf.
Clicking on the Add button will open a standard dialog allowing you to specify the font file to import.
Once you’ve specified all the fonts you want to import, click on the Install fonts button.

To select more than one font, double-click on the first font you wish
to select and it will be added to the Import Fonts window. Then
double-click the other fonts you wish to install and the same action
will occur. When you are done click on the Close button and then
on the Install fonts button. Once the installation operation is done,
make sure the new fonts appear in the Family list.

16.4. Setting your Machine’s Date and Time

This little tool enables you to set your system’s correct internal date and time.
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Figure 16-8. Changing Date and Time

You can set the date on the left and the time on the right:

• To change the year, click on the little arrows on each side of the year; same procedure to change the month.
This updates the month view where you can click on the current day in order to highlight it.

• We recommended that you check the time-zone settings for your geographical location. Click on the Change
Time Zone button and select the correct place in the tree view.

Once you’ve chosen the time zone, a dialog will appear asking you whether your hardware clock is set to
GMT. Answer Yes if only GNU/Linux is installed on your machine, No otherwise.

• To change the time, you can either move the hour, minute and second hands of the analog clock, or change
the numbers below it.

• If you have a permanent Internet connection and want your system to synchronize its internal clock with
time servers on the Internet, put a check mark in the Enable Network Time Protocol option and select a server
in the Server pull-down list, preferably one near you. If you know the name or the IP address of a local server
you can also enter it manually in that field.

The NTP (Network Time Protocol) package needs to be installed.
If it isn’t, a dialog will pop up and ask you whether you wish to
install it.

If you select the pool.ntp.org server, NTP will automatically
choose a server near to the time zone you selected.

When you’re finished, click on OK to apply your settings or Cancel to close the tool, which will discard your
changes. If you want to return to your previous settings, click on Reset.

16.5. Monitoring System Activity and Status

This tool allows you to look for specific entries in various log files, therefore making it easier to
search for particular incidents or security threats.
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16.5.1. Browsing System Logs

Figure 16-9. Browsing and Searching through System Logs

These are the steps to follow in order to browse or look for a specific event into the system logs:

1. You must choose which specific words to match by filling the Matching (log files contain the words) field
and/or the but not matching (log files which don’t contain the words) field. At least one of the two fields
must be filled.

2. Then in the Choose file area select the file you want to perform the search on. Simply check the correspon-
ding box.

The Mandriva Linux Tools Log is filled by Mandriva Linux-specific
configuration tools, like those you find in the Mandriva Linux Con-
trol Center. Each time these tools modify the system configuration
they write a line in this log file.

3. Optionally, you can restrict the search to a specific day. In that case, check the Show only for the selected
day box and choose the desired day from the calendar.

4. When all is set up, click on the Search button. The results will appear in the Content of the file area at the
bottom.

Clicking on the Save button will open a standard dialog letting you save the search results into a plain text
(*.txt) file.
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16.6. Managing Users and Groups

UserDrake allows system administrators to easily add and remove users from the system, to assign users to a
group, and to manage user groups in the same manner.

In this section we will only focus on user management. Group ma-
nagement being similar.

16.6.1. The Interface

Launching UserDrake will display the main window (figure 16-10) which lists the users currently defined on
the system. You can switch from users to groups by clicking on the Groups tab next to the Users tab.

Figure 16-10. The User List in UserDrake

All changes have immediate effect on your local user database. If the user list is modified outside of UserDrake,
you can refresh UserDrake’s window by clicking on the Refresh button.

If you make changes to an already logged in user, those changes
won’t take effect until he or she logs out, and logs in again.

Available actions are:

Add User

Adds a new user to the system. We will detail this procedure in Adding a New User, page 145.

Add Group

Adds a new user group to the system.

Edit

Allows you to change the parameters of the selected user or group. We will detail editing user parameters
in Adding a New User, page 145. In the case of a group you will be able to assign or remove users from that
group.

Delete

Removes the selected user or group from the system. A confirmation dialog will be shown, and in the
case of a user you will also be able to remove the user’s /home directory and mailbox.
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16.6.2. Adding a New User

We created the non-privileged user Queen Pingusa at installation time, and now we want to create a new user
called Peter Pingus. Then we want to make them both members of the fileshare group, so that they can
share folders with other users on the network (see Allowing Users to Share Folders, page 161, custom option).

Click on the Add User button, the dialog box to add a new user will pop up (see figure 16-11). The only required
field is Login although we strongly recommend that you set up a password for this new user: enter it in both
the Password and Confirm Password fields. You can also choose to add a comment in Full Name. Generally, this
is the full name of the user, but you can put whatever you want.

Figure 16-11. Adding a New User in the System

We now have two users in our list. Select one of them with your mouse, and click on the Edit button. The
dialog box shown in figure 16-12 will pop up. It allows you to modify most available user parameters.

Figure 16-12. Adding Users to a Group

The dialog is made of the following tabs:

User Data

Allows you to modify information provided when the user was created.
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Account Info

Enables you to provide an expiration date for that account, after which the user won’t be able to connect
to the system. This is useful for temporary accounts. It’s also possible to temporary lock an account to
prevent a user from logging in. Finally, this tab allows you to change the icon associated with the user.

Password Info

Allows you to provide a password expiration date, after which the user will have to change his password.

Groups

Shows the list of available groups where you can select the groups to which any user should belong.

For our users we just need to look for the fileshare entry and check the box associated to it. Then click on
the OK button to make the changes effective.

16.7. Backing Up and Restoring your Files

This tool allows you to back up data present on your computer onto different media and also
to a remote machine over a network. Once the parameters are set, you can run the backup
periodically. Then, you can forget about it until you wish to restore some files.

16.7.1. A Practical Example Using the Wizard

You can access this tool by clicking on the Backups icon in Mandriva Linux Control Center’s System section. Click
on the Wizard Configuration button to start the wizard. After making your choices in each step click on Next.

16.7.1.1. First Step: What to Backup

Figure 16-13. Selecting What to Backup

Select Backup System to include the /etc directory where all your current system configuration files lie. This
allows you to “transport” your system to a different computer with little effort: only hardware-dependent
configuration will have to be revised.
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The“system”backup does not include applications themselves (i.e.
executable files, libraries). A priori this makes sense because it is
likely that you will have access to the system’s installation media
from which applications can be easily installed again on the target
computer.

Select Backup Users to include all the files included in all of your users’ /home directories. Clicking on the Select
user manually button lets you select individual users and give you the following options:

• Do not include the browser cache. Selecting this option is recommended due to the very nature of the ever-
changing browser’s cache.

• Use Incremental/Differential Backups. Selecting this will preserve old backups. Choosing Use Incremental Bac-
kups will only save files which have been changed or added since the last backup operation. Choosing Use
Differential Backups will only save files which have been changed or added since the first backup operation
(also known as the “base” backup). This last option takes more space than the first one, but allows you to
restore the system “as it was” at any given point in time for which a differential backup was made.

16.7.1.2. Second Step: Where to Store the Backup

Figure 16-14. Selecting Where to Store the Backup

All possible backup media are listed, along with a Configure button to change media-dependent options:

Hard Disk Drive

The local hard disk drive is used to prepare backups for all media except NFS and direct to tape. You
should not perform backups on your local hard disk anyway, you should always backup on remote or
removable media. You can set the directory for storage and the limit of storage space. You can also set
how many days to keep incremental or differential backups in order to save disk space.

Across the Network

To store the backup on a remote computer accessible using different methods. You can set the connection
parameters as well as the access method and its options (if applicable). Please note that NFS backups are
considered to be local disk backups, even if they are effectively stored on a remote system.
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On Tape

You can set the tape device if it’s not detected automatically, and tape parameters such as writing directly
on tape, whether or not to rewind, erase and eject the tape.

Optical Media (CD-R)

This is our preferred media for the example, so click on its Configure button to set the required parameters
(see figure 16-15).

Figure 16-15. Setting Optical Media Parameters

If it isn’t done automatically, use the Choose your CD/DVD device combo box to set the CD/DVD device. Set
the medium’s type and size, multisession and erasing options.

For multisession recordings, please bear in mind that the option to erase the medium is only effective for the
1st session and also that session-related information recording takes some space out (20 to 30 MB) for each
session, so the “real data” storage space will actually be less than the medium’s size.
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16.7.1.3. Third Step: Review and Store the Configuration

Figure 16-16. Review Configuration Parameters

The last wizard step shows a summary of the configuration parameters. Use the Previous button to change any
parameter you are not satisfied with. Click on Save to store them. The backup set is now ready to be performed.

16.7.1.4. Performing the Backup

Click on Backup Now, make sure the corresponding media is ready (the recordable CDs in our example), and
then on Backup Now from configuration file to perform the backup.

If the backup set size exceeds the medium’s available capacity, the
backup operation might just fail. This is a known issue and it’s
being worked on. As a work-around, please try to remove files from
the backup set so its size never exceeds the medium’s available
capacity.

A dialog will display the current progress of the operation. Please be patient: the time it takes to back up
depends on many factors such as the size of the backup file set, the speed of the storage option selected,
and so on. Once the operation is finished a report is shown: look for possible errors on it and take corrective
measures if needed.
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16.7.2. Restoring Backups

Figure 16-17. Choosing the Restore Type to Perform

Make sure the media you want to restore the backup from is accessible and ready and click on the Restore
button. In our example we restore the whole backup so on the restore dialog (figure 16-17) click on Restore all
backups and then on the Restore button to start the restoration process.

Existing files in the target restoration directory (same location whe-
re the backup was made from, by default) will be overwritten.

Feel free to investigate the other restore options if you want to restore part of a backup instead of the full file
set.

16.7.3. Automating Periodic Backups

In the tool’s main window, click on Advanced Configuration and then on the When button. In the backup sche-
duling window (see figure 16-18) select Use daemon to define the schedule.
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Figure 16-18. Daemon Options Window

You are then asked to specify the interval (or period) between each backup operation and the storage media.
In our example we set up a customized calendar (custom period selected) to perform a backup every Friday at
a quarter to midnight and store it on CD.

16.7.4. Advanced Backup Wizard Configuration

Click on Advanced Configuration and then on the More Options button to set more backup options (see figure
16-19).

Figure 16-19. Miscellaneous Options Window
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Use the Please choose the compression type pull down list to select the compression used for your backups
among tar (no compression), tar.gz (gzip compression) and tar.bz2 (bzip2 compression: better but
slower).

Select the Use .backupignore files option to have certain files excluded from the backup. The .backupignore file
should be present in every directory of the backup file set where files are to be excluded. Its syntax is very
easy: a one-file-per-line list of the names of the files to exclude.

You can use the star (* =“matches any string”) and the question
mark (? =“matches one and only one character, regardless of what
that character is”) in the .backupignore file to exclude sets of files.
For example, somename* matches all files whose names start with
somename, and image00?.jpg matches files named image001.

jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.

Select the Send mail report after each backup to option and fill the e-mail address so the tool knows to whom
to mail the backup operation report. Please bear in mind that the system needs to have a working MTA (Mail
Transport Agent) for this option to be effective.

Select the Delete Hard Drive tar files after backup to other media option to free that space after performing the
backup.
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17.1. Managing your Hard Drive Partitions with DiskDrake

Partitions are initially set up during the installation process. DiskDrake allows you, to some
extent, to resize your partitions, move them, etc. DiskDrake can also deal with RAID devices and
supports LVM but we will not discuss these advanced uses here. Please refer to the Reference
Manual to learn more about what partitions are used for.

DiskDrake is very powerful and can therefore be a dangerous tool.
Misuse of it can very easily lead to data loss on your hard drive.
Because of this potential loss of data, you are strongly advised to
take some protective measures before using DiskDrake:

1. Back up your data. Transfer it to another computer, ZIP
disks, etc.

2. Save your current partition table (the table describing
the partitions held on your hard drive(s)) to a floppy disk
(see DiskDrake’s action buttons, page 156).

17.1.1. The Interface

Figure 17-1. DiskDrake’s Main Window

DiskDrake enables you to configure each physical hard drive on your machine. If you only have one IDE disk,
you will see a single tab called hda below the file-system types. If there is more than one drive, then each drive
will have its own tab and will be named according to the Linux name for that drive. DiskDrake will allow you
to manage the partitioning of each drive.

The window (see figure 17-1) is divided into four zones:

• Top. The structure of your hard drive. When you launch DiskDrake it will display the current structure of
the drive. DiskDrake will update the display as you make changes.
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• Left. A menu relevant to the partition currently selected in the above diagram.

• Right. A description of the selected partition.

• Bottom. Buttons for making general actions. See next section.

We will now review the actions available through the buttons at the bottom of the window, and then describe
a practical use case.

17.1.2. DiskDrake’s action buttons

Clear all

Clicking on this button will clear all partitions on the current hard drive.

More

Displays a three button dialog allowing you to:

Save partition table. Allows you to save the current partition table to a file on a disk (a floppy, for exam-
ple). This may prove useful if a problem arises (such as an error made during drive repartitioning).

Restore partition table. Allows you to restore the partition table as previously saved with Save partition
table. Restoring a partition table may recover your data as long as you do not reformat partitions, because
the formatting process will overwrite all your data.

Rescue partition table. If you lose your partition table and have no backup, this function scans your hard
drive to try and reconstruct the partition table.

Help

Display this documentation in a browser window.

Undo

Cancels last action. Most modifications done on your partitions are not made permanent until DiskDrake
warns you it will write the partition table. This button therefore allows you to undo all of your modifica-
tions on partitions up to last write.

Toggle to expert mode

This button allows you to access the expert mode functions (which are even more dangerous if you are
not sure what you are doing). Reserved for experts.

Done

Saves your changes and exits DiskDrake.

17.1.3. Resizing an Old Partition and Creating a New One

In this section, we are going to do a little exercise to demonstrate one of the more useful features of DiskDrake.
Let us imagine that you decide to use your machine as an FTP server and you want to create a separate
/var/ftp partition in order to host the FTP files. Note that doing this step-by-step tutorial will actually
modify the structure of your hard drive.

This is what the current /home partition looks like (see figure 17-2), before any modification. We are going to
shrink this partition in order to create free space for the new file system.

In order to perform the steps in this example, all users of your
system must be logged out, except root.
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First of all, you need to unmount the /home partition by clicking on it and then pressing the Unmount button.

Figure 17-2. The /home Partition Before Resizing

The next step, as you may have guessed, is to click on the Resize button. A dialog will appear (see figure 17-3)
which will allow you to choose the new size for the /home partition. Move the slider to reflect the new size,
then click on OK.

Figure 17-3. Choosing a New Size

When this is done, you will notice that the graphic representation of your hard drive has changed. The
/home partition is smaller, and an empty space appears on the right. Click on the empty space and then on
the Create button which appears. A dialog (see figure 17-4) will let you choose the parameters for the new
partition. Set the size, choose the file system you want to use (usually Journalized FS: ext3) and then
enter the mount point for the partition, which in our example will be /var/ftp.

Figure 17-4. Defining the New Partition

figure 17-5 shows what our projected partition table now looks like.
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Figure 17-5. The New Partition Table

The last step is to format (prepare to host files) the newly created partition. To format the partition, click on its
representation in the partitions picture, then on the Format button. Confirm the writing of the partition table
to disk, the formatting of the partition and the update to the /etc/fstab file. You may be asked to reboot the
computer to make changes effective.

Figure 17-6. Confirming the Writing of the Partition Table

17.2. Managing Removable Devices

These tools enables system administrators to easily control most options which affect the beha-
vior of removable devices such as floppy, CD and DVD disks. Note that, by default, all remo-
vable devices are automatically made available so users shouldn’t have to manually mount
media.
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Figure 17-7. Changing a Parameter

For each device the following properties may be changed:

• Mount point. The directory where the device’s files will be accessible from. You can either choose an entry
in the list or type in your own path. If the directory does not exist, it will be automatically created.

• Options. Controls various device options, notably whether it is mounted automatically (supermount) or not.
Note that if the supermount option is selected, the two others (user and noauto) must not be selected.

• Type. Displays a list of file-system types. If you have a specific medium with an uncommon file system on
it, this is where you can tell Linux how to access it.

Select the property you wish to change and click on OK. The corresponding dialog will pop up in which
you can change your settings. Then click on OK again. The system will then ask you if you want to save the
modifications in the /etc/fstab file. By saying yes, you will not have to unmount and re-mount that device:
it will be done automatically

17.3. Importing Remote SMB Directories

This tool allows the system administrator to import remote shared directories based on the
SMB protocol (used mainly by Windows®) on the local machine.

While users can individually access remote shares through their file managers, it may be required in some ca-
ses to import a specific share for it to become immediately available for all users. We’ll go through an example
showing you how to import a template directory from a Windows® machine.
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Figure 17-8. Scanning the Whole Network

Clicking on the Search servers button scans the local network for machines which currently share directories
(including the local one). In our example, many servers are available. We’ll choose skywalker and we’ll make
it available locally for all users.

Clicking on a machine’s name will try to connect to it and browse for available shares. If that machine has
password-protected shares, a dialog will pop up asking you to identify yourself.

Figure 17-9. Authenticating on a Remote Samba Server

Enter the correct Username, Password and Domain. The available shares on that machine will then appear. Click
on the little arrow on the left of the server icon to show available shares.

If the machine you’re connecting to has both public and password-
protected shares, then canceling the password entry dialog will con-
nect you to that machine, but only to its public shares.

Figure 17-10. Choosing the Remote Directory to Import

Once a share is selected, a Mount point button appears. Clicking on it displays a dialog where you can type the
local directory name where remote files will be accessible.

Once this is done, two more buttons appear:

• Mount. Makes the resource available locally. When this is done, users simply have to point their file manager
to the directory selected as the mount point to get the files hosted by the server.

160



Chapter 17. Mount Points and Remote Directories

• Options. Allows you to set a user name and password to access that SMB mount point. Other permissions
and advanced settings can also be set through this button.

Also, the little icon in front of the shared directory becomes

When you’re finished configuring the access points for remote directories, click on Done. A dialog box will
appear asking you whether you wish to save your modifications to the /etc/fstab file (where mount point
information is usually stored), or not. Click on Yes to make the shares configuration persistent between ses-
sions. Click on No to exit without saving your changes.

17.4. Importing Remote NFS Directories

This tool is exactly the same as the one mentioned in Importing Remote SMB Directories, page
159, except that it controls file sharing through the NFS protocol rather than SMB. Therefore it
allows you to locally import shared files from NFS-friendly machines. The interface is the same
as the one described in Importing Remote SMB Directories, and the effects are similar. Only the
corresponding machines are different: UNIX® for NFS and Windows® for SMB.

Another difference is that there is no need to provide a password to access NFS shares. The authentication
mechanism is host-based.

17.5. Allowing Users to Share Folders

This tool enables you to share files with other users of your computer network. File sharing
can be done on heterogeneous systems such as GNU/Linux and Windows®.

The file-sharing configuration is done in two simple steps: determining who can export folders, and then
which protocol to use. A 3rd step is necessary if you select the Custom export option.

Figure 17-11. Controlling Exports

First of all, you must determine who will be able to share folders. Here are the different available options:

• No sharing. Prevents users from sharing data with others.

• Allow all users. All users are allowed to share data with others.
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• Custom. By choosing this option, only users within the same fileshare group will be allowed to share
data. If you choose this option, the fileshare group will be created and, as a 3rd step, you will be prompted
to run UserDrake in order to add the allowed users to this group (see Managing Users and Groups, page 144).

Figure 17-12. Choosing the Export Protocol

Then you must choose which protocol to use for file sharing. Check one or both of the following:

• SMB. If you want your users to share files using Windows® systems.

• NFS. If you want your users to share files using UNIX® systems (such as GNU/Linux).

Once you have checked the appropriate boxes, click on OK. The required packages will be installed, if needed.
If you uncheck a previously checked box, the corresponding service will be stopped.

Once users are allowed to share data, they can select the folders to be shared through their preferred file
manager (see File Sharing, page 73).

17.6. Setting up WebDAV Mount Points

WebDAV (Web-based Distributed Authoring and Versioning) is an extension to the HTTP protocol
which allows you to create, move, copy, and delete resources on a remote web server. In prac-
tice, mounting a remote WebDAV repository on your local machine will allow users to modify
a remote web server’s files as if those files were local to the system.

Browse the WebDAV Resources (http://www.webdav.org/) pages
to learn more about this protocol.
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Figure 17-13. Managing WebDAV Mounts Points

The first time you launch this tool the required packages will be installed if needed, and only two buttons
will be available. New, which allows you to define a new mount point, the other one just Quits the application.
After you have defined mount points, they will appear as new buttons at the top of the buttons list. Clicking
on a mount point button will take you to the mount point menu (see figure 17-14).

When you click on the New button you are asked for the URL of the web server. Enter the complete URL of
the web server, beginning with http:// or https://, then click OK.

Figure 17-14. WebDAV Menu

You must now decide where the web server files will be accessible from. Select the Mount point option and
click OK. There you will be able to choose a local directory or type in your own. If the selected mount point
does not exist, it will be created.

If the server requires authentication, do not forget to fill the username and password fields in the Options dialog.
Then all you need to do is to actually mount the remote repository by selecting Mount and clicking OK.

You will now be able to browse and modify files on the local mount point you have defined and the changes
will be immediately available on the web server.

To make your settings are persistent between sessions, remember to save modifications to the /etc/fstab file,
as suggested when you quit the wizard.
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Chapter 18. Securing your Linux Box

18.1. Securing your Machine through DrakSec

draksec is a graphical interface to msec (which stands for Mandriva Linux Security Tool). It
allows you to change your system’s security level and to configure every option of msec’s
security features.

msec has two aspects: system behavior configuration and periodic checks of system state. Each security level
modifies the system configuration, making it more and more secure, and verifying more and more security
related aspects.

18.1.1. Setting your Security Level

This tool is only displayed in expert mode. Choose Options→Expert
mode from the menu and then access the Security section of Man-
driva Linux Control Center.

Figure 18-1. Choosing the Security Level of your System

Simply choose the security level you want from the Security Level pull-down list: it will be effective as soon
as you click on OK. Please read the help text regarding security levels very carefully so that you know what
setting a specific security level implies.

If you wish to check which options are activated for each security
level, review the other tabs: Network Options, System Options and
Periodic Checks. Click on the Help button to display information
about the options and their default values. If some of the default
options don’t suit your needs, simply redefine them. See Customi-
zing a Security Level , page 166, for details.
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Put a check mark on the Security Alerts box to send by mail possible security issues found by msec to the local
user name or to the e-mail address defined in the Security Administrator field.

We highly recommend you activate the security alerts option so
that the administrator is immediately informed of possible security
issues. Otherwise the administrator will have to regularly check the
relevant system log files.

18.1.2. Customizing a Security Level

Clicking on each of the Options tabs (and the Periodic Checks one) lead you to msec’s list of security options.
This allows you to define your own security level based on the security level previously chosen.

Figure 18-2. Modifying Standard Options

For each tab, there are two columns:

1. Options List. All available options are listed.

2. Value. For each option1 you can choose from the corresponding pull-down menu:

• Yes. Activate this option no matter what the default value is.

• No. Deactivate this option no matter what the default value is.

• Default. Keep the default security level behavior.

• Ignore. Use this option if you don’t wish this test to be performed.

• ALL, LOCAL, NONE. The meaning of these are option-dependent. Please see the Help text available
through the Help button for more information.

Clicking on OK accepts the current security level with custom options, applies it to the system and exits the
application.

1. The default security level setting is shown in the Help window.
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18.2. Controlling File Permissions with DrakPerm

In Securing your Machine through DrakSec, page 165, you saw how to change your system’s security level and
customize the security checks associated to those levels.

drakperm allows you to customize the permissions which should be associated with each file
and directory in your system: configuration files, personal files, applications, etc. If the owners
and permissions listed here don’t match the actual permissions of the system’s files, then msec
(which stands for Mandriva Linux Security Tool) will change them during its hourly checks.
These modifications can help prevent possible security holes or intrusions.

This tool is accessible only in expert mode. Choose Options→
Expert mode from the menu and then access the Security section
of Mandriva Linux Control Center.

Figure 18-3. Configuring File-Permission Checks

The list of files and directories which appears depends on the current system’s security level as set by msec,
along with their expected permissions for that security level. For each entry (Path) exists a corresponding
owner (User), owner group (Group) and Permissions. In the drop-down menu, you can choose to display only
msec rules (System settings), your own user-defined rules (Custom settings) or both as in the example shown in
figure 18-3.

You cannot edit system rules, as stated by the“Do not enter” sign
on the left. However you can override them by adding custom rules.

If you wish to add your own rules for specific files or modify the default behavior, display the Custom settings
list and click on the Add a rule button.
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Figure 18-4. Adding a File-Permissions Rule

Let’s imagine your current security level is set to 3 (high). This means that only the owners of the home
directories can browse them. If you wish to share the content of Queen’s home directory with other users, you
need to modify the permissions of the /home/queen/ directory.

msec only changes file permissions that are more permissive than
the one required by a certain security level. That means that for
the change above, the permissions must be changed by hand.

You can do this in Konqueror by modifying the permission
properties of your home directory, and checking the Apply changes
to all sub-folders and their contents option.

If you create more rules, you can change their priorities by moving them up and down the rules list: use the
Up and Down buttons on your custom rules to have more control over your system’s permissions.

18.3. Securing your Internet Access via DrakFirewall

This little tool allows you to set up a basic firewall on your machine. It filters connection at-
tempts made from the outside, and blocks unauthorized ones. It’s a good idea to run it just
after installing your machine and before connecting to the Internet, therefore minimizing the
risks of your machine being cracked.
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Figure 18-5. The DrakFirewall Window

If checked, uncheck the Everything (no firewall) box, and then check the boxes corresponding to the services
you wish to make available to the outside world. If you wish to authorize a service which isn’t listed here,
click on Advanced to manually enter the port numbers to open.

The Advanced button opens an Other ports field where you can
enter any port to be opened to the outside world. Examples of port
specifications are presented just above the input field: use them as
a guide. It’s possible to specify port ranges by using the : syntax
such as 24300:24350/udp.

Not checking a service in this list won’t disallow you from connecting to it. It will only prevent people from
the Internet to connect to that service on your machine. If you don’t plan on hosting any service on your
machine (common case for a desktop machine) just leave all boxes unchecked.

On the other hand if you wish to disable the firewall and leave all services accessible from the outside, check
Everything (no firewall), but please bear in mind that this is very insecure, and therefore not recommended.

Then clicking on OK will bring you to the next step, which consists of selecting the network interface connected
to the Internet.

Figure 18-6. The Internet Interface
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Refer to the examples to determine the name of your interface to the Internet. If you’re unsure, you can check
the system network configuration (see Reconfigure Interfaces, page 132). You can finally click OK to install the
required packages, activate the firewall and enjoy your secure Internet connection.
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19.1. Configuring the Login Mode

This tool allows a user to be automatically logged into the system at boot time, without a
password being required.

Figure 19-1. Choosing the Login Mode

There are a few parameters:

1. Graphical interface: if you wish to have the X Window System (graphical display) started at boot time,
check the Launch the graphical environment when your system starts box. If you leave it unchecked, the text
login will be displayed and you will need to start the graphical environment manually.

2. Autologin: if you’re the only person using your machine and nobody else has access to it, you may choose
to be automatically logged in at boot time. To do so, select the Yes, I want to autologin with this (user,
desktop) option. Then choose the user you want to be logged on automatically in the Default user, as well
as the preferred Default desktop in the pull-down menus.

19.2. Changing your Boot-up Configuration

This tool allows you to configure the bootloader and the boot menu entries.

Unless you’re an expert, it’s not recommended that you change
these settings as this may prevent you from booting your machine
the next time you try to power it on.
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Figure 19-2. Choosing the Boot Mode

19.2.1. Configuring the Bootloader

You can choose between the GRUB and the LILO bootloader. Either one will allow you to boot Mandriva Linux,
it’s just a question of taste.

Unless you know what you’re doing, you shouldn’t change the default Boot device shown, since that’s where
the bootloader installs itself. If more than one OS is installed on your machine, it’s a good idea to leave at least
5 seconds so that you can easily select a different menu item than the default image.

The dialog finally shows a few options which can be useful depending on your specific hardware.

Enable ACPI

Enable this option to allow better power management support if your hardware is ACPI compatible.
ACPI is often needed for new laptops which no longer support APM.

Force No APIC

The IO-APIC (http://www.wlug.org.nz/APIC) is only really useful for multi-processor systems. It may
cause problems on single processor systems and should be deactivated in that case by checking this box.

Force No Local APIC

The Local APIC can be used by Linux to program interruptions to wake up threads. On multi-processor
machines it can be used to send interrupts to another processor.

These relatively new APIC features are known to cause problems on some computers because of badly desig-
ned chip sets or poor support in Linux kernel drivers. These problems can cause system freezes or incorrect
device detection. So you may need to deactivate them by checking the corresponding box.

Click on Advanced to be able wipe the contents of the /tmp directory (which might hold some files you down-
load from the Internet, for instance) and to tell Linux how much RAM your machine uses should this prove to
be an issue at boot time.

19.2.2. Managing Boot Entries

After clicking Next, the list of available entries at boot time is displayed; the default one is marked by a star
(*).

It’s also possible to make an entry the default one by checking the Default check-box in the Modify dialog.

172

http://www.wlug.org.nz/APIC


Chapter 19. Boot Device Configuration

19.3. Customizing your Boot Theme

The Boot Theme utility enables you to change the default theme displayed at boot time, as well
as a few other options.

• Choose one of the available boot modes in the pull-down menu (figure 19-3).

• Uncheck the Display theme under console option if you want a clean, “traditional” console. This relates to
those accessible through the Ctrl-Alt-Fn keys.

Figure 19-3. DrakBoot Theme Window

The boot theme setting will have no effect if your system isn’t set to boot using the graphical mode. Please
refer to Changing your Boot-up Configuration, page 171, for more information on setting the boot mode.

If you only have one theme available, you may install the bootsplash-themes package which you will find in
contribs. Other themes are also available on the web.

The Create new theme button allows you to fully customize an existing boot theme or create a new boot theme
from scratch. Adjust the parameters to your liking and save it. It will then be accessible in the available Themes
list.
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Mandriva’s convenient update service warns you about bug or security fixes specifically available for your
machines. This service can also be configured to automatically install package updates so you don’t have to
run it manually.

The system is comprised of the following items:

Initial Configuration Wizard (see Initial Configuration, page 175)

Enables you to register a new machine.

Web Management Interface (see The Web Management Interface, page 176)

Allows you to manage all the hosts you maintain and to activate hosts so they are taken into account for
updates.

Applet (see Mandriva Online Applet, page 178)

Informs you on the status of your updates, and allows you to launch the installation of updates when
needed.

Take a look at the Mandriva Online FAQ (https://online.mandriva.com/page.php?page=info) page to get
further information about the Mandriva Online service.

20.1. Initial Configuration

The Mandriva Online wizard shows up when you boot your machine for the first time. It allows you to create
a new account or to register an existing one. To manually launch the wizard from your user account, right-
click on the Mandriva Online applet icon on the panel and choose Configure Now!. You must provide root’s
password.

Figure 20-1. Existing or New Mandriva Online Account?

After clicking on Next, select the appropriate option (I already have an account or I want to subscribe) and click
Next.
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Figure 20-2. Authentication on Mandriva Online

Enter your login information and provide a name to identify your machine. This is useful if you manage
several computers with Mandriva Online.

The next step explains what information is collected on your computer. This information is required for the
service to work correctly.

Figure 20-3. Uploading Your Configuration

Finally, choose your country so that automatic updates occur from the nearest possible server. If your country
is not listed, select the nearest one. Click on Next and Finish to exit the wizard.

To complete your setup, you must activate this machine in your
Mandriva Online account.
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20.2. The Web Management Interface

Access the Mandriva Online web administration interface (https://online.mandriva.com/page.php?page=
info) by right-clicking on the Mandriva Online applet on the panel to activate your Mandriva Online account.
Choose Online WebSite and once you’re on the website, provide your Mandriva Online email address and pass-
word.

Please check out your personal space (https://my.mandriva.
com) on the My Mandriva Web site.

20.2.1. Subscribing New Machines

Figure 20-4. Mandriva Online Hosts List

20.2.2. Host Management

Once you activate a host you can access its management interface by clicking on the details icon.

Figure 20-5. Up-To-Date Mandriva Online Host

The available actions differ slightly according to whether your machine’s packages are up-to-date or not, but
basically here are the actions you can perform:

Control email alerts

Change the mail-sending status to yes (by clicking on the link) to receive an email when updates are
available.

Control automatic scheduled updates

Change the auto-update status to yes (by clicking on the link) to have updates for your machine auto-
matically installed by the applet (see Mandriva Online Applet, page 178) which regularly connects to the
Internet to check for such updates.
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Check current packages

Click on the See link by the Installed packages or Errata(s) label.

20.2.3. Scheduling Updates

You can update your machine manually from the applet (see Mandriva Online Applet, page 178); from the Web
interface, you can check which updates are available and choose which ones to install.

Figure 20-6. Outdated Mandriva Online Host

You must now select the packages to be updated. You can either schedule all packages to be updated, or choose
them one by one by clicking on the See link in the Outdated packages field.

Figure 20-7. Select Packages to be Updated

Click on the advisory link (of the MDKA-year:number or MDKSA-year:number forms) to obtain details
about that update. Check the box for each package you want to be updated on your machine. When this is
done, click on Schedule Packages.

Once updates are selected, they are automatically installed next time the applet connects to the Mandriva Online
server, which occurs several times a day.
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20.3. Mandriva Online Applet

The applet resides on your desktop panel. It informs you about update availability and allows you to perform
basic system maintenance tasks.

The applet icon can be in one of many states, depending on your machine’s status:

The system is up-to-date. All is fine.

A standard program update is available for your installed packages.

A bugfix update is available for your installed packages.

A security update is available for your installed packages. It is highly recommended that you
install security updates.

The applet is currently contacting the server, be patient.

This host isn’t currently activated. Activate it using the Web interface (see Subscribing New
Machines, page 177).

The applet cannot connect to the server. Check your Internet connection.

The system is currently not configured or a configuration error was found. Launch the
configuration wizard (see Initial Configuration, page 175) to use Mandriva Online.

Click on the applet icon to open a dialog with action buttons, followed by the current machine’s status.

Figure 20-8. Mandriva Online Applet

Install updates

Manually launch the updates installer by opening Rpmdrake (see Mandriva Linux Update, page 98).

Configure

Launch the wizard (see Initial Configuration, page 175). This can be useful to resend your machine confi-
guration to the server, for example if you have upgraded your hardware.

Check updates

Manually connects to the server to check if updates are available. This is done periodically by the applet,
but if you have no permanent connection to the Internet, it may be useful to manually check for updates
when you are online.
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This chapter guides you through some troubleshooting basics, that is: what to do when everything goes wrong
or, better yet, what to do to be prepared if something goes wrong and then how to fix it.

21.1. Introduction

Making backup copies of your data, fixing little problems, recompiling the kernel, installing software, and
tweaking configuration files are not uncommon scenarios in every day GNU/Linux life: even if you don’t do it
all the time, some day you may want or need to. Those tasks can be managed without any hassle if you use a
little common sense and follow some practices and guidelines we discuss in this chapter.

Many of the examples and tools presented in this chapter deal with
the command line. Usually, restoration of a damaged system to a
working state can only be done this way. We assume that you feel
comfortable enough using this powerful tool.

So, on to the basic things you need to have ready...

21.2. A Boot Disk

The very first thing you need when your system cannot boot from the hard disk is a boot disk. It allows you
to boot your system up and, in a matter of minutes, enable you to undo what rendered your system unusable.

21.2.1. Using the Mandriva Linux CD Rescue Mode

To access Mandriva Linux’s rescue mode (available on the first CD-ROM), boot from the CD-ROM, and press
the F1 key, then type rescue and hit Enter. The system boots in rescue mode (see figure 21-1).

Figure 21-1. Available Rescue Mode Actions

You navigate through the actions with the arrow keys and execute the selected action by pressing Enter. The
actions available are:
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Re-install Bootloader

Use this option to restore the Linux bootloader to the disk’s MBR. The former bootloader configuration
will be activated again. This is handy, for example, if you dual boot with Windows® and activated a virus
which corrupted your disk’s MBR leading to an unbootable system.

Restore Windows Bootloader

Use this option to restore the Windows® bootloader to the disk’s MBR. This can be used to completely
clean the Linux bootloader information and leave Windows® only “as if Linux had never been installed”.
Press Enter to perform the action, or N followed by Enter to cancel the action.

You won’t be able to boot Linux after performing this action. Note
however, that this doesn’t erase the Linux partitions and system
from your harddisk.

Mount your partitions under /mnt

Use this option to mount all available partitions under the /mnt directory. Each partition will be mounted
in its own directory, with the same name it would have if mounted by the original system. This option is
very useful when you need to access data on your partitions, for example to back it up. You will probably
need to mount partitions before accessing the console, for example.

Go to Console

Use this option to access the console where you can perform further operations, for example loading
network card drivers, copying files, formatting partitions, etc. A very basic Linux system is available with
a few consoles which you can switch between using the Alt-F<n> key sequence.

You can return to the rescue mode actions menu by issuing the
rescue-gui command.

Once you have finished using the console you can issue the reboot command to restart the system.

Reboot

Restarts the machine. Take the CD-ROM out if you want the system to boot as usual. You won’t be asked
for confirmation, the system reboots immediately.

Doc: What’s addressed by this Rescue?

Shows a few pages of help text, with brief explanations on what the rescue mode addresses. Navigate
through the pages using the Page Up and Page Down or the arrow keys and press the Q key followed by
the Enter key to return to the rescue actions menu.

21.3. Backup

21.3.1. Why Backup?

Backing up your system is the only means of being able to repair it if it suffers severe damage, if you acci-
dentally delete some important system files, or if someone breaks into your system and intentionally deletes
some files. You should also back up your personal data (compressed audio, images, office documents, e-mails,
address book, etc.) to be safe.

You should make your backups using an appropriate medium and keep them in a safe place. Such a place
should be outside the place you usually work in, if possible. You can even have two backups, one on-site, and
one outside. Generally speaking, you should make sure that you will be able to restore those backups if you
want all this to be really useful.
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21.3.2. Preparing your System

You probably have everything you need already installed in your system. You should also keep a boot disk
near at hand (you created one, didn’t you?). Actually, you can make backups using only tar and, optionally,
a compression tool such as gzip or bzip2. See an example in Backup Example Using tar, page 183.

As an alternative, you can use specialized backup programs, such as Taper, Time Navigator, Arkeia, or Mandriva
Linux’s own Drakbackup (please refer to Backing Up and Restoring your Files, page 147).

21.3.3. What to Backup?

Well, this might be the single most difficult question every system administrator asks himself when the time
to backup comes. The answer depends on issues such as: are you only backing up your personal data, your
configuration files, or your whole system? How much time or space is it going to take? Will you be restoring
your backup on the same machine/OS version, or on a different one?

Since this is a troubleshooting chapter, we try to focus on making a backup which allows you to quickly restore
your system to the state it was before that terrible thing which rendered it unusable happened. Of course, you
need to make a backup of your personal data if you don’t want to lose it.

As a rule of thumb, you should back up the following directories: /etc, /home, /root and /var. If you do a
complete backup of these directories, you have saved not only your system configuration, but your data as
well. Please bear in mind that a backup can take a long time to complete, but it’s the safest bet.

A more sophisticated scheme would be to backup only those files which have changed, skipping the ones
which haven’t. This will take more planning time, but will lead to quicker backups (and quicker restores, too).
They will also be “easier” to port from one machine/OS version to another.

To summarize, back up all the configuration files of the programs you use and all of the configuration files
you have changed. Also back up all your personal (and your system’s users) data files. You won’t regret it.

21.3.4. Where to Back Up?

The other big question to answer. This depends on how much you want to back up, how fast you want to
make your backups, how easy it is to access the backup media, and a large list of etceteras.

Generally speaking, you need media that is at least as large as the amount of information you want to back
up, and fast enough so the whole process won’t take forever to complete.

Available backup media options vary in capacity, reliability, and speed. You can combine backup media ac-
cording to your backup strategy, for example: tapes and CD-R/DVD+RW, hard disk and tapes, hard disk
and CD-R/DVD+RW, etc., but bear in mind that your backup software may or may not support all of these
options.

21.3.5. When to Back Up?

There are many policies for backup schedules. We discuss a few in this chapter but remember that these are not
mandatory, nor the best ones, nor the only ones. These are just guidelines you may want to follow in rolling
out your own backup schedule.

The many backup strategies out there depend on the media you use, on how often your data changes, and on
how critical that data is to you or your organization. For example, one strategy states that you should make
a full backup each weekend, and an incremental (changed data only) backup every day. Then make a full
backup every month and store that one in at least two places. This strategy might prove useful for a company,
but not for a personal computer. For your personal backups you can think of something like this: make a
weekly backup of your files on your disk drive and each month transfer those backups to CD-R/DVD+RW or
tape.
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21.3.6. Backup Example Using tar

Next, we introduce you to a little backup script which uses tar and bzip2 to make a compressed backup of
the list of directories you provide. Please read the script’s comments for tips on its usage.

You need read permission on the files, and read and execute per-
missions on the directories you are going to back up. Otherwise the
backup operation will fail.

#!/bin/bash

# Create a compressed backup of all the directories specified and put the
# resulting file in a directory of your choice.

BACKUP_DIRS="$HOME /etc /var"
BACKUP_FILENAME=‘date ’+%b%d%Y’‘
BACKUP_DEST_DIR="/backups"

# Uncomment the following line for GZipped backups, comment for
# BZipped backups

#tar cvzf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.gz $BACKUP_DIRS

# We do a BZipped backup here...
# Comment the following line for GZipped backups, uncomment for
# BZipped backups

tar cvjf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.bz2 $BACKUP_DIRS

Use BACKUP_DIRS to specify the directories you want to include in the backup and BACKUP_DEST_DIR to
specify the destination directory where the backup is going to be stored. Make the script executable: open a
terminal and run chmod 700 backup.sh.

Of course, you can always move the resulting tar.bz2 or tar.gz file to any media you want later. You can
even backup directly to the media you want by mounting it and changing the variable BACKUP_DEST_DIR of
the script accordingly. Feel free to enhance this script and make it as flexible as you want.

To restore the backups made this way, please look at Restore Example Using tar, page 184.

21.4. Restore

The restoration of a backup depends on which program, media, and schedule you used to make it. We won’t
cover all the restore cases, but only mention that in order to recover your settings and data files, make sure
that you restore the files and/or directories to the same places they were in when you made the backup.

21.4.1. Restore Example Using tar

Now, we introduce a little script to restore the backup we made with tar using the script introduced earlier
in Backup Example Using tar, page 183.

You need write permissions on the files and directories you are going
to restore. Otherwise the restore operation will fail.

#!/bin/bash

# Extract a compressed backup of all the directories specified
# putting the backed up files into their original places.

BACKUP_SOURCE_DIR="/backups"
RESTORE_FILENAME=$1

# Uncomment the following line if you are restoring GZipped
# backups

#tar xvzf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME
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# Restore a BZipped backup here...

tar xvjf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

As you can see, this script is simple enough. All we have to do is to pass it the file name of the backup we
want to restore as a parameter (just the file name, not the full path), and it restores the backed up files into their
original locations. Make sure the script is executable: open a terminal and run chmod 700 restore.sh.

21.4.2. Making a Recovery CD-ROM

There is a way to be prepared in case of “total disaster”, and that is by making a full backup of your system.
Programs such as mkCDrec can be very useful to get you up and running in a matter of minutes. You can find
it, together with its documentation on the mkCDrec web site (http://mkcdrec.ota.be).

mkCDrec allows you to do multiple-CD-ROM volumes, disk cloning (copying the full contents of a disk or
partition to another with similar characteristics — at least the same size), and many more.

In order to restore a system with mkCDrec you only have to boot with the first CD-ROM of the multiple-CD-
ROM volume and then follow the on-screen instructions.

21.5. Problems Arising at Boot Time

It could happen that your system hangs during boot up. If so, don’t panic, just keep reading.

The next sections are not introduced in any particular order.

21.5.1. System Hanging During Boot

If your system hangs during Rebuilding RPM database or Finding module dependencies, just
press Ctrl-C. This allows the system to skip this step and continue to boot. Once booted, execute rpm
--rebuilddb as root if the system hang was at the Rebuilding RPM database phase. If the system
hang was at the Finding module dependencies phase you have most likely been through a kernel up-
grade, but haven’t done it correctly. Check if the files in the /boot and /lib/modules directories match the
current kernel version (i.e., have the current version number attached).

If the boot process hangs at RAMDISK: Compressed image found at block 0 you have a corrupted
initrd image. Either try to boot another boot entry or boot an emergency system and remove or change the
initrd= section in /etc/lilo.conf

21.5.2. Filesystem Check on Boot Fails

The information below applies to ext2 and ext3 filesystems only. If
you use a different filesystem, please check its documentation.

If, for any reason, you didn’t shut your box down properly, the system runs a routine filesystem check during
the next boot. Sometimes it may fail to do this on its own and asks for the root password and drops you
to a console. Execute e2fsck -py [device] where [device] is the name of the partition on which the
automatic check failed. The -p switch tells e2fsck to make all the necessary repairs without asking, -y
assumes you answer yes to all questions. When the check and repair phase is over, press Ctrl-D to leave the
emergency console. The system will reboot.

If you get this error regularly, there may be bad blocks on your disk. Execute e2fsck -c [device] to find
out. This command automatically marks any bad blocks and prevents the filesystem from storing data in
these blocks. e2fsck checks the file system automatically only if it hasn’t been unmounted properly during
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the previous system shutdown; or if the maximal mount count has been reached. To force a check, use the
-f option.

The verification for bad blocks on a disk should only be done on
unmounted file systems, and can take a long time to complete.

21.5.3. X Doesn’t Start

If you boot into X by default and have managed to break your X configuration somehow, and cannot enter
X anymore, you can log into a console and use XFdrake to reconfigure X. You can also boot into a different
runlevel, fix X’s configuration with XFdrake and reboot into X.

21.5.3.1. Booting Into a Different Run Level

The default run level GNU/Linux boots to is defined in the /etc/inittab file. Look for an entry like
id:5:initdefault:. To boot into run level 3 (the console), you have to define that run level on the boot
prompt. Under LILO, press the Esc key once and type linux init 3. Under GRUB, press the E key twice,
add init 3, press the Enter key and then the B key to boot.

For a more detailed description about run levels, please refer to the The Start-Up Files: init sysv chapter of
Mandriva Linux’s Reference Manual.

21.5.3.2. Configuring X From The Console

To reconfigure X using XFdrake from the console, simply type XFdrake as root.

Using XFdrake is no different to the graphical environment except that you won’t have nice icons and may
not be able to use the mouse pointer. To move down you have to press the right or down arrow keys on your
keyboard; to move up press the left or up keys on your keyboard. You can also use the Tab key to move
between the different options/buttons. The text on the currently selected button/option will be highlighted
with a different color. Press the Enter key to activate it.

Please refer to Controlling the Graphical Configuration, page 104 for instructions on its usage.

21.6. Bootloader Issues

21.6.1. Bootloader Reinstall

It may happen that you make a mistake and wipe your disk’s MBR (Master Boot Record), or some misbehaving
program erases it, or you dual boot with Windows® and catch a virus which suppresses it. So, you think you
won’t be able to boot your system anymore, right? Wrong! There are many ways to recover the boot record.

To recover your bootloader you need a boot disk. Without a boot disk of some kind you might be completely
lost, unless you made a backup of your MBR, see Backing Up and Restoring the MBR, page 187.

Reboot your computer using the boot disk. What you do next varies according whether you use LILO or GRUB.
No matter which bootloader you use, all the commands you must execute need to be run as root.

21.6.1.1. With LILO

If you use LILO, you only need to issue the following at the command prompt: /sbin/lilo. This command
reinstalls LILO on your disk’s boot sector and fixes the problem.
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21.6.1.2. With GRUB

If you use GRUB things are a little bit different to that of LILO.

In the following example we assume that you are trying to install
GRUB in the MBR of your first IDE drive, and that the file stage1 is
in the /boot/grub/ directory.

First, invoke GRUB’s shell by issuing the grub command. Once there, issue the following command: root
(hd0,0). This will tell GRUB that the files it needs are in the first partition (0) of your first hard disk (hd0).
Then issue the following command: setup (hd0). This installs GRUB in the MBR of your first hard disk.
That’s it!

You can also try to use grub-install /dev/hda to install GRUB on your first hard drive’s MBR, but the
method described above is the preferred one.

21.6.1.3. Some Considerations for Dual-Booting Systems

Windows 9x, NT, 2000 and XP upgrades. If you run a dual-boot system, be very careful to always have a
GNU/Linux boot disk prepared. If you don’t have a boot disk, and you (re)install Windows® (all versions) you
won’t be able to boot GNU/Linux after the Windows® upgrade because Windows® rewrites the MBR without
any warning at all.

21.6.2. Backing Up and Restoring the MBR

To make a backup copy of your hard disk’s MBR, insert a blank floppy in your floppy disk drive and issue the
following:

# dd if=/dev/hda of=/dev/fd0/mbr.bin bs=512 count=1

If you want to restore a backed up copy of your hard disk’s MBR, insert the floppy containing it into your
floppy disk drive and issue the following:

# dd if=/dev/fd0/mbr.bin of=/dev/hda bs=512

The above examples assume that the MBR of your first IDE hard
disk (/dev/hda) is backed up to a file named mbr.bin on your first
floppy diskette drive (/dev/fd0) and should be run as the root
user.

21.7. Filesystem Issues

21.7.1. Repairing a Damaged Superblock

The information below only applies to ext2 and ext3 filesystems. If
you use a different filesystem, please check its documentation.

The superblock is the first block of each ext2FS/ext3FS partition. It contains important data about the file
system, such as its size, free space, etc. (it is similar to the method used by FAT partitions). A partition with a
damaged superblock cannot be mounted. Fortunately, ext2FS/ext3FS keeps several superblock backup copies
scattered over the partition.

Boot your system with a boot disk. The backup copies’ location depends on the block size of the filesystem.
For filesystems with 1 KB block sizes it is at the beginning of each 8 KB (8192 bytes) block. For filesystems
with 2 KB sizes it is at the beginning of each 16 KB (16384 bytes) block, and so on. You can use the mke2fs
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-n [your_disk_device_name] command to find out at which byte positions the superblock copies are.
Assuming a 1 KB block size, the first backup copy is in byte number 8193. To restore the superblock from this
copy, execute e2fsck -b 8193 /dev/hda4; change hda4 accordingly to reflect the name of your damaged
partition. If that block also happens to be damaged, try the next one at byte number 16385, and so on until you
find a suitable one. Reboot your system to activate the changes.

21.7.2. Recovering Deleted Files

We discuss ways of recovering deleted files and directories. Please bear in mind that recovery tools are not
magical, and they will only work depending on how recently you deleted the file(s) you are trying to recover.

You might be wondering how to recover files you accidentally deleted. There are some utilities designed for
GNU/Linux’s ext2 filesystem which allow you to recover deleted files and directories. However they won’t
recover the files you deleted a few months ago because of disk usage, space marked as “free” will have been
overwritten. So the best way to protect against accidental or not so accidental deletions is by making backups.

There are not (as yet) tools to recover files deleted on reiserfs
file systems. Keep in touch with the ReiserFS home page (http:
//www.namesys.com) for the latest news about it.

One recovery tool is Recover. It’s an interactive tool. You can find it in the contribs CD-ROM or on the
Rpmfind web site (http://www.rpmfind.net). Once you have the RPM, install it. Then run it with recover
and answer the questions it asks you. The questions help you to set a time span to look for deleted files and
directories to minimize the time it takes to do the search1.

Once the tool finishes its search, it asks you where you want to save the recovered files and directories. Pick
a directory of your choice, and you have all the files and directories recovered into it. Note that you won’t
be able to recover the file names, just their contents, but you can inspect them or try to rename them with
different names until you get the right one. This is better than nothing.

There are also mini-HOWTOs related to “undeletion” for ext2,
look at Ext2fs-Undeletion (http://www.tldp.org/HOWTO/
mini/Ext2fs-Undeletion.html) and undeletion of who-
le directory structures (http://www.tldp.org/HOWTO/mini/
Ext2fs-Undeletion-Dir-Struct/index.html).

21.8. Recovering from a System Freeze

When stuck in a “freeze”, your computer doesn’t respond to commands anymore and input devices such as
keyboard and mouse seem to be blocked. This is a worst-case scenario and could mean that you have a very
severe error in either your configuration, your software or your hardware. We will show you how to deal with
this annoying situation.

In the case of a system freeze, your top priority should be trying to shutdown your system properly. We
assume you are running under X. So try these steps consecutively:

1. Try to kill the X server by pressing the Ctrl-Alt-Backspace keys.

2. Try to switch to another console by pressing the Ctrl-Alt-Fn keys (where n is the console number, from 1
to 6). If you succeed, login as root and issue the command: kill -15 $(pidof X) or the command
kill -9 $(pidof X), if the first command shows no effect. Check with top to see if X is still running.

3. If you are part of a local network, try to use ssh to connect into your machine from another. It is advisable
to ssh into the remote machine as an unprivileged user and then use the su command to become root.

1. You can search for all deleted files too by appending the -a option, but it takes much longer...
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4. If the system doesn’t respond to any of these steps, you have to go through the SysRq (System Request)
sequence. The SysRq sequence involves pressing and holding three keys at once: the left Alt key, the SysRq
key (labeled Print Screen on older keyboards) and a letter key.

a. Alt-SysRq-R puts the keyboard in “raw” mode. Now try pressing Alt-Ctrl-Backspace again to kill X.
If that doesn’t work, carry on.

b. Alt-SysRq-S attempts to write all unsaved data to disk (“sync” the disk).

c. Alt-SysRq-E sends a termination signal to all processes, except for init.

d. Alt-SysRq-I sends a kill signal to all processes, except for init.

e. Alt-SysRq-U attempts to re-mount all mounted filesystems read-only. This removes the “dirty flag”
and prevents a filesystem check upon reboot.

f. Alt-SysRq-B reboots the system. You might just as well press the “reset” button on your machine.

Remember that this is a sequence, i.e. you have to press one com-
bination after the other in the right order: Raw, Sync, tErm, kIll,
Umount, reBoot2. Read the kernel documentation for more infor-
mation on this feature.

5. If none of the above helps, cross your fingers and press the “reset” switch on your machine. If you are
lucky, GNU/Linux will just run a disk check upon reboot.

By all means, try to find out what causes these lockups because they can do severe damage to the filesys-
tem. You might also want to consider using one of the journaling filesystems included in Mandriva Linux: ext3,
reiserfs, etc. which handle such failures more gracefully. However, replacing ext2FS with reiserfs requi-
res reformatting your partitions. You can use tune2fs -j /dev/hdaN to convert the filesystem in the Nth

partition of the first IDE disk from ext2FS to ext3FS.

21.9. Killing Misbehaving Apps

Well, this one is not so hard after all. You have many ways to do it. You can do it by finding the PID of the
program which stopped responding, and then using the kill command to terminate it, or you can use the
xkill tool or other graphical tools such as the ones that show the process tree.

21.9.1. From the Console

The first thing to do to terminate a misbehaving program is to find its PID, or process ID. To do so, execute the
following from a console: ps aux | grep mozilla-firefox-bin, supposing that Firefox is the misbeha-
ving program. You will get something like the following, which tells you among other things that Firefox was
started by user peter and that its PID is 3505:

peter 3505 1.7 5.0 82208 25804 ? Sl 09:30 0:01 /usr/lib/mozilla-firefox-1.0.6/mozilla-firefox-bin

Now that we have the PID of the misbehaving program, we can execute the kill command to terminate it.
So we execute the following: kill -9 3505, and that’s it! Firefox is killed. Note that this is only to be used
when the program doesn’t respond to your input anymore. Do not use it as a standard means of exiting from
applications.

Actually, we sent the KILL signal to the process number 3505. The kill command accepts other signals
besides KILL, so you can have greater control over your processes. For more info, see kill(1).
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21.9.2. Using Graphical Monitoring Tools

You can also use the graphical process’ status tools (such as KPM, KSySGuard, and GTOP to name a few) which
allow you to point to the process name and with one click send that process a signal or just kill that process.

If you are using KDE, you can press the Ctrl-Alt-Esc keys: the
pointer changes to a skull with crossed bones and you can simply
click on the window of the misbehaving application to kill it.

21.10. Miscellaneous

Some considerations on newer hardware such as legacy-free systems, nVidia® and ATI 3D® graphics accelera-
tor cards, winmodems and other things that don’t fit in the preceding sections.

21.10.1. Legacy-Free Systems

Hardware manufacturers have recently introduced what they call “legacy-free systems”, mainly on laptops3,
but there are also legacy-free desktop computers. This basically means that the BIOS has been considerably
reduced to allow you only to choose which media to boot from. Mandriva Linux will be able to configure
everything properly.

21.10.2. nVidia and ATI 3D Graphics Cards

Computers with nVidia or ATI graphics cards need a patched kernel to be able to use OpenGL hardware
3D acceleration on OpenGL-compatible applications. If you own a Mandriva Linux –– PowerPack Edition, the
kernel should have been installed by DrakX. If this is not your case, please obtain and install the corresponding
packages. You can visit nVidia’s web site (http://www.nvidia.com) and ATI’s web site (http://www.ati.
com) and download the appropriate drivers, or you can download the RPM packages from Mandriva Club
(http://club.mandriva.com). Then run Mandriva Linux Control Center and re-configure X from there.

21.10.3. Winmodems

winmodems are also called controller-less modems or software modems. Support for these peripherals is im-
proving. Drivers do exist, but most of them are in binary form and available only for newer kernel versions.

If you have a PCI modem, look at the output of cat /proc/pci run as the root user from a terminal
window. It tells you the device’s I/O port and IRQ. Then use the setserial command (for our example, the
I/O address is 0xb400, the IRQ is 10 and the modem is the 4th serial device) as follows:

setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Then try to query your modem using minicom or kppp. If it doesn’t work, you may have a software modem.
If it does work, create the /etc/rc.d/rc.setserial file and place the appropriate setserial command line
in it.

If you happen to have a software modem in your machine, and you have a Mandriva Club account, you
might find an RPM package that supports your modem (try searching on the ltmodem package for ins-
tance). You should also take a look at the web site of your modem’s manufacturer and at the linmodems
(http://linmodems.org/) and the Winmodems are not modems (http://start.at/modem/) web sites.

3. Refer to the great Linux on Laptops (http://www.linux-laptop.net) web site for more information on your laptop
make/model.
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21.10.4. My Computer is “slow”

If you notice your computer is really slow, or significantly slower than with other GNU/Linux versions, you
might overcome this “problem” by disabling ACPI support. To do so, add the following to your /etc/lilo.
conf file:

append="acpi=off"

If the file already has an append= line, only add acpi=off at its end. Running lilo -v as root and reboo-
ting your computer will make the changes effective.

21.11. Mandriva Linux’s Specific Troubleshooting Tools

Each administration tool (the ones started from Mandriva Linux Control Center) is a potential trouble fixing tool.
You can use all these tools to revert configuration changes, to add or remove software, to update your system
with the latest fixes from Mandriva, etc.

If you think you have found a bug in any of our tools, please feel free to submit a bug report using Drakbug,
our automated bug report tool.

21.12. General Guidelines for Solving a Problem under Mandriva Linux

Here are the different means available to you in your problem-solving quest. Try the first option and only
then, if that does not work, try the second, and so on.

21.12.1. Search the Internet

The various Internet sites previously mentioned are excellent starting points. They deal with general and
very specific aspects of your potential problems. Finally, try a general search engine such as Google™ or, as
mentioned above, the Linux-specific Google™ search engine. And do not hesitate to use the Advanced search
(http://www.google.com/advanced_search) option with very detailed questions, such as the error message
you are receiving.

21.12.2. Mailing Lists and Newsgroups Archives

The previous searches may lead you to general answers which hide the results of your specific question
amongst many other answers. To refine your search, you can try the following.

First, try to find a list which seems specifically geared to your problem, then perform a search in its archive
pages.

Example
You’ve noticed some strange behavior while trying to use GRUB with a minix partition.

One of the results of a search using the “grub mailing list” keywords in Google™ is a link to the GRUB mailing list
archive (http://mail.gnu.org/archive/html/bug-grub/). It even offers a search engine, which when searched for
“Minix” leads you directly to a patch.

Note that not all archives have an embedded search engine. Howe-
ver, using Google� as an example, you can easily use the advanced
field domain to limit your search to the specific site hosting the
archive. This strategy may also be used to exclude sites which keep
returning garbage.
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For a newsgroups search, Google Groups� (http://groups.google.com/) maintains an archive of an amazingly
large number of newsgroup channels.

21.12.3. Directly Contacting the Person in Charge

Use this option as a very last resort and in really extreme situations — unless you want to offer your collabo-
ration! Software developers generally receive mountains of e-mails, so your anguished question on the use of
the cd command will most likely... be ignored!

The addresses will be found either on the home page of a project’s site or in the software documentation.

A last word: do not underestimate your neighbors’ skills or those of your local LUG (Linux Users Group).
And please, do not throw your computer through the window. If your problem isn’t fixed today, it may be
tomorrow...

21.12.4. Mandriva Business Services

Finally, when facing a really challenging situation, corporate users (especially) might consider hiring one of
Mandriva’s consultants to address their specific needs.

This is one of the strong suits of open-source products: we have the source, we have the power! Therefore,
almost any problem, no matter how complex, specific or high level, may be solved right in the heart of the
software.

You might also want to customize your Linux environment to meet very precise goals. For example, you could
use Mandriva Linux as a custom routing application on special devices. Know that Mandriva consulting services
(http://www.mandriva.com/enterprise/products/) can help you.

21.13. Final Thoughts

As you have seen there are many more ways to recover from an emergency than by re-installing the whole
system again4. Sure, you need a little expertise in applying some of the techniques described in this chapter,
but with a little practice you will gain such expertise. However, we hope that you will never need to really
master these techniques ... although it does not hurt to know them. We hope that the instructions and examples
given will be useful when you are in need. Good luck recovering from an emergency!

4. The usual way to fix things in some other operating systems...
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Appendix A. The GNU General Public License

The following text is the GPL license that applies to most programs found in Mandriva Linux distributions.

Version 2, June 1991 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330,
Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

A.1. Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public License is intended to guarantee your freedom to share and change free software — to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies
of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you
must show them these terms so they know their rights.

We protect your rights with two steps:

1. copyright the software, and

2. offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there
is no warranty for this free software. If the software is modified by someone else and passed on, we want its
recipients to know that what they have is not the original, so that any problems introduced by others will not
reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed
at all.

The precise terms and conditions for copying, distribution and modification follow.

A.2. Terms and conditions for copying, distribution and modification

• 0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or
with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
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if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

• 1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any me-
dium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright
notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of
any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

• 2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

1. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

2. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

3. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you
provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not
normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not de-
rived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

• 3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

1. Accompany it with the complete corresponding machine-readable source code, which must be distribu-
ted under the terms of Sections 1 and 2 above on a medium customarily used for software interchange;
or,

2. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy of
the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

3. Accompany it with the information you received as to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial distribution and only if you received the program
in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any asso-
ciated interface definition files, plus the scripts used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need not include anything that is normally dis-
tributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.
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If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

• 4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will au-
tomatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such parties remain in full
compliance.

• 5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

• 6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

• 7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

• 8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if
written in the body of this License.

• 9. The Free Software Foundation may publish revised and/or new versions of the General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail
to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this Li-
cense which applies to it and "any later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

• 10. If you wish to incorporate parts of the Program into other free programs whose distribution condi-
tions are different, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status of all derivatives of our free software
and of promoting the sharing and reuse of software generally.
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Appendix A. The GNU General Public License

NO WARRANTY

• 11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STA-
TED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTI-
CULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NE-
CESSARY SERVICING, REPAIR OR CORRECTION.

• 12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GE-
NERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILU-
RE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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